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Accuracy 

While reasonable efforts have been made to assure the accuracy of this document, Cambium Networks assumes 
no liability resulting from any inaccuracies or omissions in this document, or from use of the information 

obtained herein. Cambium reserves the right to make changes to any products described herein to improve 
reliability, function, or design, and reserves the right to revise this document and to make changes from time to 
time in content hereof with no obligation to notify any person of revisions or changes. Cambium does not 
assume any liability arising out of the application or use of any product, software, or circuit described herein; 
neither does it convey license under its patent rights or the rights of others. It is possible that this publication 
may contain references to, or information about Cambium products (machines and programs), programming, or 
services that are not announced in your country. Such references or information must not be construed to mean 
that Cambium intends to announce such Cambium products, programming or services in your country.  

Copyrights 

This document, Cambium products, and 3rd Party software products described in this document may include or 
describe copyrighted Cambium and other 3rd Party supplied computer programs stored in semiconductor 
memories or other media. Laws in the United States and other countries preserve for Cambium, its licensors, 
and other 3rd Party supplied software certain exclusive rights for copyrighted material, including the exclusive 
right to copy, reproduce in any form, distribute and make derivative works of the copyrighted material. 
Accordingly, any copyrighted material of Cambium, its licensors, or the 3rd Party software supplied material 
contained in the Cambium products described in this document may not be copied, reproduced, reverse 
engineered, distributed, merged or modified in any manner without the express written permission of Cambium. 
Furthermore, the purchase of Cambium products shall not be deemed to grant either directly or by implication, 
estoppel, or otherwise, any license under the copyrights, patents or patent applications of Cambium or other 3rd 
Party supplied software, except for the normal non-exclusive, royalty free license to use that arises by operation 
of law in the sale of a product.  

Restrictions 

Software and documentation are copyrighted materials. Making unauthorized copies is prohibited by law. No 
part of the software or documentation may be reproduced, transmitted, transcribed, stored in a retrieval system, 
or translated into any language or computer language, in any form or by any means, without prior written 
permission of Cambium. 

License Agreements  

The software described in this document is the property of Cambium and its licensors. It is furnished by express 
license agreement only and may be used only in accordance with the terms of such an agreement.  

High Risk Materials  

Cambium and its supplier(s) specifically disclaim any express or implied warranty of fitness for any high risk 
activities or uses of its products including, but not limited to, the operation of nuclear facilities, aircraft 
navigation or aircraft communication systems, air traffic control, life support, or weapons systems (“High Risk 
Use”).  Any High Risk is unauthorized, is made at your own risk and you shall be responsible for any and all 
losses, damage or claims arising out of any High Risk Use. 

© 2014 Cambium Networks Limited. All Rights Reserved. 
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Safety and regulatory information 

This section describes important safety and regulatory guidelines that must be observed by personnel installing or 

operating ePMP equipment. 

IMPORTANT SAFETY INFORMATION 

 Warning 

To prevent loss of life or physical injury, observe the safety guidelines in this section. 

Power lines 

Exercise extreme care when working near power lines. 

Working at heights 

Exercise extreme care when working at heights. 

Grounding and protective earth 

Connectorized ePMP devices must be properly grounded to protect against lightning. It is the user’s 

responsibility to install the equipment in accordance with national regulations. In the USA, follow Section 810 of 

the National Electric Code, ANSI/NFPA No.70-1984 (USA). In Canada, follow Section 54 of the Canadian Electrical 

Code. These codes describe correct installation procedures for grounding the outdoor unit, mast, lead-in wire and 

discharge unit, size of grounding conductors and connection requirements for grounding electrodes. Other 

regulations may apply in different countries and therefore it is recommended that installation be contracted to a 

professional installer.  

Powering down before servicing 

Always power down and unplug the equipment before servicing. 

Primary disconnect device  

The ePMP power supply is the primary disconnect device. 

External cables 

Safety may be compromised if outdoor rated cables are not used for connections that will be exposed to the 

outdoor environment. 

RF exposure near the antenna 

Strong radio frequency (RF) fields will be present close to the antenna when the transmitter is on. Always turn off 

the power to the ePMP device before undertaking maintenance activities in front of the antenna. 

Minimum separation distances 

Install the ePMP device so as to provide and maintain the minimum separation distances from all persons. 

The minimum separation distances for each frequency variant are specified in Calculated distances and power 

compliance margins on page 307. 

IMPORTANT REGULATORY INFORMATION 

The ePMP product is certified as an unlicensed device in frequency bands where it is not allowed to cause 

interference to licensed services (called primary users of the bands). 



CAMBIUM NETWORKS 

 

 

 4 

Radar avoidance 

In countries where radar systems are the primary band users, the regulators have mandated special requirements 

to protect these systems from interference caused by unlicensed devices.  Unlicensed devices must detect and avoid 

co-channel operation with radar systems.  

The ePMP provides detect and avoid functionality for countries and frequency bands requiring protection for 

radar systems. 

Installers and users must meet all local regulatory requirements for radar detection. To meet these requirements, 

users must set the correct country code during commissioning of the ePMP equipment. If this is not done, 

installers and users may be liable to civil and criminal penalties. 

Contact the Cambium helpdesk if more guidance is required. 

USA and Canada specific information 

The USA Federal Communications Commission (FCC) has asked manufacturers to implement special features to 

prevent interference to weather radar systems that operate in the band 5600 MHz to 5650 MHz. These features 

must be implemented in all products able to operate outdoors in the band 5470 MHz to 5725 MHz. 

Manufacturers must ensure that such radio products cannot be configured to operate outside of FCC rules; 

specifically it must not be possible to disable or modify the radar protection functions that have been demonstrated 

to the FCC. 

In order to comply with these FCC requirements, Cambium supplies variants of the ePMP for operation in the 

USA or Canada. These variants are only allowed to operate with license keys and country codes that comply with 

FCC/IC rules. In particular, operation of radio channels overlapping the band 5600-5650 MHz is not allowed and 

these channels are permanently barred. 

In addition, other channels may also need to be barred when operating close to weather radar installations. 

 Note 

To ensure compliance with FCC rules (KDB 443999: Interim Plans to Approve UNII Devices Operating in 

the 5470 - 5725 MHz Band with Radar Detection and DFS Capabilities), follow Avoidance of weather 

radars on page 61. 

Other variants of the ePMP are available for use in the rest of the world, but these variants are not supplied to the 

USA or Canada except under strict controls, when they are needed for export and deployment outside the USA or 

Canada. 

Specific expertise and training required for professional installers 

To ensure that the ePMP is installed and configured in compliance with the requirements of Industry Canada and 

the FCC, installers must have the radio engineering skills and training described in this section. This is 

particularly important when installing and configuring an ePMP system for operation in the 5 GHz band (5150 – 

5250 MHz – FCC only, 5250 – 5350 MHz, 5470 – 5725 MHz and 5725 – 5850 MHz).. 

Avoidance of weather radars 

The installer must be familiar with the requirements in FCC KDB 443999. Essentially, the installer must be able 

to: 

 Access the FCC data base of weather radar location and channel frequencies. 
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 Use this information to correctly configure the product (using the GUI) to avoid operation on channels that 

must be avoided according to the guidelines that are contained in the KDB and explained in detail in this user 

guide. 

In ETSI regions, the band 5600 MHz to 5650 MHz is reserved for the use of weather radars. 

External antennas 

When using a connectorized version of the product (as compared to the version with an integrated antenna), the 

conducted transmit power must be reduced to ensure the regulatory limit on transmitter EIRP is not exceeded. 

The installer must have an understanding of how to compute the effective antenna gain from the actual antenna 

gain and the antenna cable losses. 

The product GUI automatically applies the correct conducted power limit to ensure that it is not possible for the 

installation to exceed the EIRP limit, when the appropriate values for antenna gain are entered into the GUI. 

Ethernet networking skills 

The installer must have the ability to configure IP addressing on a PC and to set up and control products using a 

web browser interface. 

Lightning protection 

To protect outdoor radio installations from the impact of lightning strikes, the installer must be familiar with the 

normal procedures for site selection, bonding and grounding. Installation guidelines for the ePMP can be found in 

section System planning on page 58. 

Training 

The installer needs to have basic competence in radio and IP network installation. The specific requirements 

applicable to the ePMP must be gained by reading this user guide and by performing sample set ups at base 

workshop before live deployments. 
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About This User Guide 
This guide describes the planning, installation, configuration and operation of the Cambium ePMP Series of point-

to-multipoint wireless Ethernet systems. It is intended for use by the system designer, system installer and system 

administrator.  

 

For radio network design, see: 

 Product description 

 System hardware 

 System planning 

 Legal and reference information  

 

For system configuration, monitoring and fault-finding, see: 

 Configuration 

 Operation and Troubleshooting 

 

For radio equipment installation, refer to the following guides: 

 The ePMP Quick Start Guide 

 The ePMP Installation Guide 

 

 Note 

The ePMP Installation Guide is reproduced as an addendum to this user guide. 
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General information 

22BVERSION INFORMATION 

The following shows the issue status of this document: 

Issue Date of issue Remarks 

001v000 October 2013 System Release 1.0 (Software Release 1.1.6) 

002v000 December 2013 System Release 1.0 (Software Release 1.2.3) 

003v000 January 2014 System Release 1.0 (Software Release 1.3.4) 

004v000 March 2014 System Release 1.0 (Software Release 1.4.1) 

005v000 March 2014 System Release 1.0 (Software Release 1.4.3) 

006v000 April 2014 System Release 1.0 (Software Release 1.4.4) 

007v000 June 2014 System Release 2.0 (Software Release 2.0) 

008v000 July 2014 System Release 2.1 (Software Release 2.1) 

010v000 September 2014 System Release 2.2 (Software Release 2.2) 

011v000 October 2014 System Release 2.3 (Software Release 2.3) 

012v000 November 2014 System Release 2.3.1 (Software Release 2.3.1) 

013v000 December 2014 System Release 2.3.3 (Software Release 2.3.3) 

014v000 December 2014 System Release 2.3.4 (Software Release 2.3.4) 

015v000 March 2015 System Release 2.4 (Software Release 2.4) 

 

23BCONTACTING CAMBIUM NETWORKS 

 

Support website: http://www.cambiumnetworks.com/support 

Main website: http://www.cambiumnetworks.com 

Sales enquiries: solutions@cambiumnetworks.com 

Support enquiries: support@cambiumnetworks.com 

Telephone number list: http://www.cambiumnetworks.com/support/contact-support/ 

Address: Cambium Networks Limited, 

3800 Golf Road, Suite 360 

Rolling Meadows, IL 60008 

 

  

http://www.cambiumnetworks.com/support
http://www.cambiumnetworks.com/
mailto:solutions@cambiumnetworks.com
mailto:support@cambiumnetworks.com
http://www.cambiumnetworks.com/support/contact-support/
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Purpose 

Cambium Networks enhanced Point-To-Multipoint (ePMP) documents are intended to instruct and assist 

personnel in the operation, installation and maintenance of the Cambium ePMP equipment and ancillary devices. 

It is recommended that all personnel engaged in such activities be properly trained. 

Cambium disclaims all liability whatsoever, implied or expressed, for any risk of damage, loss or reduction in 

system performance arising directly or indirectly out of the failure of the customer, or anyone acting on the 

customer's behalf, to abide by the instructions, system parameters, or recommendations made in this document. 

Cross references 

References to external publications are shown in italics. Other cross references, emphasized in green text in 

electronic versions, are active links to the references. 

Feedback 

We appreciate feedback from the users of our documents. This includes feedback on the structure, content, 

accuracy, or completeness of our documents.  

For feedback, e-mail to support@cambiumnetworks.com. 

 

mailto:support@cambiumnetworks.com


CAMBIUM NETWORKS 

 

 13 

Problems and warranty 

Reporting problems 

If any problems are encountered when installing or operating this equipment, follow this procedure to investigate 

and report: 

1 Search this document and the software release notes of supported releases. 

2 Visit the support website: 

http://www.cambiumnetworks.com/support/epmp 

3 Ask for assistance from the Cambium product supplier. 

4 Gather information from affected units, such as any available diagnostic downloads. 

5 Escalate the problem by emailing or telephoning support: 

http://www.cambiumnetworks.com/support/contact-support 

Repair and service 

If unit failure is suspected, obtain details of the Return Material Authorization (RMA) process from the support 

website. 

Warranty 

Cambium’s standard hardware warranty is for one (1) year from date of shipment from Cambium or a Cambium 

distributor. Cambium warrants that hardware will conform to the relevant published specifications and will be free 

from material defects in material and workmanship under normal use and service. Cambium shall within this time, 

at its own option, either repair or replace the defective product within thirty (30) days of receipt of the defective 

product. Repaired or replaced product will be subject to the original warranty period but not less than thirty (30) 

days. 

To register PMP products or activate warranties, visit the support website. 

For warranty assistance, contact the reseller or distributor. 

 Caution 

Do not open the radio housing for repair or diagnostics; there are no serviceable parts within the housing. 

Portions of Cambium equipment may be damaged from exposure to electrostatic discharge. Use precautions 

to prevent damage. 

 

 

http://www.cambiumnetworks.com/support/epmp
http://www.cambiumnetworks.com/support/contact-support
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Security advice 

Cambium Networks systems and equipment provide security parameters that can be configured by the operator 

based on their particular operating environment. Cambium recommends setting and using these parameters 

following industry recognized security practices. Security aspects to be considered are protecting the 

confidentiality, integrity, and availability of information and assets. Assets include the ability to communicate, 

information about the nature of the communications, and information about the parties involved.  

In certain instances Cambium makes specific recommendations regarding security practices, however the 

implementation of these recommendations and final responsibility for the security of the system lies with the 

operator of the system. 

Cambium Networks ePMP equipment is shipped with default web management interface login credentials. It is 

highly recommended that these usernames and passwords are modified prior to system deployment. 



CAMBIUM NETWORKS 

 

 15 

Warnings, cautions, and notes 

The following describes how warnings and cautions are used in this document and in all documents of the 

Cambium Networks document set. 

Warnings 

Warnings precede instructions that contain potentially hazardous situations. Warnings are used to alert the 

reader to possible hazards that could cause loss of life or physical injury. A warning has the following format: 

 Warning 

Warning text and consequence for not following the instructions in the warning. 

 

Cautions 

Cautions precede instructions and are used when there is a possibility of damage to systems, software, or 

individual items of equipment within a system. However, this damage presents no danger to personnel. A caution 

has the following format: 

 

 Caution 

Caution text and consequence for not following the instructions in the caution. 

 

Notes 

A note means that there is a possibility of an undesirable situation or provides additional information to help the 

reader understand a topic or concept. A note has the following format: 

 Note 

Note text. 
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Caring for the environment 

The following information describes national or regional requirements for the disposal of Cambium Networks 

supplied equipment and for the approved disposal of surplus packaging. 

In EU countries 

The following information is provided to enable regulatory compliance with the European Union (EU) directives 

identified and any amendments made to these directives when using Cambium equipment in EU countries. 

 

Disposal of Cambium equipment 

European Union (EU) Directive 2002/96/EC Waste Electrical and Electronic Equipment (WEEE) 

Do not dispose of Cambium equipment in landfill sites. For disposal instructions, see 

http://www.cambiumnetworks.com/support 

Disposal of surplus packaging 

Do not dispose of surplus packaging in landfill sites. In the EU, it is the individual recipient’s responsibility to 

ensure that packaging materials are collected and recycled according to the requirements of EU environmental 

law. 

In non-EU countries 

In non-EU countries, dispose of Cambium equipment and all surplus packaging in accordance with national and 

regional regulations. 

 

 

http://www.cambiumnetworks.com/support
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Product description 
This chapter provides a high level description of the ePMP product. It describes the function of the product, the 

main product variants and typical deployment. It also describes the main hardware components. 

The following topics are described in this chapter: 

 The key features, typical uses, product variants and components of the ePMP are explained in Overview of 

ePMP on page 18. 

 How the ePMP wireless link is operated, including modulation modes, power control and security is described 

under Wireless operation on page 20. 

 The ePMP management system, including the web interface, installation, configuration, alerts and upgrades is 

described in System management on page 24. 
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Overview of ePMP 

This section introduces the key features, typical uses, product variants and components of the ePMP. 

PURPOSE 

Cambium ePMP Series products are designed for Ethernet bridging over point-to-multipoint microwave links in 

the unlicensed 5 GHz and 2.4 GHz bands. Users must ensure that the ePMP Series complies with local operating 

regulations. 

The ePMP Series acts as a transparent bridge between two segments of the operator and customers’ networks. In 

this sense, it can be treated as a virtual wired connection between the Access Point and the Subscriber Module. 

The ePMP Series forwards 802.3 Ethernet packets destined for the other part of the network and filters packets it 

does not need to forward.  

KEY FEATURES 

The ePMP is a high performance wireless bridge for Ethernet traffic with a maximum UDP throughput of 200+ 

Mbps (40 MHz Channel Bandwidth). It is capable of operating in line-of-sight (LOS) and near-LOS conditions. Its 

maximum LOS range is 13 mi (20 MHz channel bandwidth) or 9 mi (40 MHz channel bandwidth). 

Utilizing GPS sync, the ePMP is an ideal fit for networks that require capacity and reliability for superior QoS in 

remote and underserved areas. The integrated PTP and PMP solution features an efficient GPS synchronized 

operational mode that permits highly scalable frequency reuse. 

The ePMP operates in the unlicensed 5 GHz and 2.4 GHz bands and supports a channel bandwidth of up to 

40 MHz. It is available with an integrated antenna or in connectorized version for use with an external antenna. 

The wireless link is primarily TDD based. System Release 1.2.3 added a Flexible Frame Ratio option which 

provides improved latency and throughput under unsynchronized operational mode.  

From a network point-of-view, the ePMP wireless link is a transparent Layer 2 bridge. It offers limited switching 

capability in order to support a primary and a secondary (future release) Ethernet port on the Subscriber Module. 

ePMP supports quality of service (QoS) classification capability and supports three traffic priorities. Management 

of the unit is conducted via the same interface as the bridged traffic (in-band Management). 

System Release 1.3.4 adds support for RADIUS EAP-TTLS authentication and VSA support for MIR.  

When deployed with a sector antenna, the ePMP 1000 GPS Sync Radio can be configured as a GPS synchronized 

Access Point serving ePMP Integrated Radios configured as Subscriber Modules. When deployed with a high 

gain point to point antenna, the ePMP GPS Sync Radio can be configured to be a GPS Synchronized Backhaul 

Master, forming a PTP link with another ePMP Radio module. 

A summary of the main ePMP characteristics is listed under Table 1. 
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Table 1  Main characteristics of the ePMP Series 

Characteristic Value 

Topology PMP or PTP 

Wireless link condition LOS, near LOS 

Range 5 MHz:  Up to 21 mi 

10 MHz:  Up to 17 mi 

20 MHz:  Up to 13 mi 

40 MHz:  Up to 9 mi 

Scheduler TDD (fixed ratios or Flexible), ePTP 

Connectivity Ethernet 

Operating frequencies Unlicensed bands, 5 GHz and 2.4 GHz 

Channel bandwidth 5 MHz, 10 MHz, 20 MHz or 40 MHz 

Data rate 200+ Mbps 

 

TYPICAL DEPLOYMENT EQUIPMENT 

The ePMP is a solution consisting of integrated or connectorized outdoor units, indoor power supply units/LAN 

injectors, cabling and surge suppression equipment. 

The main hardware components of an ePMP deployment are as follows: 

 Connectorized Radio with GPS Sync: A connectorized outdoor transceiver unit containing all the radio, 

networking, and surge suppression electronics. 

 GPS Sync Connectorized Radio: An indoor power supply module providing Power-over-Ethernet (PoE) 

supply and 1000/100/10 Base-TX to the Access Point. 

 Connectorized Radio Cabling and lightning protection: Shielded Cat5e cables, grounding cables, and 

connectors. 

 Integrated Radio: An integrated-antenna outdoor transceiver unit containing all the radio, networking, 

antenna, and surge suppression electronics. 

 Integrated or Un-sync Connectorized Radio: A connectorized outdoor transceiver unit containing all the 

radio, networking and surge suppression electronics. 

 Integrated Radio Power Supply: An indoor power supply module providing Power-over-Ethernet (PoE) 

supply and 100/10 Base-TX to the Subscriber Module. 

 Integrated Radio Cabling and lightning protection: Shielded Cat5e cables and connectors 

 

For more information about these components, including interfaces, specifications and Cambium part numbers, see 

System hardware on page 27. 
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Wireless operation 

This section describes how the ePMP wireless link is operated, including modulation modes, power control and 

security. 

TIME DIVISION DUPLEXING 

TDD cycle 

ePMP links operate using Time Division Duplexing (TDD). The links employ a TDD cycle in which the APs 

determines which SMs may transmit and when based on the configured downlink/uplink ratio (duty cycle). Three 

fixed Downlink/Uplink frame ratios are available – 75/25, 50/50 and 30/70. A flexible frame ratio is available as a 

fourth option where the AP dynamically determines the downlink and uplink ratio based on data demand in each 

direction.  

OFDM AND CHANNEL BANDWIDTH 

The ePMP series transmits using Orthogonal Frequency Division Multiplexing (OFDM). This wideband signal 

consists of many equally spaced sub-carriers. Although each sub carrier is modulated at a low rate using 

conventional modulation schemes, the resultant data rate from all the sub-carriers is high.  

The channel bandwidth of the OFDM signal is 5 MHz, 10 MHz, 20 MHz or 40 MHz, based on operator 

configuration. 

 Each channel is offset in center frequency from its neighboring channel by 5 MHz.  

ADAPTIVE MODULATION 

The ePMP series can transport data over the wireless link using a number of different modulation modes ranging 

from 64-QAM to QPSK. For a given channel bandwidth and TDD frame structure, each modulation mode 

transports data at a fixed rate. Also, the receiver requires a given signal to noise ratio in order to successfully 

demodulate a given modulation mode. Although the more complex modulations such as 64QAM will transport 

data at a much higher rate than the less complex modulation modes, the receiver requires a much higher signal to 

noise ratio. 

The ePMP series provides an adaptive modulation scheme where the receiver constantly monitors the quality of 

the received signal and notifies the far end of the link of the optimum modulation mode with which to transmit. In 

this way, optimum capacity is achieved at all times.  

MIMO 

Multiple-Input Multiple-Output (MIMO) technique provides protection against fading and increases the 

probability of a received decoded signal to be usable.  

The ePMP transmits two signals on the same radio frequency, one of which is 90 degrees offset from the other.  
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RADAR AVOIDANCE 

In regions where protection of radars is part of the local regulations, the ePMP must detect interference from 

radar-like systems and avoid co-channel operation with these systems. 

To meet this requirement, the ePMP implements the following features: 

 The equipment can only transmit on available channels, of which there are none at initial power up. The radar 

detection algorithm will always scan a usable channel for 60 seconds for radar interference before making the 

channel an available channel. 

 This compulsory channel scan will mean that there is at least 60 seconds service outage every time radar is 

detected and that the installation time is extended by at least 60 seconds even if there is found to be no radar 

on the channel 

There is a secondary requirement for bands requiring radar avoidance. Regulators have mandated that products 

provide a uniform loading of the spectrum across all devices. In general, this prevents operation with fixed 

frequency allocations. However: 

 ETSI regulations do allow frequency planning of networks (as that has the same effect of spreading the load 

across the spectrum).  

 The FCC does allow channels to be avoided if there is actually interference on them. 

 

 Note 

When operating in a region which requires DFS, ensure that the AP is configured with alternate frequencies and 

that the SM is configured to scan for these frequencies to avoid long outages. 

 

ENCRYPTION 

The ePMP supports optional encryption for data transmitted over the wireless link. The encryption algorithm 

used is the Advanced Encryption Standard (AES) with 128-bit key size. AES is a symmetric encryption algorithm 

approved by U.S. Government organizations (and others) to protect sensitive information.  

COUNTRY CODES 

Some aspects of wireless operation are controlled, enforced or restricted according to a country code. ePMP 

country codes represent individual countries (for example Denmark) or regulatory regions (for example FCC or 

ETSI). 

Country codes affect the following aspects of wireless operation: 

 Maximum transmit power 

 Radar avoidance 

 Frequency range 

 Caution 

To avoid possible enforcement action by the country regulator, always operate links in accordance with 

local regulations 
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PMP NETWORKS 

Using frequency planning 

Frequency planning is the exercise of assigning operating channels to PMP units so as to minimize RF 

interference between links. Frequency planning must consider interference from any PMP unit to any other PMP 

unit in the network. Low levels of interference normally allow for stable operation and high link capacity. 

The frequency planning task is made more straightforward by use of the following techniques: 

 Using several different channels 

 Separating units located on the same mast 

 Configuring a 5 MHz guard band between adjacent sector operating band edges. 

 

For help with planning networks, see System planning. You can also contact your Cambium distributor or re-

seller.  
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FURTHER READING ON WIRELESS OPERATION 

For information on planning wireless operation, see: 

 The regulatory restrictions that affect radio spectrum usage, such as frequency range and radar avoidance is 

described under Radio spectrum planning on page 59 

 The factors to be taken into account when planning links such as range, path loss and data throughput are 

described under Link planning on page 62. 

 The safety specifications against which the ePMP has been tested are listed under Compliance with safety 

standards on page 305. It also describes how to keep RF exposure within safe limits. 

 How ePMP complies with the radio regulations that are enforced in various countries is explained in 

Compliance with radio regulations on page 316. 

 Compliance with the radio regulations that are enforced in various regions is explained under Notifications 

on page 332. 

 Tables and graphs to support calculation of the data rate capacity that can be provided by ePMP 

configurations are available at Data throughput tables on page 344. 

 

For more information on configuring and operating the wireless link, see: 

 The configuration parameters of the ePMP devices described under Configuration on page 66. 

 Post-installation procedures and troubleshooting tips explained under Operation and Troubleshooting on 

page 218`. 
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System management  

This section introduces the ePMP management system, including the web interface, installation, alerts and 

upgrades, configuration and management software. 

MANAGEMENT AGENT 

ePMP equipment is managed through an embedded management agent. Management workstations, network 

management systems or PCs can be connected to this agent using the module’s Ethernet port or over the air (SM). 

The management agent supports the following interfaces: 

 Hypertext Transfer Protocol (HTTP) 

 Hypertext Transfer Protocol secure (HTTPs) 

 Simple Network Management Protocol (SNMP) 

 Network Time Protocol (NTP) 

 System logging (Syslog) 

 Cambium Network Services Server (CNSS) software 

 Dynamic Host Configuration Protocol (DHCP) 

WEB SERVER 

The ePMP management agent contains a web server. The web server supports access via the HTTP and HTTPs 

interfaces. 

Web-based management offers a convenient way to manage the ePMP equipment from a locally connected 

computer or from a network management workstation connected through a management network, without 

requiring any special management software. The web-based interfaces are the only interfaces supported for 

installation of ePMP, and for the majority of ePMP configuration management tasks. 
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Figure 1  AP web-based management screenshot 

 

 

Web pages 

The web-based management interfaces provide comprehensive web-based fault, configuration, performance and 

security management functions organized into the following web-pages and groups: 

Access Point and Subscriber Module web-pages: 

 Dashboard:  The Dashboard web-page reports the general device status, session status, remote subscriber 

status, event log information, and network interface status. 

 Configure: The Configuration web-page may be utilized for configuring general device parameters, as well as 

IP, radio, SNMP, Quality of Service (QoS), security, time, VLAN, protocol filtering, and unit settings. 

 Monitor: The Monitor web-page reports detailed operating statistics for the radio link and network, and 

reports system log information. 

 Tools: The tools web-page offers useful tools for device installation, configuration, and operation including 

software upgrade, backup/restore, spectrum analyzer, throughput test, ping test, and traceroute. 

 Quick Start: The Quick Start web-page provides quick access to requisite parameters for radio link 

establishment and network access. 
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Identity-based user accounts 

When identity-based user accounts are configured, a security officer can define from one to four user accounts, 

each of which may have one of the four possible roles: 

 ADMINISTRATOR (default username/password “admin”), who has full read and write permission. 

 INSTALLER (default username/password “installer”), who has permission to read and write parameters 

applicable to unit installation and monitoring. 

 HOME (default username/password “home”), who has permission only to access pertinent information for 

support purposes 

 READONLY (default username/password “readonly”), who has permission to only view the Monitor page. 

SNMP 

The management agent supports fault and performance management by means of an SNMP interface. The 

management agent is compatible with SNMP v2c using one Management Information Base (MIB) file which is 

available for download from the Cambium Networks Support website 

(https://support.cambiumnetworks.com/files/epmp). 

NETWORK TIME PROTOCOL (NTP) 

The clock supplies accurate date and time information to the system. It can be set to run with or without a 

connection to a network time server (NTP). It can be configured to display local time by setting the time zone and 

daylight saving in the Time web page. 

If an NTP server connection is available, the clock can be set to synchronize with the server time at regular 

intervals.  

ePMP devices may receive NTP data from a CMM3 or CMM4 module or an NTP server configured in the 

system’s management network. 

The Time Zone option is configurable on the AP’s Configure => System page and may be used to offset the 

received NTP time to match the operator’s local time zone.  

CAMBIUM NETWORK SERVICES SERVER 

The Cambium Network Services Server (CNSS) may be used to monitor, configure, and upgrade Cambium 

network equipment.  

For Cambium Network Services Server download, see https://support.cambiumnetworks.com/files/cnss. 

SOFTWARE UPGRADE 

Software upgrades may be issued via the radio web interface (Tools => Software Upgrade) or via CNSS 

(Cambium Networks Services Server). 

For Software upgrades, see  
https://support.cambiumnetworks.com/files/epmp. 

FURTHER READING ON SYSTEM MANAGEMENT 

For more information on system management, see: 

 AP System page on page 101 

 SM System page on page 158 

 Operation and Troubleshooting on page 218 

https://support.cambiumnetworks.com/files/epmp
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System hardware 
This chapter describes the site planning and hardware components of an ePMP link. 

The following topics are described in this chapter:  

 Factors to be considered when planning the proposed network is described under Site planning on page 28. 

 The connectorized module hardware, part numbers, mounting equipment, and specifications are described 

under Connectorized Module on page 30. 

 The SM hardware, part numbers, mounting equipment and specifications are described under Integrated 

Module on page 38. 

 The hardware, part numbers, mounting equipment and specifications are described under Un-synced 

Connectorized Radio on page 44. 

 The power supply hardware, part numbers and specifications are described under Power supply on page 52. 

 The AP antenna and part numbers are described under Connectorized module antennas and antenna 

cabling on page 37. 

 Cable standards and lengths are described under Ethernet cabling on page 55. 

 Surge suppression requirements and recommendations are described under Surge Suppression unit on page 

56. 
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Site planning 

Conduct a site survey to ensure that the proposed AP and SM sites meet the requirements defined in this section. 

SITE INSTALLATION 

An ePMP site typically consists of a high supporting structure such as a mast, tower or building for the AP or SM.  

There is only one Ethernet interface, a copper Cat5e connection from the AP or SM to the AP/SM power supply 

and network terminating equipment. If a 1000 Base-TX (Gigabit) Ethernet connection is required at the AP, 

ensure that power supply N000900L001A is utilized. 

GROUNDING AND LIGHTNING PROTECTION 

Structures, equipment and people must be protected against power surges (typically caused by lightning) by 

conducting the surge current to ground via a separate preferential solid path. The actual degree of protection 

required depends on local conditions and applicable local regulations. To adequately protect an ePMP installation, 

both ground bonding and transient voltage surge suppression are required. 

 Warning 

Electro-magnetic discharge (lightning) damage is not covered under warranty. The recommendations in this 
guide, when followed correctly, give the user the best protection from the harmful effects of EMD. However 
100% protection is neither implied nor possible. 

Details of lightning protection methods and requirements can be found in the international standards IEC 61024-1 

and IEC 61312-1, the U.S. National Electric Code ANSI/NFPA No. 70-1984 or section 54 of the Canadian 

Electric Code. 

 Note 

International and national standards take precedence over the requirements in this guide. 
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LIGHTNING PROTECTION ZONES 

Use the rolling sphere method (Figure 2) to determine where it is safe to mount equipment. An imaginary sphere, 

typically 50 meters in radius, is rolled over the structure. Where the sphere rests against the ground and a strike 

termination device (such as a finial or ground bar), all the space under the sphere is considered to be in the zone of 

protection (Zone B). Similarly, where the sphere rests on two finials, the space under the sphere is considered to be 

in the zone of protection. 

Figure 2  Rolling sphere method to determine the lightning protection zones 

Assess locations on masts, towers 

and buildings to determine if the 

location is in Zone A or Zone B: 

 Zone A: In this zone a direct 

lightning strike is possible. Do 

not mount equipment in this 

zone. 

 Zone B: In this zone, direct 

EMD (lightning) effects are 

still possible, but mounting in 

this zone significantly reduces 

the possibility of a direct 

strike. Mount equipment in 

this zone. 

 

 

 Warning 

Do not mount equipment in Zone A which can put the equipment, structures and life at risk. 
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Connectorized Module 

For details of the ePMP connectorized hardware, see: 

 Connectorized Module description  on page 30 

 Connectorized part numbers on page 31 

 Connectorized Module interfaces on page 32 

 Connectorized Module specifications on page 34 

 Connectorized Module and external antenna location on page 35 

 Connectorized Module wind loading on page 36 

 Connectorized Module software packages on page 36 

 Connectorized module antennas and antenna cabling on page 37 

 

CONNECTORIZED MODULE DESCRIPTION 

The connectorized ePMP device is a self-contained 

transceiver unit that houses both radio and networking 

electronics. The connectorized unit is designed to work 

with externally mounted antennas that have high gains. 

Connectorized units can cope with more difficult radio 

conditions. The unit is designed with female RP-SMA 

50Ω antenna connections located at the top of the unit. 

An ePMP connectorized unit may function as an Access 

Point (AP) or a Subscriber Module (SM) in a Point-To-

Multipoint (PMP) or in a Point-To-Point (PTP) 

network topology. 

 Note 

To select antennas, RF cables and connectors for 

connectorized units, see Connectorized module 

antennas and antenna cabling on page 37. 

 

Figure 3  ePMP Series Connectorized Radio with Sync 
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CONNECTORIZED PART NUMBERS 

Choose the correct regional variant: one is for use in regions where FCC or IC licensing restrictions apply 

(FCC/IC), and the other is for use in ETSI countries or non-FCC/IC/ETSI-restricted regions. 

Each of the parts listed in Table 2 includes the following items: 

 One connectorized unit 

 One power supply 1000/100/10 Base-TX LAN injector 

 

The GPS-capable parts listed in Table 2 also ship with a GPS antenna. 

Table 2  Connectorized part numbers 

Cambium description Cambium part number 

ePMP GPS, Conn - 5 GHz - no power cord – ROW version C050900A011A 

ePMP GPS, Conn - 5 GHz – no power cord – EU version C050900A013A 

ePMP GPS, Conn - 5 GHz - US power cord – FCC version C058900A112A 

ePMP GPS, Conn - 2.4 GHz - US power cord C024900A011A 

Table 3  AP accessory part numbers 

Cambium description Cambium part number 

ePMP Power Supply for GPS Radio - no cord (spare) N000900L001A 

ePMP Power Supply for non-GPS Radio - no cord (spare) N000900L002A 

 

CONNECTORIZED MODULE MOUNTING BRACKET 
 
The connectorized unit is designed to be attached to a Cambium ePMP sector antenna (see Table 10). The 

Cambium ePMP sector antenna contains all of the mounting brackets, antenna cabling, and GPS antenna 

mounting for device deployment. 
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 Figure 4 Connectorized module sector antenna 

 

CONNECTORIZED MODULE INTERFACES 

The connectorized module interfaces are illustrated in Figure 5 and described in Table 4. 

Figure 5  Connectorized module interfaces 

 

  

 

  

Antenna port V 

Antenna port H 

ET
H 
GPS 
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Table 4  Connectorized module interfaces 

Name Connector Interface Description 

Antenna 

port H 
RP-SMA, female 

Antenna, 

H polarization 
To/from H polarized antenna port 

Antenna 

port V 
RP-SMA, female 

Antenna, 

V polarization 
To/from V polarized antenna port 

ETH RJ45 

PoE input 

802.3af PoE Standard, as well as Proprietary power over 

Ethernet (PoE) twisted pair (for powering via 

CMM3/CMM4) 

10/100/1000 

Base-TX 

Ethernet 

Management and data 

GPS SMA, female Antenna, GPS To/from GPS antenna 

Reset 

Button 
Physical button N/A 

For resetting the radio and for setting the radio back to 

its factory default configuration.  See Using the device 

external reset button on page 227. 

CONNECTORIZED MODULE LEDS 

 

LED Function 

POWER Green: Power is applied to the device 

Unlit:  No power is applied to the device or improper 

power source 

GPS 

SYNC 

Orange: AP has acquired a 1PPS GPS synchronization 

pulse either from the internal GPS module and antenna 

or from a connected CMM 

Unlit:  1PPS GPS not acquired, or Synchronization 

Source set to Internal (AP generating sync, not GPS-

based) 

 

Reserved for future release 

ETH Once lit, blinking indicates Ethernet activity 

Red:  10BaseTX link 

Green: 100BaseTX link 

Orange:  1000BaseTX link 

Unlit:  No Ethernet link established 
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CONNECTORIZED MODULE SPECIFICATIONS 

The ePMP connectorized module conforms to the specifications listed in Table 5 and Table 6.  

The connectorized module meets the low level static discharge specifications identified in Electromagnetic 

compatibility (EMC) compliance on page 305 and provides internal surge suppression but does not provide 

lightning suppression. 

For a full listing of connectorized radio specifications, see Connectorized Radio Specifications on page 347. 

Table 5  Connectorized module physical specifications 

Category Specification 

Dimensions (H x W x D) Radio: 227 x 88 x 33 mm (8.9” x 3.5” x 1.3”) 

Antenna: 529 x 124 x 53 mm (20.8” x 4.9” x 2.1”) 

Weight  .521 kg (1.15 lbs) without antenna 

4.5 kg (10 lbs) with antenna 

Table 6  Connectorized module environmental specifications 

Category Specification 

Temperature  -30°C (-22°F) to +55°C (131°F) 

Wind loading  118 mph (190 kph) maximum. See Connectorized Module wind 

loading on page 36 for a full description. 

Humidity  95% condensing 

Environmental IP55 
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CONNECTORIZED MODULE HEATER 

At startup, if the ePMP connectorized module temperature is at or below 32° F (0° C), an internal heater is 

activated to ensure that the device is able to successfully begin operation. The unit’s heater is only activated when 

the unit is powered on and will not apply heat to the device once startup is complete. When the unit temperature is 

greater than 32° F (0° C), the heater is deactivated and the unit continues its startup sequence. 

The effect on device startup time at various temperatures is defined in Table 7. 

Table 7  Connectorized module startup times based on ambient temperature 

Initial Temperature Startup time (from power on to operational) 

-22° F (-30° C) 20 minutes 

-4° F (-20° C) 6 minutes 

14° F (-10° C) 2 minutes, 30 seconds 

 

CONNECTORIZED MODULE AND EXTERNAL ANTENNA LOCATION 

Find a location for the device and external antenna that meets the following requirements: 

 The equipment is high enough to achieve the best radio path. 

 People can be kept a safe distance away from the equipment when it is radiating. The safe separation distances 

are defined in Calculated distances and power compliance margins on page 307. 

 The equipment is lower than the top of the supporting structure (tower, mast or building) or its lightning air 

terminal. 

 The location is not subject to excessive wind loading. For more information, see Connectorized Module 

wind loading on page 36. 



CAMBIUM NETWORKS 

 

 36 

CONNECTORIZED MODULE WIND LOADING 

Ensure that the device and the structure on which it is mounted are capable of withstanding the prevalent wind 

speeds at a proposed ePMP site. Wind speed statistics is available from national meteorological offices. 

The device and its mounting bracket are capable of withstanding wind speeds of up to 190 Kph (118 mph). 

Wind blowing on the device will subject the mounting structure to significant lateral force. The magnitude of the 

force depends on both wind strength and surface area of the device. Wind loading is estimated using the following 

formulae: 

Force (in kilograms) = 0.1045aV2 

Where:  Is:  

 a  surface area in square meters 

 V  wind speed in meters per second 

Force (in pounds) = 0.0042Av2 

Where:  Is:  

 A  surface area in square feet 

 v  wind speed in miles per hour 

 

Applying these formulae to the ePMP device at different wind speeds, the resulting wind loadings are shown in 

Table 8 and Table 9. 

Table 8  Connectorized module wind loading (Kg) 

Type of ePMP 

device 

Largest  

surface area 

(square meters) 

Wind speed (meters per second) 

30 40 50 60 70 

Connectorized 0.13 12.2 Kg 21.7 Kg 34 Kg 49 Kg 66.6 Kg 

 

Table 9  Connectorized module wind loading (lb) 

Type of ePMP device Largest surface 

area (square 

feet) 

Wind speed (miles per hour) 

80 100 120 140 150 

Connectorized 1.39 37.4 lb 58.4 lb 84.1 lb 114.4 lb 131.4 lb 
 

CONNECTORIZED MODULE SOFTWARE PACKAGES 

Connectorized radios may be upgraded by downloading new software packages from the Cambium Networks 
website or by using the Cambium Network Services Server.  The software packages applicable to ePMP 
connectorized radios are named: 

 ePMP-GPS_Synced-v2.4.tar.gz 
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Connectorized module antennas and antenna cabling 

Connectorized modules require external antennas connected using RF cable (included with Cambium ePMP sector 

antennas). For details of the antennas and accessories required for a connectorized ePMP installation, see: 

 Antenna requirements on page 37 

 FCC and IC approved antennas on page 37 

ANTENNA REQUIREMENTS 

For connectorized units operating in the USA or Canada 2.4 GHz, 5.2 GHz, 5.4 GHz or 5.8 GHz bands, choose 

external antennas from those listed in FCC and IC approved antennas on page 37. For installations in other 

countries, the listed antennas are advisory, not mandatory. 

FCC AND IC APPROVED ANTENNAS 

For connectorized units operating in the USA or Canada, choose external antennas from Table 10. These are 

approved by the FCC for use with the product and are constrained by the following limits: 

 5 GHz – 15 dBi gain 

 2.4 GHz - 15 dBi gain 

 Caution 

Using other than approved antennas may cause measurements higher than reported for certification. 

 Caution 

This radio transmitter (IC certification number 109W-0005) has been approved by Industry Canada to operate 

with the antenna types listed below with the maximum permissible gain and required antenna impedance for 

each antenna type indicated. Antenna types not included in this list, having a gain greater than the maximum 

gain indicated for that type, are strictly prohibited for use with this device. 

Le présent émetteur radio (Numéro de certification IC  109W-0005) a été approuvé par Industrie Canada pour 

fonctionner avec les types d'antenne énumérés ci-dessous et ayant un gain admissible maximal et l'impédance 

requise pour chaque type d'antenne. Les types d'antenne non inclus dans cette liste, ou dont le gain est supérieur 

au gain maximal indiqué, sont strictement interdits pour l'exploitation de l'émetteur. 

Table 10  Allowed antennas for deployment in USA/Canada 

Cambium part 

number 

Antenna Type Gain (dBi) 

C050900D003A 5 GHz Sector Antenna – 90 degree 15 

C050900D002A 5 GHz Sector Antenna – 120 degree 15 

C024900D004A 2.4 GHz Sector Antenna - 90 /120 degree 15 
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Integrated Module 

For details of the ePMP integrated hardware, see: 

 Integrated Module description on page 38 

 Integrated Module part numbers on page 39 

 Integrated Module mounting bracket on page 39 

 Integrated Module interfaces on page 40 

 Integrated Module specifications on page 41 

 Integrated Module heater on page 42 

 Integrated Module wind loading on page 42 

 Integrated Module software packages on page 43. 

 

INTEGRATED MODULE DESCRIPTION 

The integrated module is a self-contained transceiver 

unit that houses both radio and networking electronics. 

An ePMP integrated unit may function as an Access 

Point (AP) or a Subscriber Module (SM) in a Point-To-

Multipoint (PMP) or in a Point-To-Point (PTP) 

network topology. 

Figure 6  ePMP Series Integrated Radio 
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INTEGRATED MODULE PART NUMBERS 

Choose the correct regional variant: one is for use in regions where FCC or IC licensing restrictions apply 

(FCC/IC) and the other is for use in ETSI countries or the rest of the world (ETSI/RoW). 

Each of the parts listed in Table 11 includes the following items: 

 One integrated module (with mounting bracket) 

 One metal mounting strap 

 Power supply 

Table 11  Integrated module part numbers 

Cambium description Cambium part number 

ePMP Integrated – 5 GHz – no power cord – ROW version C050900C031A 

ePMP Integrated – 5 GHz – EU power cord – EU version C050900P033A 

ePMP Integrated – 5 GHz – US power cord – FCC version C058900C132A 

ePMP Integrated - 2.4 GHz - US power cord C024900C031A 

Table 12  Integrated module accessory part numbers 

Cambium description Cambium part number 

ePMP Power Supply for non-GPS Radio - no cord (spare) N000900L002A 

INTEGRATED MODULE MOUNTING BRACKET 

The integrated module is designed to be pole-mounted 

using the mounting strap and bracket provided in the 

box with the radio.  

 

Figure 7  Integrated module mounting bracket 
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INTEGRATED MODULE INTERFACES 

The integrated module interfaces are illustrated in Figure 8 and described in Table 13. 

Figure 8  Integrated module interfaces 

  

Table 13  Integrated module interfaces 

Port name Connector Interface Description 

Primary Ethernet RJ45 

PoE input 

Proprietary power over Ethernet (PoE) 

twisted pair (for powering via 

CMM3/CMM4) 

10/100 Base-TX 

Ethernet 
Management and data 

Auxiliary Ethernet 

(future release) 
RJ45 

Cambium proprietary 

PoE output, data 

bridging 

Proprietary 30V PoE output for auxiliary 

devices (not 802.3af standard PoE) 

 

Auxiliary 
Ethernet 

Primary 
Ethernet 
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INTEGRATED MODULE LEDS 
 

 

LED Function 

POWER 

Green: Power is applied to the device 

Unlit:  No power is applied to the device or improper power 

source 

ETH 1 

Main/Primary Ethernet port indicator 

Once lit, blinking indicates Ethernet activity 

Green:  10/100BaseTX link 

ETH 2 

Auxiliary/Secondary Ethernet port indicator 

Once lit, blinking indicates Ethernet activity 

Green:  10/100BaseTX link 

 

Radio scanning:  LEDs light in an ascending sequence to 

indicate that the radio is scanning 

Radio registered:  LEDs light to indicate the RSSI level at 

the device. 

 

 

RSSI  

> -60 
dBm 

 

-70 dBm  

< RSSI ≤≤  

-60 dBm 
 

-80 dBm  

< RSSI ≤ 

-70 dBm 
 

RSSI  

≤ -80 
dBm 

 

INTEGRATED MODULE SPECIFICATIONS 

The ePMP integrated module conforms to the specifications listed in Table 14 and Table 15. 

The integrated device meets the low level static discharge specifications identified in Electromagnetic 

compatibility (EMC) compliance on page 305 and provides internal surge suppression but does not provide 

lightning suppression. 

For a full listing of integrated radio specifications, see Integrated Radio Specifications on page 351. 
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Table 14  Integrated module physical specifications 

Category Specification 

Dimensions (H x W x D)  Radio: 29.1 x 14.5 x 8.3 cm (11.4 x 5.7 x 3.3 in) 

Weight  0.49 kg (1.1 lbs) 

 

Table 15  Integrated module environmental specifications 

Category Specification 

Temperature  -30°C (-22°F) to +60°C (131°F) 

Wind loading  90 mph (145 kph) maximum. See Integrated Module wind loading on page 42 for a 

full description. 

Humidity  95% condensing 

Environmental IP55 

INTEGRATED MODULE HEATER 

Upon power on, if the ePMP integrated module device temperature is at or below 32° F (0° C), an internal heater 

is activated to ensure that the device is able to successfully begin operation. The unit’s heater is only activated 

when the unit is powered on and will not apply heat to the device once startup is complete. When the unit 

temperature is greater than 32° F (0° C), the heater is deactivated and the integrated module continues its startup 

sequence. 

The effect on integrated module startup time at various temperatures is defined in Table 16. 

Table 16  Integrated module startup times based on ambient temperature 

Initial Temperature Startup time (from power on 

to operational) 

-22° F (-30° C) 4 minutes 

-4° F (-20° C) 2 minutes 

14° F (-10° C) 1 minutes, 30 seconds 

INTEGRATED MODULE WIND LOADING 

Ensure that the integrated module and the structure on which it is mounted are capable of withstanding the 

prevalent wind speeds at a proposed ePMP site. Wind speed statistics must be available from national 

meteorological offices. 

The integrated module and its mounting bracket are capable of withstanding wind speeds of up to 145 Kph 

(90 mph). 

Wind blowing on the integrated module will subject the mounting structure to significant lateral force.  The 

magnitude of the force depends on both wind strength and surface area of the integrated module. Wind loading is 

estimated using the following formulae: 
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Force (in kilograms) = 0.1045aV2 

Where:  Is:  

 a  surface area in square meters 

 V  wind speed in meters per second 

Force (in pounds) = 0.0042Av2 

Where:  Is:  

 A  surface area in square feet 

 v  wind speed in miles per hour 

Applying these formulae to the ePMP integrated module at different wind speeds, the resulting wind loadings are 

shown in Table 17 and Table 18. 

Table 17  Integrated module wind loading (Kg) 

Type of ePMP 

module 

Largest  

surface area (square 

meters) 

Wind speed (meters per second) 

30 40 50 60 70 

Integrated 0.042 4 Kg 7 Kg 11 Kg 15.8 Kg 21.6 Kg 

 

Table 18  Integrated module wind loading (lb) 

Type of ePMP 

module 

Largest surface area 

(square feet) 

Wind speed (miles per hour) 

80 100 120 140 150 

Integrated 0.45 12.1 lb  18.9 lb  27.2 lb  37 lb  42.5 lb  
 

INTEGRATED MODULE SOFTWARE PACKAGES 

Integrated radios may be upgraded by downloading new software packages from the Cambium Networks website 
or by using the Cambium Network Services Server. The software packages applicable to ePMP integrated radios 
are named: 

 

   ePMP-NonGPS_Synced-v2.4.tar.gz 
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Un-synced Connectorized Radio 

For details of the ePMP connectorized hardware, see: 

 Un-synced Connectorized Radio description  on page 44 

 Un-synced Connectorized Radio part numbers on page 45 

 Un-synced Connectorized Radio Interfaces on page 46 

 Un-synced Connectorized Radio specifications on page 48 

 Un-synced Connectorized Radio and external antenna location on page 49 

 Un-synced connectorized Radio wind loading on page 50 

 Un-synced Connectorized Radio software packages on page 51 

 Un-synced connectorized radio antennas and antenna cabling on page 51 

 

UN-SYNCED CONNECTORIZED RADIO DESCRIPTION 

The connectorized ePMP device is a self-contained 

transceiver unit that houses both radio and networking 

electronics. The connectorized unit is designed to work 

with externally mounted antennas that have high gains. 

Connectorized units can cope with more difficult radio 

conditions. The unit is designed with female RP-SMA 

50Ω antenna connections located at the top of the unit. 

An ePMP connectorized unit may function as an Access 

Point (AP) or a Subscriber Module (SM) in a Point-To-

Multipoint (PMP) or in a Point-To-Point (PTP) 

network topology.  

Figure 9  ePMP Series Un-synced Connectorized 
Radio 

 

 

 Note 

To select antennas, RD cables and connectors for connectorized units, see Un-synced connectorized radio 

antennas and antenna cabling on page 51. 
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UN-SYNCED CONNECTORIZED RADIO PART NUMBERS 

Choose the correct regional variant: one is for use in regions where FCC or IC licensing restrictions apply 

(FCC/IC) and the other is for use in ETSI countries or non-FCC/IC/ETSI-restricted regions. 

Each of the parts listed in Table 19 includes the following items: 

 One connectorized unit 

 One power supply 100/10 Base-TX LAN injector 

 

Table 19  Un-synced Connectorized Radio part numbers 

Cambium description Cambium part number 

ePMP Conn – 5 GHz – no power cord – ROW version C050900A021A 

ePMP Conn – 5 GHz – EU power cord – EU version C050900A023A 

ePMP Conn – 5 GHz – US power cord – FCC version C058900A122A 

ePMP Conn – 2.4 GHz – US power cord C024900A021A 

 

Table 20  AP accessory part numbers 

Cambium description Cambium part number 

ePMP Power Supply for non-GPS Radio - no cord (spare) N000900L002A 

 

UN-SYNCED CONNECTORIZED RADIO MOUNTING BRACKET 

The un-synced connectorized unit is designed to be 

attached to a Cambium ePMP sector antenna or with a 

non-Cambium antenna. 

 

Figure 10  Un-synced connectorized radio sector 
antenna 

 

  



CAMBIUM NETWORKS 

 

 46 

UN-SYNCED CONNECTORIZED RADIO INTERFACES 

The un-synced connectorized radio with interfaces are illustrated in Figure 11 and described in Table 21. 

Figure 11  Un-synced connectorized radio interfaces 

 

 

 

 

Table 21  Un-synced connectorized radio interfaces 

Name Connector Interface Description 

Antenna 

port H 
RP-SMA, female 

Antenna, 

H polarization 
To/from H polarized antenna port 

Antenna 

port V 
RP-SMA, female 

Antenna, 

V polarization 
To/from V polarized antenna port 

Primary 

Ethernet 
RJ45 

PoE input 
Proprietary power over Ethernet (PoE) twisted pair 
(for powering via CMM3/CMM4)  

10/100 Base-TX 

Ethernet 
Management and data 

Auxiliary 
Ethernet  
(future 
release)  

RJ45 

Cambium 

propriety PoE 

output, data 

bridging 

Propriety 30V PoE output for auxiliary devices (not 

802 3af standard Poe) 

Reset 
Button Physical button N/A 

For resetting the radio and for resetting the radio back 

to its factory default configuration, see Using the 

device external reset button on page 227. 

 

UN-SYNCED CONNECTORIZED RADIO LEDS 
 

Antenna port V 

Antenna port H 

AUXILLARY 
ETHERNET 

PRIMARY 
ETHERNE
T 
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LED Function 

POWER Green: Power is applied to the device 

Unlit:  No power is applied to the device or 

improper power source 

ETH 1 Main/Primary Ethernet port indicator 

Once lit, blinking indicates Ethernet activity 

Green: 10/100BaseTX link 

ETH 2 Auxiliary/Secondary Ethernet port indicator 

Once lit, blinking indicates Ethernet activity 

Green: 10/100BaseTX link 

Radio scanning: LEDs light in an ascending 

sequence to indicate that the radio is scanning 

Radio registered: LEDs light to indicate the RSSI 

level at the device. 

 

Reserved for future release 

 

 
 

 

RSSI  

> -60 
dBm 

 

-70 dBm  

< RSSI ≤ 

-60 dBm 
 

-80 dBm  

< RSSI ≤ 

-70 dBm 
 

RSSI  

≤ -80 
dBm 
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UN-SYNCED CONNECTORIZED RADIO SPECIFICATIONS 

The ePMP un-synced connectorized radio conforms to the specifications listed in Table 22 and Table 23.  

The connectorized module meets the low level static discharge specifications identified in Electromagnetic 

compatibility (EMC) compliance on page 305  and provides internal surge suppression but does not provide 

lightning suppression. 

For a full listing of connectorized radio specifications, see Connectorized Radio Specifications on page 347. 

Table 22  Un-synced connectorized radio physical specifications 

Category Specification 

Dimensions (H x W x D) Radio: 227 x 88 x 33 mm (8.9” x 3.5” x 1.3”) 

Antenna: 529 x 124 x 53 mm (20.8” x 4.9” x 2.1”) 

Weight  .521 kg (1.15 lbs) without antenna 

4.5 kg (10 lbs) with antenna 

Table 23  Un-synced connectorized radio environmental specifications 

Category Specification 

Temperature  -30°C (-22°F) to +55°C (131°F) 

Wind loading  118 mph (190 kph) maximum. See Un-synced connectorized Radio 

wind loading on page 50 for a full description. 

Humidity  95% condensing 

Environmental IP55 
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UN-SYNCED CONNECTORIZED RADIO HEATER 

On startup, if the ePMP un-synced connectorized radio temperature is at or below 32° F (0° C), an internal heater 

is activated to ensure that the device is able to successfully begin operation. The unit’s heater is only activated 

when the unit is powered on and will not transfer heat to the device until the startup completes. When the unit 

temperature is greater than 32° F (0° C), the heater is deactivated and the unit continues its startup sequence. 

The effect on device startup time at various temperatures is defined in Table 24. 

Table 24  Un-synced connectorized radio startup times based on ambient temperature 

Initial Temperature Startup time (from power on to operational) 

-22° F (-30° C) 20 minutes 

-4° F (-20° C) 6 minutes 

14° F (-10° C) 2 minutes, 30 seconds 

 

UN-SYNCED CONNECTORIZED RADIO AND EXTERNAL ANTENNA LOCATION 

Find a location for the device and external antenna that meets the following requirements: 

 The equipment is high enough to achieve the best radio path. 

 People are a safe distance away from the equipment when it is radiating. The safe separation distances are 

defined in Calculated distances and power compliance margins on page 307. 

 The equipment is lower than the top of the supporting structure (tower, mast or building) or its lightning air 

terminal. 

 The location is not subjected to excessive wind loading. For more information, see Un-synced connectorized 

Radio wind loading on page 50. 
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UN-SYNCED CONNECTORIZED RADIO WIND LOADING 

Ensure that the device and the structure on which it is mounted are capable of withstanding the prevalent wind 

speeds at a proposed ePMP site. Wind speed statistics must be available from national meteorological offices. 

The device and its mounting bracket are capable of withstanding wind speeds of up to 190 kph (118 mph). 

Wind speeds on the device subjects the mounting structure to significant lateral force.  The magnitude of the force 

depends on both the wind strength and surface area of the device. Wind loading is estimated using the following 

formulae: 

Force (in kilograms) = 0.1045aV2 

Where:  Is:  

 a  surface area in square meters 

 V  wind speed in meters per second 

Force (in pounds) = 0.0042Av2 

Where:  Is:  

 A  surface area in square feet 

 v  wind speed in miles per hour 

 

Applying these formulae to the ePMP device at different wind speeds, the resulting wind loadings are shown in 

Table 25 and Table 26. 

Table 25  Un-synced connectorized radio wind loading (Kg) 

Type of ePMP 

device 

Largest  

surface area 

(square meters) 

Wind speed (meters per second) 

30 40 50 60 70 

Connectorized 0.13 12.2 Kg 21.7 Kg 34 Kg 49 Kg 66.6 Kg 

 

Table 26  Un-synced connectorized radio wind loading (lb) 

Type of ePMP device Largest surface 

area (square 

feet) 

Wind speed (miles per hour) 

80 100 120 140 150 

Connectorized 1.39 37.4 lb 58.4 lb 84.1 lb 114.4 lb 131.4 lb 
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UN-SYNCED CONNECTORIZED RADIO SOFTWARE PACKAGES 

Un-synced connectorized radio may be upgraded by downloading new software packages from the Cambium 
Networks website or by using the Cambium Network Services Server. The software packages applicable to ePMP 
Un-synced connectorized radio are named: 

 ePMP-NonGPS_Synced-v2.4.tar.gz 

 

UN-SYNCED CONNECTORIZED RADIO ANTENNAS AND ANTENNA CABLING 

Un-synced connectorized radio requires external antennas connected using RF cable (included with Cambium 

ePMP sector antennas). For details of the antennas and accessories required for a connectorized ePMP 

installation, see: 

 Antenna requirements on page 37 

 FCC and IC approved antennas on page 37 

 
ANTENNA REQUIREMENTS 

For connectorized units operating in the USA or Canada 2.4 GHz, 5.4 GHz or 5.8 GHz bands, choose external 

antennas from those listed in FCC and IC approved antennas on page 37. For installations in other countries, the 

listed antennas are advisory, not mandatory. 

FCC AND IC APPROVED ANTENNAS 

For connectorized units operating in the USA or Canada, choose external antennas from Table 27. These are 

approved by the FCC for use with the product and are constrained by the following limits: 

 5 GHz – 15 dBi gain 

 2.4 GHz - 15 dBi gain 

 

 Caution 

Using other than approved antennas may cause measurements higher than reported for certification. 

This radio transmitter (IC certification number 109W-0005) has been approved by Industry Canada to operate 

with the antenna types listed below with the maximum permissible gain and required antenna impedance for each 

antenna type indicated. Antenna types not included in this list, having a gain greater than the maximum gain 

indicated for that type, are strictly prohibited for use with this device. 

Le présent émetteur radio (Numéro de certification IC  109W-0005 ) a été approuvé par Industrie Canada pour 

fonctionner avec les types d'antenne énumérés ci-dessous et ayant un gain admissible maximal et l'impédance 

requise pour chaque type d'antenne. Les types d'antenne non inclus dans cette liste, ou dont le gain est supérieur 

au gain maximal indiqué, sont strictement interdits pour l'exploitation de l'émetteur. 
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Table 27  Allowed antennas for deployment in USA/Canada – 5 GHz 

Cambium part number Antenna Type Gain (dBi) 

C050900D003A 5 GHz Sector Antenna – 90 degree 15 

C050900D002A 5 GHz Sector Antenna – 120 degree 15 

C024900D004A 2.4 GHz Sector Antenna - 90 /120 degree 15 

 

Power supply 

For details of the ePMP power supply units, see: 

 Power supply description on page 52 

 Power supply part numbers on page 52 

 Power supply interfaces on page 53 

 Power supply specifications on page 54 

 Power supply location on page 54 

POWER SUPPLY DESCRIPTION 

The power supply is an indoor unit that is connected to the connectorized or integrated module and network 

terminating equipment using Cat5e cable with RJ45 connectors. It is also plugged into an AC or DC power supply 

so that it can inject Power over Ethernet (PoE) into the module.  

POWER SUPPLY PART NUMBERS 

Each module requires one power supply and one power supply line cord. For cord part numbers, see Table 28.  

The power supplies listed in Table 28 may be used for both connectorized and integrated modules, however, only 

N000900L001A provides a Gigabit Ethernet interface (connectorized modules only). 

Table 28  Power supply component part numbers 

Cambium description Cambium part number 

ePMP Pwr Supply for GPS Radio - no cord (spare) N000900L001A 

ePMP Pwr Supply for non-GPS Radio - no cord (spare) N000900L002A 
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POWER SUPPLY INTERFACES 

The power supply interfaces are illustrated in Figure 12 and described in Table 29 and Table 31. 

 

Figure 12  Power supply interfaces 

  

 

Table 29  Power supply interface functions - N000900L001A 

Interface Function 

Power input Mains power input. 

Gigabit Data + Power 

RJ45 socket for connecting Cat5e cable to radio 

 Note 

This port provides a Gigabit Ethernet interface to ePMP GPS Synced 

connectorized radios. To ePMP integrated radios, this port provides a 

10/100 Mbit/sec Ethernet interface. 

Gigabit Data RJ45 socket for connecting Cat5e cable to network. 

 

Table 30  Power supply interface functions - N000900L002A 

Interface Function 

Power input Mains power input. 

10/100 Mbit/sec Data + Power RJ45 socket for connecting Cat5e cable to radio 

10/100 Mbit/sec Data RJ45 socket for connecting Cat5e cable to network. 

 

Table 31  Power Supply LED functions 

LED Function 

Power (green) Power supply detection 

 

Gigabit 
Data 

Gigabit 
Data + 
Power 

Power 
input 
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POWER SUPPLY SPECIFICATIONS 

The ePMP power supply conforms to the specifications listed in Table 32, Table 33 and Table 34.  These 

specifications apply to all ePMP product variants. 

Table 32  Power supply physical specifications 

Category Specification 

Dimensions (H x W x D) 11.8 x 4.4 x 3.2 cm (4.66 x 1.75 x 1.25 in) 

Weight  0.26 lbs 

Table 33  Power supply environmental specifications 

Category Specification 

Ambient Operating Temperature  0° C to +40° C 

Humidity  20% - 90% 

Table 34  Power supply electrical specifications 

Category Specification 

AC Input 100 to 240 VAC 

Efficiency Meets efficiency level ‘V’ 

Over Current Protection Zener clamping (38V to 45V) 

Hold up time  10 ms minimum at maximum load, 120 VAC 

 

POWER SUPPLY LOCATION 

Find a location for the power supply that meets the following requirements: 

 The power supply can be mounted on a wall or other flat surface. 

 The power supply is kept dry, with no possibility of condensation, flooding or rising damp. 

 The power supply can be accessed to view status indicators. 

 The power supply can be connected to the ePMP module drop cable and network terminating equipment. 

 The power supply can be connected to a mains or dc power supply that meets the requirements defined in 

Table 34.  
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Ethernet cabling 

For details of the Ethernet cabling components of an ePMP installation, see: 

 Ethernet standards and cable lengths on page 55 

 Outdoor Cat5e cable on page 55 

 
ETHERNET STANDARDS AND CABLE LENGTHS 

All configurations require a copper Ethernet connection from the power supply port to the power supply and 

network terminating equipment.  

For each power supply, the maximum permitted drop cable length is specified in Table 35. 

Table 35  Power supply drop cable length restrictions 

Part number Description Maximum cable length (*1) 

N000900L001A Power Supply for Radio with 

Gigabit Ethernet (no cord) 

330 feet (100m) 

N000900L002A Power Supply for Radio with 

100Mbit Ethernet (no cord) 

330 feet (100m) 

(*1) Maximum length of Ethernet cable from AP/SM to power supply 

 
OUTDOOR CAT5E CABLE 

For copper connections from the device to the power supply, use Cat5e cable that is shielded with copper-plated 

steel. 

 

 Caution 

Always use Cat5e cable that is shielded with copper-plated steel. Alternative types of Ethernet cables are 

not supported by Cambium Networks. 
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Surge Suppression unit 

The ePMP integrated and connectorized units both contain 1 Joule-rated surge suppression built into the device. 

With this built-in surge suppression, it is not required to install a surge suppressor at the unit’s mounting 

location.  However, it is required to install a surge suppressor at the Ethernet cable’s building ingress into the 

power supply’s indoor location. For installations that do not require Gigabit (1000 Mbit/sec) Ethernet, a 

Cambium 600SSH surge suppressor may be used. For more details, see Cambium 600SSH details.  
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CAMBIUM 600SSH DETAILS 

 

 

 

 Note 

For connectorized module installations requiring 

Gigabit (1000 Mbit/sec) Ethernet surge suppression, 

utilize the following: 

Mfr Part Description 

L-

COM 

AL-CAT6JW Outdoor 10/100/1000 Base-

T CAT6 PoE Compatible 

Lightning Protector 

L-

COM 

AL-

CAT6HPJW 

Outdoor 10/100/1000 Base-

T CAT6 PoE Compatible 

Lightning Protector – High 

Power (protection 

comparable to 600SSH) 
 

1 Holes—for mounting the Surge Suppressor 

to a flat surface (such as an outside wall). The 

distance between centers is 4.25 inches (108 

mm). 

2 RJ-45 connectors—One side (neither side is 

better than the other for this purpose) 

connects to the product (AP, SM, or cluster 

management module). The other connects to 

the AC adaptor’s Ethernet connector. 

3 Ground post and washer—use heavy gauge 

(10 AWG or 6 mm2) copper wire for 

connection. Refer to local electrical codes for 

exact specifications. 

 
 Note 

The 600SSH surge suppressor is shipped in 

the “isolated” position (pin 4 isolated by 

68V from protective earth).  If packet error 

issues occur over the Ethernet link (verify 

by pinging the device through the 

600SSH), configure the 600SSH to 

“grounded” position (by moving the 

600SSH switch from “isolated” to 

“ground”) to avoid ground loops that may 

be present in the system. 

4 Ground Cable Opening—route the 10 AWG 

(6 mm2) ground cable through this opening. 

5 CAT-5 Cable Knockouts—route the two 

CAT-5 cables through these openings, or 

alternatively through the Conduit Knockouts. 

6 Conduit Knockouts—on the back of the case, 

near the bottom. Available for installations 

where cable is routed through building 

conduit. 

1 

2 

3 

6 

5 4 5 
6 

2 

1 
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System planning 
This chapter provides information to help the user to plan an ePMP link. 

The following topics are described in this chapter: 

 How to plan ePMP links to conform to the regulatory restrictions that apply in the country of operation is 

explained under Radio spectrum planning on page 59. 

 Factors to be considered when planning links such as range, path loss and throughput are described under 

Link planning on page 62. 

 Factors to be considered when planning to use connectorized APs with external antennas in ePMP links are 

described under Planning for connectorized units on page 63. 

 The grounding and lightning protection requirements of a ePMP installation is described under Grounding 

and lightning protection on page 28. 

 Factors to be considered when planning ePMP data networks are described under Data network planning 

on page 64. 
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Radio spectrum planning 
This section describes how to plan ePMP links to conform to the regulatory restrictions that apply in the country 

of operation.  

 Caution 

The user must ensure ePMP product operates in accordance to local regulatory limits. 

 Note 

Contact the applicable radio regulator to check if registration of the ePMP link is required or not. 

GENERAL WIRELESS SPECIFICATIONS 

The wireless specifications that apply to all ePMP variants are listed under Table 36. The wireless specifications 

that are specific to each frequency variant are listed in Table 37. 

Table 36  ePMP wireless specifications (all variants) 

Item  Specification  

Channel selection Automatic and Manual selection (fixed frequency). 

Manual power control  To avoid interference to other users of the band, maximum power can be 

set lower than the default power limit. 

Integrated device antenna type Patch antenna 

Duplex scheme Adaptive TDD (with optional Standard 802.11n Wi-Fi on SM) 

Range 21 mi (5 MHz channel bandwidth) 

17 mi (10 MHz channel bandwidth) 

13 mi (20 MHz channel bandwidth) 

9 mi (40 MHz channel bandwidth) 

Over-the-air encryption AES 

Error Correction FEC 

Table 37  ePMP wireless specifications (per frequency band) 

Item 5 GHz 2.4 GHz 

RF band (GHz) 5150 - 5875 MHz 2407 - 2472 MHz  

Channel bandwidth  5 MHz, 10 MHz, 20 MHz or 40 MHz 5 MHz, 10 MHz, 20 MHz or 40 MHz 

Typical antenna 

gain 

Connectorized antenna – 15 dBi 

Integrated patch antenna – 13 dBi 

Reflector dish antenna – 6 dBi 

Connectorized antenna - 15 dBi 

Integrated patch antenna - 11 dBi 

Reflector dish antenna – 8 dBi 

Antenna beamwidth 

(Integrated) 

24° azimuth, 12° elevation 24° azimuth, 12° elevation 

Antenna beamwidth 10° azimuth, 25° elevation 10° azimuth, 28° elevation 
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(Relector dish) 

 
REGULATORY LIMITS 

The local regulator may restrict frequency usage and channel width and may limit the amount of conducted or 

radiated transmitter power. For details of these restrictions, see Examples of regulatory limits on page 317. 

Many countries impose EIRP limits (Allowed EIRP) on products operating in the bands used by the ePMP Series. 

For example, in the 5 GHz and 2.4 GHz bands, these limits are calculated as follows: 

 In the 5.2 GHz (5250 MHz to 5350 MHz) and 5.4 GHz (5470 MHz to 5725 MHz) band, the EIRP must not 

exceed the lesser of 30 dBm or (17 + 10 x Log Channel width in MHz) dBm. 

 In the 5.8 GHz band (5725 MHz to 5875 MHz), the EIRP must not exceed the lesser of 36 dBm or (23 + 10 x 

Log Channel width in MHz) dBm. 

 In the 2.4 GHz band (2400 MHz to 2500 MHz), the EIRP must not exceed the lesser of 36 dBm or (23 + 10 x 

Log Channel width in MHz) dBm. 

Some countries (for example the USA) impose conducted power limits on products operating in the 5 GHz and 

2.4 GHz band. 

CONFORMING TO THE LIMITS 

Ensure the link is configured to conform to local regulatory requirements by configuring the correct country code 

(located in the web management interface, under Configure => Radio). In the following situations, the country 

code does not automatically prevent operation outside the regulations: 

 When using connectorized APs with external antennas, the regulations may require the maximum transmit 

power to be reduced. To ensure that regulatory requirements are met for connectorized installations, see 

Calculating maximum power level for connectorized units on page 63. When operating in ETSI regions, 

it is required to enter a license key in the ePMP web management interface to unlock 5.8 GHz band 

frequencies. This key may be obtained from https://support.cambiumnetworks.com/licensekeys/epmp. 

 When installing 5.4 GHz links in the USA, it may be necessary to avoid frequencies used by Terminal 

Doppler Weather Radar (TDWR) systems. For more information, see Avoidance of weather radars on page 

61. 

AVAILABLE SPECTRUM 
The available spectrum for operation depends on the region. When configured with the appropriate country code, 

the unit will only allow operation on those channels which are permitted by the regulations. 

 Note 

In Italy, there is a regulation which requires a general authorization of any 5.4 GHz radio link which is used 

outside the operator’s own premises. It is the responsibility of the installer or operator to have the link 

authorized. For details, see: 

http://www.sviluppoeconomico.gov.it/index.php?option=com_content&view=article&idmenu=672 

&idarea1=593&andor=AND&idarea2=1052&id=68433&sectionid=1,16&viewType=1&showMenu=1&sho

wCat=1&idarea3=0&andorcat=AND&partebassaType=0&idareaCalendario1=0&MvediT=1 

&idarea4=0&showArchiveNewsBotton=0&directionidUser=0 

For the form that must be used for general authorization, see: 

http://www.sviluppoeconomico.gov.it/images/stories/mise_extra/Allegato%20n19.doc 

 

http://www.sviluppoeconomico.gov.it/index.php?option=com_content&view=article&idmenu=672&idarea1=593&andor=AND&idarea2=1052&id=68433&sectionid=1,16&viewType=1&showMenu=1&showCat=1&idarea3=0&andorcat=AND&partebassaType=0&idareaCalendario1=0&MvediT=1&idarea4=0&showArchiveNewsBotton=0&directionidUser=0
http://www.sviluppoeconomico.gov.it/index.php?option=com_content&view=article&idmenu=672&idarea1=593&andor=AND&idarea2=1052&id=68433&sectionid=1,16&viewType=1&showMenu=1&showCat=1&idarea3=0&andorcat=AND&partebassaType=0&idareaCalendario1=0&MvediT=1&idarea4=0&showArchiveNewsBotton=0&directionidUser=0
http://www.sviluppoeconomico.gov.it/index.php?option=com_content&view=article&idmenu=672&idarea1=593&andor=AND&idarea2=1052&id=68433&sectionid=1,16&viewType=1&showMenu=1&showCat=1&idarea3=0&andorcat=AND&partebassaType=0&idareaCalendario1=0&MvediT=1&idarea4=0&showArchiveNewsBotton=0&directionidUser=0
http://www.sviluppoeconomico.gov.it/index.php?option=com_content&view=article&idmenu=672&idarea1=593&andor=AND&idarea2=1052&id=68433&sectionid=1,16&viewType=1&showMenu=1&showCat=1&idarea3=0&andorcat=AND&partebassaType=0&idareaCalendario1=0&MvediT=1&idarea4=0&showArchiveNewsBotton=0&directionidUser=0
http://www.sviluppoeconomico.gov.it/images/stories/mise_extra/Allegato%20n19.doc
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Certain regulations have allocated certain channels as unavailable for use: 

 ETSI has allocated part of the 5.4 GHz band to weather radar. 

 UK and some other European countries have allocated part of the 5.8 GHz band to Road Transport and 

Traffic Telematics (RTTT) systems. 

For details of these restrictions, see Examples of regulatory limits on page 317. 

Where regulatory restrictions apply to certain channels, these channels are barred automatically by the use of the 

correct country code. For example, at 5.8 GHz in the UK and some other European countries, the RTTT band 

5795 MHz to 5815 MHz is barred. With the appropriate country code configured for this region, the ePMP will 

not operate on channels within this band. 

The number and identity of channels barred by the license key and country code is dependent on the channel 

bandwidth. 

For more information about configuring the Country Code parameter, see AP Radio page on page 89 and SM 
Radio page on page 148. 

CHANNEL BANDWIDTH 

Select the required channel bandwidth for the link. The selection depends upon the ePMP frequency variant and 

country code, as specified on page 317.  

Wider a channel bandwidth greater is its capacity. As narrower channel bandwidths take up lesser spectrum, 

selecting a narrow channel bandwidth may be a better choice when operating in locations where the spectrum is 

very busy.  

Both ends of the link must be configured to operate on the same channel bandwidth. 

AVOIDANCE OF WEATHER RADARS 

To comply with FCC rules (KDB 443999: Interim Plans to Approve UNII Devices Operating in the 5470 - 5725 

MHz Band with Radar Detection and DFS Capabilities), units which are installed within 35 km (22 miles) of a 

Terminal Doppler Weather Radar (TDWR) system (or have a line of sight propagation path to such a system) 

must be configured to avoid any frequency within +30 MHz or –30 MHz of the frequency of the TDWR device. 

This requirement applies even if the master is outside the 35 km (22 miles) radius but communicates with outdoor 

clients which may be within the 35 km (22 miles) radius of the TDWRs. 

The requirement for ensuring 30 MHz frequency separation is based on the best information available to date. If 

interference is not eliminated, a distance limitation based on line-of-sight from TDWR will need to be used. In 

addition, devices with bandwidths greater than 20 MHz may require greater frequency separation. 

When planning a link in the USA, visit http://spectrumbridge.com/udia/home.aspx, enter the location of the 

planned link and search for TDWR radars. If a TDWR system is located within 35 km (22 miles) or has line of 

sight propagation to the PMP device, perform the following tasks: 

 Register the installation on http://spectrumbridge.com/udia/home.aspx. 

 Make a list of channel center frequencies that must be barred, that is, those falling within +30 MHz or –

30 MHz of the frequency of the TDWR radars. 

 

In ETSI regions, the band 5600 MHz to 5650 MHz is reserved for the use of weather radars. 

 

http://spectrumbridge.com/udia/home.aspx
http://spectrumbridge.com/udia/home.aspx
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Link planning 

This section describes factors to be taken into account when planning links, such as range, obstacles path loss and 

throughput. 

RANGE AND OBSTACLES 

Calculate the range of the link and identify any obstacles that may affect radio performance. 

Perform a survey to identify all the obstructions (such as trees or buildings) in the path and to assess the risk of 

interference. This information is necessary in order to achieve an accurate link feasibility assessment. 

PATH LOSS 

Path loss is the amount of attenuation the radio signal undergoes between the two ends of the link. The path loss 

is the sum of the attenuation of the path if there were no obstacles in the way (Free Space Path Loss), the 

attenuation caused by obstacles (Excess Path Loss) and a margin to allow for possible fading of the radio signal 

(Fade Margin). The following calculation needs to be performed to judge whether a particular link can be 

installed: 

capabilityseasonalfadeexcessspacefree LLLLL _  

Where: Is: 

capabilityseasonalfadeexcessspacefree LLLLL _  
Free Space Path Loss (dB) 

capabilityseasonalfadeexcessspacefree LLLLL _  
Excess Path Loss (dB) 

capabilityseasonalfadeexcessspacefree LLLLL _  
Fade Margin Required (dB) 

capabilityseasonalfadeexcessspacefree LLLLL _  
Seasonal Fading (dB) 

capabilityseasonalfadeexcessspacefree LLLLL _  
Equipment Capability (dB) 

 

Free space path loss is a major determinant in received (Rx) signal level.  Rx signal level, in turn, is a major factor 

in the system operating margin (fade margin), which is calculated as follows: 

 

 System Operating Margin (fade margin) dB = Rx signal level (dB) – Rx sensitivity (dB) 

 

Thus, the fade margin is the difference between strength of the received signal and the strength that the receiver 

requires for maintaining a reliable link.   

ADAPTIVE MODULATION 

Adaptive modulation ensures that the highest throughput that can be achieved instantaneously will be obtained, 

taking account of propagation and interference. When the link has been installed, web pages provide information 

about the link loss currently measured by the equipment, both instantaneously and averaged.  
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Planning for connectorized units 

This section describes factors to be taken into account when planning to use connectorized APs with external 

antennas in ePMP networks. 

CALCULATING MAXIMUM POWER LEVEL FOR CONNECTORIZED UNITS 

If a connectorized ePMP link is to be installed in a country that imposes an EIRP limit in the selected band, 

choose an external antenna and RF cable that will not cause the ePMP to exceed the EIRP limit.  To calculate the 

highest setting of Maximum Power Level that will be permitted, use this formula: 

Maximum Power Level (dBm) = Allowed EIRP (dBm) – Antenna Gain (dBi) + Cable Loss (dB) 

Where: Is: 

Maximum Power Level 

(dBm) 

the highest permissible setting of the Maximum Power Level attribute in the 

Step 2: Wireless Configuration page, 

Allowed EIRP (dBm) the EIRP limit allowed by the regulations, 

Antenna Gain (dBi) the gain of the chosen antenna, 

Cable Loss (dB) the loss of the RF cable connecting the AP to the antenna. 

As the 2.4 GHz, 5.4 GHz and 5.8 GHz have an operating bandwidth of 5 MHz, 10 MHz, 20 MHz or 40 MHz then 

the maximum allowed EIRP depends on the operating bandwidth of the radio as shown in Table 38. 

Table 38  Normal EIRP limits with operating channel bandwidth 

Operating 

bandwidth 

(MHz) 

Allowed EIRP 

(dBm) at 5.2 GHz 

Allowed EIRP 

(dBm) at 5.4 GHz 

Allowed EIRP 

(dBm) at 5.8 GHz 

Allowed EIRP 

(dBm) at 2.4 GHz 

5, 10, 20, 40 24 - 30 24 - 30 36 36 

The settings to be used for regions with the EIRP limits in Table 38 are shown in Table 39. 

Table 39  Setting maximum transmit power to meet general EIRP limits 

 Note 

Calculations under Table 39 are on the basis of 0.5 dB cable loss and the highest gain antennas per size of 

which Cambium Networks are aware. At these operating frequencies, antenna cable losses even with 

short cables are unlikely to ever be below 0.5 dB for practical installations and cable diameters. 

 

Antenna Maximum 

available 

antenna gain 

(dBi) 

Operating bandwidth 

(MHz) 
Transmitter Output Power parameter setting 

(dBm)  

5.2 GHz 5.4 GHz 5.8 GHz 2.4 GHz 

Connectorized 

module Sector 

antenna 

15 5, 10, 20, 40 15 15 21 21 
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Data network planning 

This section describes factors to be considered when planning ePMP data networks. 

ETHERNET INTERFACES 

The ePMP Ethernet ports conform to the specifications listed in Table 40. 

Table 40  ePMP Ethernet bridging specifications 

Ethernet Bridging  Specification 

Protocol  10BASE-Te/100BASE-Tx/1000BASE-T IEEE 802.3 

IEEE 802.3af (PoE) 

IEEE802.3u compliant Auto-negotiation 

QoS Proprietary QoS 

Interface  10/100/1000BaseT (RJ-45)  

Data Rates See Data throughput tables on page 344.  

Maximum Ethernet Frame Size 1700 bytes 

Service classes for bridged traffic 3 classes 

 
 

 

 Note 

Practical Ethernet rates will depend on network configuration, higher layer protocols and platforms used. 

Over the air throughput will be capped to the rate of the Ethernet interface at the receiving end of the 

link. 

 

MANAGEMENT VLAN 

Decide if the IP interface of the AP/SM management agent will be connected in a VLAN. If so, decide if this is a 

standard (IEEE 802.1Q) VLAN or provider bridged (IEEE 802.1ad) VLAN, and select the VLAN ID for this 

VLAN. 

Use of a separate management VLAN is strongly recommended. Use of the management VLAN helps to ensure 

that the AP/SM management agent cannot be accessed by customers. 
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QUALITY OF SERVICE FOR BRIDGED ETHERNET TRAFFIC 

Decide how quality of service will be configured in ePMP to minimize frame loss and latency for high priority 

traffic. Wireless links often have lower data capacity than wired links or network equipment like switches and 

routers, and quality of service configuration is most critical at network bottlenecks. 

ePMP provides three priority types for traffic waiting for transmission over the wireless link – Voice, High and 

Low. Low is the lowest priority and Voice is the highest priority. Traffic is scheduled using strict priority; in other 

words, traffic in a given priority is transmitted when all higher-priority transmissions are complete. 

 

 

 



CAMBIUM NETWORKS 

 

 66 

Configuration 
This chapter describes all configuration and alignment tasks that are performed when an ePMP system is 

deployed. 

Configure the units by performing the following tasks: 

 Preparing for configuration on page 67 

 Using the web interface on page 70 

 Configuring connectorized radios using the Quick Start menu on page 81 

 Configuring SM units using the Quick Start menu on page 84 

 Using the AP menu options on page 87 

 Using the SM menu options on page 146 
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Preparing for configuration 

This section describes the checks to be performed before proceeding with unit configuration. 

SAFETY PRECAUTIONS 

All national and local safety standards must be followed while configuring the units.  

 Warning 

Ensure that personnel are not exposed to unsafe levels of RF energy. The units start to radiate as soon as they 
are powered up. Respect the safety standards defined in Compliance with safety standards on page 305, in 
particular the minimum separation distances. 

Observe the following guidelines: 

Never work in front of the antenna when the AP is powered. 

Always power down the power supply before connecting or disconnecting the Ethernet cable from the 
module. 

 
REGULATORY COMPLIANCE 

All applicable radio regulations must be followed while configuring the units and aligning the antennas. For more 

information, see Compliance with radio regulations on page 316.  

 



CAMBIUM NETWORKS 

 

 68 

Connecting to the unit 

To connect the unit to a management PC, use the following procedures: 

 Configuring the management PC on page 68 

 Connecting to the PC and powering up on page 69 

CONFIGURING THE MANAGEMENT PC 

Use this procedure to configure the local management PC to communicate with the ePMP module. 

Procedure: 

1 Select Properties for the Ethernet port. 

In Windows 7 this is found in Control Panel > 

Network and Internet >  

Network Connections > Local Area Connection. 

 

2 Select the Internet Protocol (TCP/IP) item: 

 

3 Click Properties. 

4 Enter an IP address that is valid for the 192.168.0.X 

network, avoiding: 

192.168.0.1, 192.168.0.2 and 192.168.03 

A good example is 192.168.0.100: 

 

 

5 Enter a subnet mask of 255.255.255.0. 

Leave the default gateway blank. 

6 Click OK, then click Close 
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CONNECTING TO THE PC AND POWERING UP 

Use this procedure to connect a management PC directly to the ePMP for configuration and alignment purposes 

and to power up the ePMP device. 

Procedure: 

1 Check that the device and power supply are correctly connected (the device Ethernet port is connected to 

the power supply Ethernet power port – see the ePMP Installation Guide for more information). 

2 Connect the PC Ethernet port to the LAN (AP:  “Gigabit Data”, SM:  “10/100Mbit Data”) port of the 

power supply using a standard (not crossed) Ethernet cable. 

3 Apply mains or battery power to the power supply. The green Power LED must illuminate continuously. 

 Note 

If the Power and Ethernet LEDs do not illuminate correctly, see Testing hardware on page 223. 
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Using the web interface 

To understand how to use the ePMP web interface, see: 

 Logging into the web interface on page 71 

 Layout of the web interface on page 72 

 Configuring connectorized radios using the Quick Start menu on page 81 

 Configuring SM units using the Quick Start menu on page 84 

 Using the AP menu options on page 87 
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LOGGING INTO THE WEB INTERFACE 

Use this procedure to log into the web interface as a system administrator. 

Equipment and tools: 

 Connectorized or integrated device connected to power supply by Ethernet cable. 

 PC connected to power supply by Ethernet cable. 

 Power Supply powered up. 

 Supported browser – Chrome v29, Firefox v24, Internet Explorer 10, Safari v5. 

 

Procedure: 

 

1 Start the web browser from the management PC. 
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2 Type the IP address of the unit into the address bar. The factory default IP address is either 192.168.0.1 (AP 

mode) or 192.168.0.2 (SM mode). Press ENTER. The web interface dashboard and login input is displayed. 

 Note 

If Device IP address Mode is set to DHCP and the device is unable to retrieve IP address information 

via DHCP, the device management IP is set to fallback IP 192.168.0.1 (AP mode), 192.168.0.2 (SM 

mode), 192.168.0.3 (Spectrum Analyzer mode) or the previously-configured static Device IP Address. 

Units may always be accessed via the Ethernet port. 

 

With Release 2.1, the fallback IP address has changed from 10.1.1.254 to 169.254.1.1. 

 

 

 

 

3 Enter Username (default: admin) and Password (default: admin) at top right corner. 

4 Click Login. 

 Note 

New ePMP devices all contain default username and password configurations. It is recommended to change 

these password configurations immediately. These passwords may be configured in the management GUI in 

section Configuration => System => User Account Management. 

 

LAYOUT OF THE WEB INTERFACE 
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After logging in, the web interface first displays a dashboard view of vital system status and statistics.  Also, the 

first level of navigation is displayed across the top (Configure, Monitor, Tools and Quick Start).  To return to 

this display at any time, click the Home ( ) icon or device name (i.e. “ePMP Access Point”) 

Figure 13  GUI dashboard 
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The top of the interface contains the following attributes: 

Table 41  GUI status bar attributes 

Icon Attribute Meaning 

 
Cambium Networks logo Hyperlink to the Cambium Networks website. 

 
Home Icon Link to the device dashboard. 

 Login Level indicator Displays the current user login level. 

 

Internet Connectivity 

Indicator 

Green indicates that the AP has IP connectivity to the 
configured DNS server. 

Grey indicates that the AP has no IP connectivity to 
the configured DNS server. 

  Note 

The Internet Connectivity Indicator state is 

determined by receipt of ping responses from the 

configured DNS server. 

 

GPS Synchronization 

Receive Indicator 

Green indicates that the AP is receiving a valid GPS 

synchronization timing pulse via a connected GPS 

antenna or a CMM. 

Red indicates that the AP is not receiving GPS 

synchronization due to lack of satellite fix.  

Grey indicates that the AP is not receiving GPS 

synchronization due to configuration of Synchronization 

Source to Internal. 

 
Notifications Button 

The Notifications button may be clicked to display 

system messaging. When a new notification is available, 

the icon is highlighted and displays the number of 

notifications available. The outer icon highlighting 

indicates the type of notification pending: 

Green:  Successful operation has completed (i.e. Changes 

successfully saved) 

Grey:  Informational message (i.e. tips regarding GUI 

operation) 

Blue:  Operations information message (i.e. Initializing 

upgrade…) 

Orange:  Warning message (i.e. Login session has 

expired) 

Red:  Error message (i.e. Software update file download 

failed) 

 
Undo Button 

The Undo button may be used to undo changes prior to a 

Save operation. All changes made on any section of the 

GUI are undone. 
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Icon Attribute Meaning 

 
Save Button 

The Save button is used to commit configuration changes 

to the device. When configuration changes are made, the 

outer area of the icon is highlighted blue to indicate that 

a save operation is required. 

 
Reset Button  

The Reset button is used to reset the device.  When a 

configuration change requires a radio reset, the outer 

area of this icon is highlighted orange to indicate that a 

reset is necessary to complete the change. 

 
Logout Button 

The Logout button is used to logout from the current 

session and return to the initial GUI landing page (login 

screen). 

 

The bottom of the interface contains the following attributes: 

Table 42  GUI footer attributes 

Attribute Meaning 

Cambium Support link Hyperlink to the Cambium Networks support website. 

Software Version link The current software version is reported in the footer bar and may be clicked to 

navigate to the Cambium Networks software support website. 

Copyright Copyright information. 

 

The AP dashboard contains the following attributes: 

Table 43  AP dashboard attributes 

Attribute Meaning 

Device Name The configured device name of the AP, used for identifying the device in an NMS 

such as the Cambium Network Services Server (CNSS). 

AP SSID The current configured name/SSID of the AP. 

Operating Frequency 

 

The current frequency carrier used for radio transmission, based on the 

configuration of the Frequency Carrier parameter (in DFS regions, if a radar has 

been detected, this field may display either DFS Alternate Frequency Carrier 1 or 

DFS Alternate Frequency Carrier 2). 

Operating Channel 

Bandwidth 

 

The current channel bandwidth used for radio transmission, based on the 

configuration of the Channel Bandwidth parameter. 

Transmitter Output 

Power 

The current operating transmit power of the AP. 

Antenna Gain The configured gain of the external antenna. 
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Attribute Meaning 

Country The current configured country code, which has an effect on DFS operation and 

transmit power restrictions.  Registered Subscriber Modules will inherit this 

country code when registration is complete (unless SM is locked to US region). 

Access Point Mode TDD: The Access Point is operating in point-to-multipoint (PMP) mode using 

TDD scheduling. The AP is able to GPS synchronize in this mode (except when in 

Flexible mode). 

ePTP Master: The Access Point is operating as a Master in point-to-point mode. 

The AP does not support GPS Synchronization in this mode but is able to provide 

significantly lower latency than other modes. QoS (MIR and traffic priority) 

capability and Link Quality/Capacity indicators are not available in this mode. 

PTP: The Access Point is operating in point-to-point (PTP) mode using TDD 

scheduling. The AP is able to GPS synchronize in this mode (except when in 

Flexible mode).  

Downlink/Uplink 

Frame Ratio 

The current configured schedule of downlink traffic to uplink traffic on the radio 

link.  In other words, this ratio represents the amount of the total radio link’s 

aggregate throughput that will be used for downlink resources and the amount of 

the total radio link’s aggregate throughput that will be used for uplink resources. 

Wireless Security The current configured authentication type used for radio link encryption as well as 

SM authentication. 

Ethernet Interface Up:  The Ethernet (LAN) interface is functioning properly. This also displays the 

current port speed and duplex mode to which the Ethernet port has auto-negotiated 

to or configured for.  

Down:  The Ethernet (LAN) interface is either disconnected or it has encountered 

an error and is not servicing traffic. 

Wireless Interface Up:  The radio (WAN) interface is functioning properly  

Down:  The radio (WAN) interface has encountered an error and is not servicing 

traffic. 

Wireless MAC 

Address 

The MAC address of the device wireless interface. 

Ethernet MAC 

Address 

The MAC address of the device Ethernet (LAN) interface. 

IP Address  The current configured device IP address (LAN) used for management access. 

Date and Time The current date and time on the device, subject to the configuration of parameter 

Time Zone. 

System Uptime The total uptime of the radio since the last reset. 

System Description The current configured system description. 

Sync Source Status Displays the current source (GPS, CMM or Internal) of sync timing for the AP.  

Device Coordinates The current configured Latitude and Longitude coordinates in decimal format. 
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Attribute Meaning 

DFS Status Current DFS operational status. 

Registered Subscriber 

Modules 

The total number of SMs currently registered to the AP. 

 

The SM dashboard is as shown in Figure 14 and the attributes are explained in Table 44. 

Figure 14 SM Dashboard 
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Table 44  SM Dashboard Attributes 

Attribute Meaning 

Device Name The configured device name of the SM, used for identifying the device in an NMS 

such as the Cambium Network Services Server (CNSS). 

Operating Frequency The current operating frequency. 

Operating Channel 

Bandwidth 

The current operating width of the channel used for the radio link. 

Transmitter Output 

Power 

The current power level at which the SM is transmitting (which is adjusted 

dynamically by the AP based on radio conditions). 

Antenna Gain The configured gain of the external antenna. 

Country The current configured country code, which has an effect on DFS operation and 

transmit power restrictions. Registered Subscriber Modules will inherit this country 

code when registration is complete (unless SM is locked to US region). 

Subscriber Module 

Mode 

TDD: The SM is operating in the proprietary TDD mode and will only connect to 

another ePMP Access Point.  

Standard WiFi: The SM is operating in the Standard 802.11n WiFi mode and will 

be able to connect to any Access Point operating in standard WiFi mode. 

ePTP Slave: The SM is operating as a Slave in point-to-point mode. The AP and the 

system do not support GPS Synchronization in this mode but are able to provide 

significantly lower latency than other modes. QoS (MIR and traffic priority) 

capability and Link Quality/Capacity indicators are not available in this mode.  

Subscriber Module 

Priority 

The configured priority of the SM in the sector. 

Network Mode Bridge: The SM acts as a switch and the packets are forwarded or filtered based on 

their MAC destination address. 

NAT: The SM acts as a router and the packets are forwarded or filtered based on 

their IP header (source or destination) which can be grouped into subnets for finer 

granularity. 

Downlink RSSI The Received Signal Strength Indicator, which is a measurement of the power level 

being received by the SM’s antenna. 

Downlink SNR The Signal to Noise Ratio, which is an expression of the carrier signal quality with 

respect to signal noise and co-channel interference (or both). 

Uplink MCS Modulation and Coding Scheme – indicates the modulation mode used for the radio 

uplink, based on radio conditions (MCS 1-7, 9-15). 

Downlink MCS Modulation and Coding Scheme – indicates the modulation mode used for the radio 

downlink, based on radio conditions (MCS 1-7, 9-15). 
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Attribute Meaning 

Ethernet Interface Up:  The Ethernet (LAN) interface is functioning properly. This also displays the 

current port speed and duplex mode to which the Ethernet port has auto-negotiated 

to or configured for.  

Down:  The Ethernet (LAN) interface is either disconnected or it has encountered an 

error and is not servicing traffic. 

Wireless Interface Up:  The radio (WAN) interface is functioning properly. 

Down:  The radio (WAN) interface has encountered an error and is not servicing 

traffic. 

Wireless MAC 

Address 

The MAC address of the device Wireless interface. 

Ethernet MAC 

Address 

The MAC address of the device LAN (Ethernet) interface. 

IP Address The current configured device IP address (LAN, Ethernet interface) used for 

management access. 

Wireless IP Address The current configured device IP address (Wireless interface), when the SM is in 

Router (NAT) mode.  

Separate Wireless 

Management IP 

Address 

The current configured device IP address (Separate Wireless Management interface) 

used for management access, when the SM is in Router (NAT) mode. 

Date and Time The current date and time on the device, subject to the configuration of parameter 

Time Zone.  If an NTP server is not specified, the date and time will begin from 

factory default upon radio startup. 

System Uptime The total uptime of the radio since the last reset. 

System Description The current configured system description. 

Registered AP SSID The AP SSID of the AP to which the SM is registered. 

Registered AP MAC 

Address 

The Wireless MAC Address of the AP to which the SM is registered. 

Device Coordinates The current configured Latitude and Longitude coordinates in decimal format. 

DFS Status Current DFS operational status. 

Link Quality (Uplink) The Uplink quality based on the current MCS and Packet Error Rate (PER).  

Link Capacity (Uplink) The uplink capacity based on the current MCS with respect to the highest supported 

MCS (MCS15). 



CAMBIUM NETWORKS 

 

 80 

 

The GUI interface consists of two levels of navigation – the first-level navigation buttons on the top (Configure, 

Monitor, Tools and Quick Start) as well as the context-based second-level navigations on the left-hand side of 

the interface. After a second-level navigation section has been chosen, the resulting configuration parameters are 

displayed in the main GUI pane.  Each subsection of parameters may be configured to display a clean view of only 

basic parameters, or the display may also be configured to display a comprehensive listing of advanced parameters. 

Figure 15  GUI first-level and second-level navigation 
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Configuring connectorized radios using the Quick Start menu 

The Quick Start tab contains a listing of parameters required to configure a simple radio link and to configure 

requisite networking parameters. After configuring an AP, SM and resetting both devices, the SM is ready to 

associate (register) to the AP.  

Figure 16 AP Quick Start menu 

 

 

To configure an AP via the Quick Start menu, follow this: 

Procedure: 

1 Start the web browser from the management PC. 

2 Navigate to the Quick Start menu 

3 Configure the parameter Radio Mode: 

This parameter controls the function of the device – All ePMP devices may be configured to operate as an 

Access Point (AP), Subscriber Module (SM) or as a Spectrum Analyzer. For initial link bring-up, choose AP 
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4 Configure the parameter Access Point Mode: 

This parameter controls the mode of operation of the Access Point – An AP may be configured to operate in 

TDD mode for multipoint access, PTP mode for point-to-point access using TDD or as an ePTP Master. 

For initial link bring-up, choose TDD. When the AP is an ePTP Master, the system does not support GPS 

Synchronization but is able to provide significantly lower latency than other modes. QoS (MIR and traffic 

priority) capability and Link Quality/Capacity indicators are not available in this mode. 

5 Configure the parameter Country: 

Country settings affect the radios in the following ways: 

• Maximum transmit power limiting (based on radio transmitter power plus configured antenna 

gain) 

• DFS operation is enabled based on the configured country code, if applicable 

• Frequency selection limiting (based on valid frequencies for the configured Country 

 Select the country in which your network will be operating. 

6 Configure the parameter Automatic Channel Selection (ACS): 

When ACS is enabled, the AP will automatically scan the available spectrum and choose a channel with the 

lowest occupancy. For more information on this parameter please see AP Automatic Channel Selection 

page on page 138. 

7 Configure the parameter Frequency Carrier: 

Configure the frequency carrier for RF transmission.  This list is dynamically adjusted to the regional 

restrictions based on the setting of the Country Code parameter. Ensure that a thorough spectrum analysis 

has been completed prior to configuring this parameter. 

8 Configure parameter AP SSID (Name): 

The AP SSID (Name) is used to identify the AP and is used to configure the SM with the appropriate AP 

with which to register.  Ensure that this parameter is configured uniquely for each AP in the network. 

9 Configure the parameter Downlink/Uplink Ratio: 

Specify the percentage of the aggregate throughput for the downlink (frames transmitted from the AP to 

the SM). For example, if the aggregate (uplink and downlink total) throughput on the AP is 90 Mbps, then 

75/25 specified for this parameter allocates 67.5 Mbps for the downlink and 22.5 Mbps for the uplink. The 

default for this parameter is 75/25. 

 Caution 

You must set this parameter exactly the same for all APs in a cluster. 

10 Configure the parameter Synchronization Source: 

This parameter defines the timing source for the device which can be GPS-based or internally generated. 

Select GPS if the AP will receive synchronization pulses from a connected GPS antenna. Select CMM if the 

device will receive GPS synchronization pulses from a co-located Cambium Cluster Management Module 

(see PMP Synchronization Solutions User Guide).  Select Internal if no GPS synchronization source is 

available (in this mode, transmission between co-located devices will create radio interference). If Flexible 

is chosen as the DL/UL Ratio or if the Access Point Mode is chosen as ePTP Master, then this 

parameter will be greyed out.  
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11 Configure the parameter IP Assignment: 

If DHCP is selected, the DHCP server automatically assigns the IP configuration (Ethernet (LAN) IP 

Address, Ethernet (LAN) IP Subnet Mask, Gateway IP Address (LAN)) and the values of those individual 

parameters (below) are not used.  To configure a simple test network, select mode Static. 

12 Configure the parameter IP address: 

Internet Protocol (IP) address. This address is used by the family of Internet protocols to uniquely identify 

this unit on a network. To configure a simple test network, this field may be left at default (192.168.0.1). 

13 Configure the parameter Subnet Mask: 

The Subnet Mask defines the address range of the connected IP network. To configure a simple test 

network, this field may be left at default (255.255.255.0). 

14 Configure the parameter Gateway: 

The IP address of the device on the current network that acts as a gateway. A gateway acts as an entrance 

and exit to packets from and to other networks. To configure a simple test network, this parameter may be 

left at default (blank). 

15 Configure the parameter Wireless Security: 

Open:  All SMs requesting network entry are allowed registration. 

WPA2:  The WPA2 mechanism provides AES radio link encryption and SM network entry authentication. 

When enabled, the SM must register using the Authentication Pre-shared Key configured on the AP and 

SM. 

16 Configure the parameter WPA2 Pre-shared Key 

Configure this key on the AP and then configure each of the network SMs with this key to complete the 

authentication configuration. This key must be between 8 to 128 symbols. Click the visibility icon  

to toggle the display of the key’s contents. 

17 Click the Save icon, then click the Reset icon 
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Configuring SM units using the Quick Start menu 

The Quick Start tab contains a simple listing of parameters required to configure a simple radio link and to 

configure requisite networking parameters. 

Figure 17 SM Quick Start menu 

  

To configure a SM via the Quick Start menu, follow this: 

Procedure: 

1 Start the web browser from the management PC. 

2 Navigate to Quick Start menu 

3 Configure the parameter Radio Mode: 

This parameter controls the function of the device – all ePMP devices may be configured to operate as an Access 

Point (AP), Subscriber Module (SM), or as a Spectrum Analyzer. For initial link bring-up, choose SM. 
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4 Configure the parameter Subscriber Module Mode: 

This parameter controls the mode of operation of the Subscriber Module – An SM may be configured to operate in 

TDD mode for point-to-point and point-to-multipoint access, Standard WiFi mode providing the capability to 

connect to any AP operating in standard WiFi mode or as an ePTP Slave. For initial link bring-up, choose TDD. 

When the SM is an ePTP Slave, the system does not support GPS Synchronization but is able to provide 

significantly lower latency than other modes. QoS (MIR and traffic priority) capability and Link Quality/Capacity 

indicators are not available in this mode. 

5 The Country is automatically retrieved from the AP and requires no configuration. 

Country settings affect the radios in the following ways: 

• Maximum transmit power limiting (based on radio transmitter power plus configured antenna gain) 

• DFS operation is enabled based on the configured country code, if applicable 

• Frequency range of operation depending on local limitations 

6 Configure the parameter Device Name: 

The SM Device Name is used to identify the device on the network. This parameter may be modified or left at the 

default value of Cambium-SM. 

7 Configure the parameter Network Mode: 

NAT: The SM acts as a router and packets are forwarded or filtered based on their IP header (source or destination). 

Bridge: The SM acts as a switch and packets are forwarded or filtered based on their MAC destination address. 

8 Configure the parameter Wireless IP Assignment: 

If DHCP is selected, the DHCP server automatically assigns the IP configuration (Ethernet (LAN) IP Address, 

Ethernet (LAN) IP Subnet Mask, Gateway IP Address (LAN)) and the values of those individual parameters (below) 

are not used.  To configure a simple test network, this parameter must be configured to Static. 

9 Configure the parameter Wireless IP Address: 

Internet Protocol (IP) address. This address is used by the family of Internet protocols to uniquely identify this unit 

on a network. To configure a simple test network, this field must be configured to 192.168.0.2. 

10 Configure the parameter Wireless Subnet Mask: 

The Subnet Mask defines the address range of the connected IP network. To configure a simple test network, this 

field may be left at default (255.255.255.0). 

11 Configure the parameter Wireless Gateway: 

The IP address of the device on the current network that acts as a gateway. A gateway acts as an entrance and exit 

to packets from and to other networks. To configure a simple test network, this parameter may be left at default 

(blank). 

12 Configure the parameter WPA2 Pre-shared Key: 

Configure each of the network SMs with this key (matching the AP’s configured key) to complete the authentication 

configuration. This key must be between 8 to 128 symbols. Click the visibility icon   to toggle the display of 

the key’s contents. 

13 Configure the parameter EAP-TTLS Username: 

Configure each of the network SMs with this EAP-TTLS Username (matching the credentials on the RADIUS 

server being used for the network).   
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14 Configure the parameter EAP-TTLS Password: 

Configure each of the network SMs with this EAP-TTLS Password (matching the credentials on the RADIUS 

server being used for the network). Click the visibility icon  to toggle the display of the password’s contents. 

15 Configure the parameter Authentication Identity String: 

Configure each of the network SMs with this Identity string (matching the credentials on the RADIUS server being 

used for the network).  Default value for this parameter is “anonymous”. 

16 Configure the parameter Authentication Identity Realm: 

Configure each of the network SMs with this Identity realm (matching the credentials on the RADIUS server being 

used for the network). Default value for this parameter is “cambiumnetworks.com”. 

17 Configure the Preferred AP’s 

The Preferred AP’s is comprised of a list of up to 16 APs to which the SM sequentially attempts registration. For 

each AP configured, if authentication is required, enter a Pre-shared Key associated with the configured AP SSID.  

If this list is empty or if none of the configured APs are found, the SM scans and registers to the best AP signal 

found (with matching radio and/or authentication settings). 

18 Configure the parameter Subscriber Module Scanning: 

The Radio Scan List determines the frequencies for which the SM scans for AP signaling. For a simple radio 

network setup, click Select All to scan all frequencies.   

19 Click the Save icon, then click the Reset icon 
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Using the AP menu options 

Use the menu navigation bar in the top and left panels to navigate to each web page. The functional areas that may 

be accessed from each menu option are listed in Table 45. Some of the parameters are only displayed for specific 

system configurations. 

Table 45  Functional areas accessed from each menu option 

Menu option Menu Details 

Quick Start Configuring connectorized radios using the Quick Start menu on 

page 81 

Configure AP Configure menu on page 88 

    Radio AP Radio page on page 89 

    Quality of Service AP Quality of Service page on page 98 

    System AP System page on page 101 

    Network AP Network page on page 105 

    Security AP Security page on page 109 

Monitor AP Monitor menu on page 111 

    Performance AP Performance page on page 112 

    System Status AP System page on page 116 

    Wireless Status AP Wireless page on page 118  

    GPS Status AP GPS page on page 120 

    Network Status AP Network page on page 122 

    System Log AP System Log page on page 125 

Tools AP Tools menu on page 126 

    Software Upgrade AP Software Upgrade page on page 127 

    Backup / Restore AP Backup/Restore page on page 129 

    eDetect AP eDetect page on page 132 

    Spectrum Analyzer AP Spectrum Analyzer page on page 135 

    Automatic Channel Selection AP Automatic Channel Selection page on page 138 

    eAlign AP eAlign page on page 140 

    Wireless Link Test AP Wireless Link Test page on page 142 

    Ping AP Ping page on page 144 

    Traceroute AP Traceroute page on page 145 
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AP CONFIGURE MENU 

Use the Configure menu to access all applicable device configuration parameters. The configuration menu 

contains the following pages: 

 AP Radio page on page 89 

 AP Quality of Service page on page 98 

 AP System page on page 101 

 AP Network page on page 105 

 AP Security page on page 109  
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AP Radio page 

Use the Radio page to configure the device radio interface parameters. 

 Caution 

Plan Configuration modifications since modifying radio parameters may result in a wireless outage. 

Figure 18  AP Radio page 
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Table 46  AP Radio Configuration attributes 

Attribute Meaning 

General 

Radio Mode This parameter controls the function of the device – All ePMP devices may be 

configured to operate as an Access Point (AP), Subscriber Module (SM) or as a 

Spectrum Analyzer. For initial link bring-up, choose AP. 

Access Point Mode TDD: The Access Point is operating in point-to-multipoint (PMP) mode using TDD 

scheduling. The AP is able to GPS synchronize in this mode (except when in Flexible 

mode). 

ePTP Master: The Access Point is operating as a Master in point-to-point mode. The 

AP does not support GPS Synchronization in this mode but is able to provide 

significantly lower latency than other modes. QoS (MIR and traffic priority) 

capability and Link Quality/Capacity indicators are not available in this mode. 

PTP: The Access Point is operating in point-to-point (PTP) mode using TDD 

scheduling. The AP is able to GPS synchronize in this mode (except when in Flexible 

mode).  

Country From the drop-down list, select the country in which the radio is operating.  

Country Code settings affect the radios in the following ways: 

 Maximum transmit power limiting (based on radio transmitter power plus 

configured antenna gain) 

 DFS operation is enabled based on the configured country code, if applicable 

 Frequency selection limiting, based on regional limitations 

Range Unit Miles:  The Max Range setting and resulting frame calculations are configured in 

units of miles. 

Kilometers:  The Kilometers setting and resulting frame calculations are configured 

in units of kilometers. 

Point-to-Point 

Access 

Off: The system is configured to operate in PMP mode (i.e. more than one SM may 

connect to the AP). 

First Subscriber Module:  The system is configured to accept only the 1st registered 
SM.  Network entry is denied for all subsequent SM network entry requests. 

MAC Filtering:  The system is configured to accept only one SM registration, and 

this registration is limited by SM MAC Address (the SM Wireless MAC Address). 

Subscriber Module 

Wireless MAC 

Configure the Wireless MAC Address of the sole SM which is granted registration to 

the AP. All other network entry attempts are rejected by the AP.  The SM’s 

Preferred AP List may be configured with the destination point-to-point AP to 

ensure that the SM connects with the intended AP. 



CAMBIUM NETWORKS 

 

 91 

Attribute Meaning 

Access Point Configuration 

AP SSID The AP SSID is used to identify the AP and is used to configure the SM with the 

appropriate AP with which to register. Ensure that this parameter is configured 

uniquely for each AP in the network. 

Max Registrations 

Allowed 

Based on sector/network planning and SM service level implementations, this 

parameter allows the user to set the maximum number of SMs that are allowed to 

register/network entry. The maximum number of SMs allowed for each channel 

bandwidth is as follows: 

20/40 MHz : 120 subscribers 

10 MHz : 60 subscribers 

5 MHz: 30 subscribers 

Default value is 60. 

For DFS regions, the max number of SMs will be limited based on the channel 

bandwidth of the current operating channel, i.e. Frequency Carrier, Alternate 

Frequency Carrier 1 or Alternate Frequency Carrier 2. 

Max Range Enter a number of miles or kilometers for the furthest distance from which an SM is 

allowed to register to this AP. Do not set the distance to any greater number of miles. 

A greater distance: 

 does not increase the power of transmission from the AP. 

 can reduce aggregate throughput. 

Regardless of this distance, the SM must meet the minimum requirements for an 

acceptable link. The AP will reject any SM network entry attempts from outside the 

configured maximum range. Default value is 3 miles. 

 Caution 

If the AP is in a cluster or is in range of another AP, then you must set this 
parameter on all other APs in the cluster and in range exactly the same.  Otherwise, 
overlapping RF transmissions will introduce system interference. 

Automatic Channel 

Selection 

Enabled – This enables the Automatic Channel Selection (ACS) feature. ACS allows 

the radio to scan the entire band (governed by the Country setting) and chooses a 

channel with the lowest channel occupancy i.e. lowest interference level. To run the 

ACS feature (once enabled), the radio will have to be rebooted or manually triggered 

using Tools->Automatic Channel Selection. When ACS is running, the radio 

measures the occupancy level of the channel (measured in terms of an internal 

interference metric) and uses an algorithm to make a decision to choose the best 

channel within the band. The channel chosen is not based just on the occupancy level 

channel but also the occupancy level of adjacent channels.  

Disabled – ACS is disabled and the operator should configure a Frequency Carrier 

manually.  

 Note 
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Attribute Meaning 

The channel bandwidth configured prior to enabling and running ACS will be used to 

automatically select a channel. For ex: If the operator manually configured a channel 

bandwidth of 20MHz, ACS will scan and choose a channel of 20MHz wide channel. To 

switch ACS to 40MHz or other channel bandwidth, the operator should disable ACS, 

manually configure 40MHz or desired channel bandwidth on the radio, then enable 

and run ACS. 

 

Channel Bandwidth Configure the channel size used by the radio for RF transmission. This value must 

match between the AP and SMs. 

Frequency Carrier Configure the frequency carrier for RF transmission. This list is dynamically adjusted 

to the regional restrictions based on the setting of the Country Code parameter. 

Frequency Reuse The Frequency Reuse Mode parameter allows operators to define which APs are 

co-located (or within radio range) with other APs. This definition results in an 

automatic radio network modification such that self-interference is reduced amongst 

the co-located sectors. 

A network in which two frequencies “F1” and “F2” are reused throughout the 

deployment in shown in Figure 19. 

Figure 19  Frequency reuse deployment 
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The set of APs to configure the Frequency Reuse Mode option on is dependent on 

the GPS synchronization sources in the whole network, CMM3, CMM4 or “onboard 

GPS” (GUI options are: GPS or CMM). 

The GPS sync source is the same on all APs or is a 
combination of “onboard GPS” and CMM4  

In this configuration the GPS synchronization source in the whole network is one of 

the following: 

1- “onboard GPS” or  

2- CMM4 or  

3- CMM3 or 

4- Mix of “onboard GPS” and CMM4 (but NOT CMM3) 
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Attribute Meaning 

For instructions on how to configure Frequency Reuse Mode to ensure that 

interference is reduced throughout the deployment, see Figure 20. 

Figure 20  Frequency reuse configuration example 
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The rules in selecting the APs to enabling the Frequency Reuse Mode in this 

deployment are: 

1- Only ONE of the APs on the same tower configured with the same 

frequency must be configured with the Frequency Reuse Mode parameter 

set to Frequency-Reuse-Back; the other AP must be configured with 

Frequency Reuse Mode set to Frequency-Reuse-Front. 

Also, APs on different towers facing each other with overlapped coverage 

must be configured with Frequency Reuse Mode set to Frequency-

Reuse-Back. 

The GPS sync source is a mixture of all types (CMM3, CMM4 
& “onboard GPS”) 
 

In this configuration the GPS sync source in the whole network is one of the 

following: 

1- (CMM3 and “onboard GPS”) or  

2- (CMM3 and CMM4) or  

3- (CMM3 and CMM4 and “onboard GPS”) 

For more examples of which APs to enable the Frequency Reuse Mode feature in 

this mixture of sync sources, see Figure 21 and Figure 22. 
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Attribute Meaning 

Figure 21  Example 1 - Frequency reuse configuration, mixture of GPS 
synchronization sources 
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Figure 22  Example 2 - Frequency Reuse Configuration with Mixture of GPS 

sources 
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The rules in selecting the APs to configure Frequency Reuse Mode to Frequency 

Reuse Mode to Frequency-Reuse-Front or Frequency-Reuse-Back in a mixture 

of sync sources deployments are: 

1- Only ONE of the APs on the same tower configured with the same 

frequency must have Frequency Reuse Mode set to Frequency-Reuse-
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Attribute Meaning 

Back if the sync source of both APs is the same or the sync is a 

combination of “onboard GPS” and CMM4; the other AP will have the 

Frequency-Reuse-Front ON. 

2- For the APs on different towers facing each other with overlapped 

coverage: 

a. If both APs have the same sync source then only ONE of them 

must have the Frequency-Reuse-Back ON; the other AP shall 

have the Frequency-Reuse–Front ON. 

b. If one AP has “onboard GPS” as sync source and the other one has 

CMM4 then only ONE of them must have  Frequency-Reuse - 

Back ON; the other AP shall have Frequency-Reuse-Front ON. 

c. If one AP has “onboard GPS” or CMM4 as sync source and the 

other one has CMM3 then: 

i. If the AP with CMM3 sync source has Frequency-

Reuse-Back ON, then the other AP (with “onboard GPS” 

or CMM4 sync source) must have the Frequency-Reuse-

Back ON. 

ii. If the AP with CMM3 sync source has Frequency Reuse 

Mode set to Off, then the other AP (with “onboard GPS” 

or CMM4 sync source) must have Frequency Reuse 

Mode set to Off. 

Alternate Frequency 

Carrier 1 Channel 

Bandwidth 

Configure the first channel bandwidth configuration that will be used for RF 

transmission if DFS detection causes the radio to switch from using the channel 

bandwidth configured in Channel Bandwidth.  

Alternate Frequency 

Carrier 1 

Configure the first frequency that will be used for RF transmission if DFS detection 

causes the radio to switch from using the frequency configured in Frequency 

Carrier.  It is important to set this frequency also in the SM Scan List. 

Alternate Frequency 

Carrier 2 Channel 

Bandwidth 

Configure the second channel bandwidth configuration that will be used for RF 

transmission if DFS detection causes the radio to switch from using the channel 

bandwidth configured in Channel Bandwidth.  

Alternate Frequency 

Carrier 2 

Configure the second frequency that is used for RF transmission if DFS detection 

causes the radio to switch from using the frequencies configured in Frequency 

Carrier and DFS Alternate Frequency Carrier 1.  It is important to set this 

frequency also in the SM Scan List. 

Downlink Max Rate Configure the maximum MCS (Modulation and Coding Scheme) that the AP should 

use in the Downlink. For example: Setting this parameter to MCS12 will prevent 

the AP’s rate adapt algorithm from using MCS13 through MCS15. Not available 

when AP is an ePTP Master. 
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Attribute Meaning 

Power Control 

Transmitter Output 

Power 

This value represents the combined power of the AP’s two transmitters.  This value 

may be automatically adjusted based on the configuration of the parameter Country 

Code. 

Nations and regions may regulate transmitter output power. For example 

 2.4 GHz and 5 GHz modules are available as connectorized radios, which 

require the operator to adjust power to ensure regulatory compliance. 

The professional installer of the equipment has the responsibility to 

 maintain awareness of applicable regulations. 

 calculate the permissible transmitter output power for the module. 

 confirm that the initial power setting is compliant with national or regional 

regulations 

 confirm that the power setting is compliant following any reset of the module to 

factory defaults. 

Antenna Gain This value represents the amount of gain introduced by an external antenna (minus 

cable loss). This value is used in calculating the unit’s Equivalent Isotropic Radiated 

Power (EIRP) level. For certain Country Code configurations, the unit’s EIRP may 

be limited based on regional regulations. 

Subscriber Module 

Target Receive Level 

Each SM’s transmitter output power is automatically set by the AP. The AP 

monitors the received power from each SM and adjusts each SM’s transmitter 

output power so that the received power at the AP from the SM is not greater than 

what is configured in SM Target Received Power Level. These automatic power 

adjustments ensure that the SM is not transmitting excessive energy (raising 

system noise level) and that the SM is able to achieve an optimal modulation state 

(and maximum achievable throughput).  

Nominally, target receive levels must be set lesser than -60 dBm in order to prevent 

interference from co-located co-channel sectors.   

Scheduler 

Downlink/Uplink 

Ratio 

Configure the schedule of downlink traffic to uplink traffic on the radio link. The 

first three options, 75/25, 50/50 and 30/70, allow the radio to operate in a fixed 

ratio on every frame.  In other words, this ratio represents the amount of the total 

radio link’s aggregate throughput that will be used for downlink resources, and the 

amount of the total radio link’s aggregate throughput that will be used for uplink 

resources. The fourth option, Flexible, allows the radio to dynamically choose the 

amount of the total radio’s aggregate throughput that is used for downlink and 

uplink resources, every frame. 

 Caution 

Setting this parameter to Flexible causes the radio to operate in unsynchronized 

mode. For all other settings, if the AP is in a cluster or is in range of another AP, 

then you must set this parameter on all other APs in the cluster and in range exactly 

the same.  Otherwise, overlapping RF transmissions will introduce system 
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Attribute Meaning 

interference.   

Carrier Sense Enabled – The device tries to detect the presence of a carrier wave from another 

AP/SM before attempting to transmit. This is to prevent the overlapping or 

corruption of the RF signal when the system is in noisy or interference RF 

environment. The device delays transmitting the wireless packets until the wireless 

channel is clear. This is only applicable in Flexible mode and on a non-DFS channel. 

Disabled – The device does not check for any other transmission.  

AP Management 

Packet Rate 

MCS0: The system is configured to use MCS0 rate for all management messages. 
This allows for improved link stability and range in high interference environment.  

MCS1:  The system is configured to use MCS1 rate for all management messages. 
This allows for slightly higher sector throughput. This is the default setting. 

Synchronization 

Synchronization 

Source 

GPS: Synchronization timing is received via the AP’s connected GPS antenna. Co-

located or in-range APs receiving synchronization via GPS or CMM transmits and 

receives at the same time, thereby reducing self-interference. 

CMM:  Synchronization timing is received via the AP’s Ethernet port via a 

connected Cambium Cluster Management Module (CMM). Co-located or in-range 

APs receiving synchronization via GPS or CMM will transmit and receive at the 

same time, thereby reducing self-interference. For more information on CMM 

configuration, refer to the PMP Synchronization Solutions User Guide. 

Internal:  Synchronization timing is generated by the AP and the timing is not 

based on GPS pulses. 

 Caution 

If a CMM is being used, verify that the cables from the CMM to the network switch 

are at most 30 ft (shielded) or 10 Ft (unshielded) and that the network switch is not 

PoE (802.3af). 

APs using Synchronization Source of Internal will not transmit and receive in sync 

with other co-located or in-range APs, which introduces self-interference into the 

system. 

Synchronization 

Holdoff Time 

The Synchronization Holdoff Time is designed to gracefully handle 

fluctuations/losses in the GPS synchronization signaling.  After the AP has received 

a reliable synchronization pulse for at least 60 seconds, if there is a loss of 

synchronization signal, the Synchronization Holdoff timer is started. During the 

holdoff interval, all SM registrations are maintained.  If a valid GPS synchronization 

pulse is regained during the holdoff interval, then the AP continues to operate 

normally.  If a valid synchronization pulse is not regained from the GPS source 

during the holdoff interval, then the AP ceases radio transmission. Default is 30 

seconds. 
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AP Quality of Service page 

The ePMP platform supports three QoS priority levels (not available in ePTP Master mode) using air fairness, 

priority-based starvation avoidance scheduling algorithm: 

Priority Level ePMP Traffic Priority Label 

Highest Priority (Served first) VOIP (only utilized when VOIP Enable is 

set to Enabled) 

Medium Priority (Served once highest priority traffic is 

sent) 

High 

Lowest Priority (Serviced once Highest and Medium 

priority traffic is sent) 

Low 

By default, all traffic passed over the air interface is low priority. The AP’s Quality of Service page may be utilized 

to map traffic to certain priority levels using QoS classification rules. The rules included in the table are enforced 

starting with the first row of the table.   

 Caution 

Each additional traffic classification rule increases device CPU utilization. Careful network traffic planning 

is required to efficiently use the device processor. 

The ePMP platform also supports radio data rate limiting (Maximum Information Rate, or MIR) based on the 

configuration of the MIR table. Operators may add up to 16 MIR profiles on the AP, each with unique limits for 

uplink and downlink data rates. The SM field MIR Profile Setting is used to configure the appropriate MIR 

profile for limiting the SM’s data rate. 

Figure 23  AP Quality of Service page 
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Table 47  AP Radio Configuration attributes 

Attribute Meaning 

Maximum Information Rate 

Maximum Information 

Rate (MIR) 

Disabled:  When disabled, RF transmission is only limited by the capacity of 

the link (and any active QoS classification rules). 

Enabled:  When enabled, all downlink and uplink traffic is limited based on the 

profiles configured in the MIR table. 

MIR Profiles The MIR (Maximum Information Rate) table is comprised of up to sixteen 

profiles which, after configured, may be set on the SM to employ a certain 

service level or data rate. 

Number Assign a profile number to each row in the AP MIR table. This profile number 

is then set on each SM to limit data transfer rates based on the operator’s 

configuration of the MIR table and its profiles. 

Description Assign a logical description for each service level. For example, a tiered service-

level provider may deploy service levels “Gold”, “Silver” and “Bronze” or “20 

Mbps”, “10 Mbps” and “5 Mbps” to offer a clear description. 

Downlink MIR (kbps) Specify the downlink rate at which the AP is allowed to transmit for this 

configured profile. 

Uplink MIR (kbps) Specify the uplink rate at which the AP is allowed to transmit for this 

configured profile. 

Traffic Priority 

Traffic Priority Disabled:  No traffic prioritization is performed. All traffic is treated with equal 

priority (low priority).  

Enabled:  Traffic prioritization is enabled and specific types of traffic can be 

prioritized using the fields below. 

VOIP Priority Enabled:  When enabled, two entries are automatically added to the first and 

second rows of the QoS Classification Rules table, one with Rule Type CoS (5) 

and one with Rule Type DSCP (46). The addition of these rules ensures that 

VoIP traffic passed over the radio downlink is given highest priority. The CoS 

and DSCP values may be modified to accommodate non-standard VoIP 

equipment. 

Disabled:  When disabled, VoIP traffic is scheduled normally along with all 

other user data. 

Broadcast Priority Low Priority:  All Broadcast traffic sent over the downlink is prioritized as low 

priority and is delivered to the SM after scheduled high priority and VoIP 

traffic. 

High Priority:  All Broadcast traffic sent over the downlink is prioritized as 

high priority and is scheduled for delivery to SMs before low priority traffic but 

after VoIP traffic. 
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Attribute Meaning 

Multicast Priority Low Priority:  All Multicast traffic sent over the downlink is prioritized as low 

priority, and will be delivered to the SM after scheduled high priority and VoIP 

traffic. 

High Priority:  All Multicast traffic sent over the downlink is prioritized as 

high priority and is scheduled for delivery to SMs before low priority traffic but 

after VoIP traffic. 

QoS Classification Rules The QoS Classification Rules table contains all of the rules enforced by the 

device when passing traffic over the radio downlink. Traffic passed through the 

device is matched against each rule in the table; when a match is made the 

traffic is sent over the radio link using the priority defined in column Traffic 

Priority. 

Type CoS:  Class of Service; traffic prioritization is based on the 3-bit header present 

in the 802.1Q VLAN-tagged Ethernet frame header in the packet entering the 

AP’s Ethernet port. 

VLAN ID:  traffic prioritization is based on the VLAN ID of the packet 

entering the AP’s Ethernet port. 

EtherType:  traffic prioritization is based on the two octet Ethertype field in 

the Ethernet frame entering the AP’s Ethernet port.  The Ethertype is used to 

identify the protocol of the data in the payload of the Ethernet frame. 

IP:  traffic prioritization is based on the source and (or) destination IP address 

of the packet entering the AP’s Ethernet port. A subnet mask may be included 

to define a range of IP addresses to match. 

MAC:  traffic prioritization is based on the source and (or) destination MAC 

address of the packet entering the AP’s Ethernet port. A mask may be included 

to define a range of MAC addresses to match. The mask is made up of a hex 

representation of a series of 1s to start the mask and 0s that end the mask. A 1 

may not follow a 0. Thus FF:FF:FF:FF:00:00 is allowed, but 

FF:00:FF:FF:FF:FF is not. The MAC address is combined with the mask to 

define the range of allowed MAC addresses. 

Details Represents the details of the Class of Service (CoS) present in the packet 

entering the AP’s Ethernet port.  

Priority Represents the QOS classification rule priority.  
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AP System page 

The AP’s System page is used to configure system parameters, services, time settings, SNMP and syslog.   

Figure 24  AP System page 
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Table 48  AP System attributes 

Attribute Meaning 

General 

Device Name Specifies the name of the AP. 

Webpage Auto Update Configure the interval for which the device retrieves system statistics for display on 

the management interface. For example, if this setting is configured to 5 seconds, 

the statistics and status parameters displayed on the management interface will be 

refreshed every 5 seconds (default). 

Web Service 

Web Service HTTP:  Access to the device management GUI is conducted via HTTP. 

HTTPS:  Access to the device management GUI is conducted via HTTPS. 

HTTP Port If Web Service is set to HTTP, configure the port which the device uses to service 

incoming HTTP requests for management GUI access. 

HTTPS Port If Web Service is set to HTTPS, configure the port which the device uses to 

service incoming HTTPS requests for management GUI access. 

SSH Service 

SSH Service Disabled: If the SSH port to the device is ‘Disabled’, access to the device through 
SSH is not possible. 

Enabled: If the SSH port to the device is ‘Enabled’, Cambium engineers can access 
the device through SSH which enables them to login to the radio and troubleshoot. 
SSH port is ‘Enabled’ by default.  

Network Time Protocol 

NTP Server IP 

Assignment 

Static:  The device retrieves NTP time data from the servers configured in fields 

NTP Server IP Address. 

DHCP:  The device retrieves NTP time data from the server IP issued via a 

network DHCP server. 

Preferred NTP Server Configure the primary NTP server IP addresses from which the device will retrieve 

time and date information. 

Alternate NTP Server Configure an alternate or secondary NTP server IP addresses from which the device 

retrieves time and date information. 

Time Zone The Time Zone option may be used to offset the received NTP time to match the 

operator’s local time zone. 

Location Services 

Obtain from Internal 

GPS 

On a GPS Synchronized ePMP radio, the Device coordinates can be populated using 

the information retrieved from the on-board GPS chip. Click the  

button to automatically populate the Device Latitude and Device Longitude fields 

using the coordinates provided by the on-board GPS chip.  

Device Latitude Configure Latitude information for the device in decimal format. 



CAMBIUM NETWORKS 

 

 103 

Attribute Meaning 

Internal GPS Latitude On a GPS Synchronized ePMP radio, the field is automatically populated with the 

Device Latitude information from the on-board GPS chip. 

Device Longitude Configure Longitude information for the device in decimal format. 

Internal GPS 

Longitude 

On a GPS Synchronized ePMP radio, the field is automatically populated with the 

Device Longitude information from the on-board GPS chip. 

Device Height Configure height above sea level for the device in meters. 

Internal GPS Height On a GPS Synchronized ePMP radio, the field is automatically populated with the 

Device height above sea level from the on-board GPS chip. 

User Account Management 

Administrator 

Username 

Read-only listing of available login levels. 

 ADMINISTRATOR, full read write permissions. 

 INSTALLER, permissions to read and write parameters applicable to unit 

installation and monitoring. 

 HOME, permissions only to access pertinent information for support purposes. 

 READONLY has permission to only view the Monitor page. 

Administrator 

Password 

Configure a custom password for Administrator account. The password character 

display may be toggled using the visibility icon . 

Installer Account Disabled: The disabled user is not granted access to the device management 

interface. The administrator user level cannot be disabled. 

Enabled: The user is granted access to the device management interface. 

Installer Username Provide the ‘Installer Username’ in this box.  

Installer Password Configure a custom password to secure the device. Only ‘Administrator’ account can 

override this password. The password character display may be toggled using the 

visibility icon . 

Home User Account Disabled: The disabled user is not granted access to the device management 

interface. 

Enabled: The user is granted access to the device management interface 

Home User Username Provide the Home User ‘Username’ in this box. 

Home User Password Configure a custom password to secure the device in order access pertinent 

information for support purpose only. The password character display may be 

toggled using the visibility icon . 

Read-Only Account Disabled: The disabled user is not granted access to the device management 

interface, even on a ‘Read-Only’ access. 

Enabled: The user is granted ‘Read-Only’ access to the device management 

interface. 
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Attribute Meaning 

Read-Only Username Provide the Read Only ‘Username’ in this box.  

Read-Only Password Provide the password that can be used for ‘Read-only’ access. Password character 

display may be toggled using the visibility icon . 

Simple Network Management Protocol (SNMP) 

Read-Only Community 

String 

Specify a control string that can allow a Network Management Station (NMS) such 

as the Cambium Networks Services Server (CNSS) to read SNMP information. No 

spaces are allowed in this string. This password will never authenticate an SNMP 

user or an NMS to read/write access. 

The SNMP Read-only Community String value is clear text and is readable by a 

packet monitor. 

Read-Write 

Community String 

Specify a control string that can allow a Network Management Station (NMS) to 

access SNMP information. No spaces are allowed in this string.  

Traps Disabled:  SNMP traps for system events are not sent from the device. 

Enabled:  SNMP traps for system events are not sent to the servers configured in 

table SNMP Trap Servers. 

Trap Community 

String 

Configure a SNMP Trap Community String which is processed by the servers 

configured in SNMP Trap Servers.  This string is used by the trap server to decide 

whether or not to process the traps incoming from the device (i.e. for traps to 

successfully be received by the trap server, the community string must match). 

Trap Servers The SNMP Trap Servers table is used to configure trap destinations for SNMP 

traps generated by the device.  

Server IP Configure the IP address of each SNMP trap server target. 

Server Port Configure the port to which SNMP traps are sent from the ePMP device. 

System Name Specify a string to associate with the physical module. This parameter can be polled 

by the Cambium Networks Services Server (CNSS) or an NMS. Special characters 

are supported. 

System Description Specify a description string to associate with the physical module. This parameter 

can be polled by the Cambium Networks Services Server (CNSS) or an NMS. Special 

characters are supported. 

Syslog Server IP 1-4 Specify up to four syslog servers to which the device sends syslog messages. 

System Log Mask Configure the levels of syslog messages which the devices send to the servers 

configured in parameters Syslog Server IP 1-4. 

 Caution 

Choose only the syslog levels appropriate for your deployment.  Excessive logging 

can cause the device log file to fill and begin overwriting previous entries. 
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AP Network page 

The AP’s Network page is used to configure system networking parameters and VLAN parameters. 

 Figure 25  AP Network page 

 

Table 49  AP Network attributes 

Attribute Meaning 

General 

IP Assignment Static:  Device management IP addressing is configured manually in fields Device 

IP Address (LAN), IP Subnet Mask (LAN), Gateway IP Address (LAN) and 

DNS Server IP Address (LAN). 

DHCP:  Device management IP addressing (IP address, subnet mask, gateway, and 

DNS server) is assigned via a network DHCP server, and parameters Device IP 

Address (LAN), IP Subnet Mask (LAN), Gateway IP Address (LAN), and DNS 

Server IP Address (LAN) are unused. 

IP Address Internet protocol (IP) address. This address is used by the family of Internet 

protocols to uniquely identify this unit on a network. 

 Note 

If Device IP address Mode is set to DHCP and the device is unable to retrieve IP 

address information via DHCP, the device management IP is set to fallback IP 

192.168.0.1 (AP mode), 192.168.0.2 (SM mode), 192.168.0.3 (Spectrum Analyzer 

mode) or the previously-configured static Device IP Address.  Units may always be 

accessed via the Ethernet port with IP 169.254.1.1. 

Subnet Mask Defines the address range of the connected IP network. For example, if Device IP 

Address (LAN) is configured to 192.168.2.1 and IP Subnet Mask (LAN) is 

configured to 255.255.255.0, the device will belong to subnet 192.168.2.X. 
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Gateway Configure the IP address of the device on the current network that acts as a 

gateway. A gateway acts as an entrance and exit to packets from and to other 

networks. 

Preferred DNS Server Configure the primary IP address of the server used for DNS resolution. 

Alternate DNS Server Configure the secondary IP address of the server used for DNS resolution. 

Ethernet MTU Maximum Transmission Unit; the size in bytes of the largest data unit that the 

device is configured to process.  Larger MTU configurations can enable the network 

to operate with greater efficiency, but in the case of retransmissions due to packet 

errors, efficiency is reduced since large packets must be resent in the event of an 

error. Packets received by the device larger than the configured MTU are dropped. 

Ethernet Port 

Configuration 

Manual:  The LAN Ethernet port speed and duplex mode can be manually 

configured.  

Auto-Negotiate:  The AP auto negotiates the LAN Ethernet port speed and duplex 

mode with the device connected to it.  

Port Speed With “Ethernet Port Configuration” the LAN Ethernet port speed can be forced to 

1000 Mbps, 100 Mbps or 10 Mbps. 

Port Duplex Mode With “Ethernet Port Configuration” the LAN Ethernet port duplex mode can be 

forced into Full or Half.  

Spanning Tree 

Protocol 

Disabled:  When disabled, Spanning Tree Protocol (802.1d) functionality is disabled 
at the AP. 

Enabled:  When enabled, Spanning Tree Protocol (802.1d) functionality is enabled 
at the AP, allowing for prevention of Ethernet bridge loops. 

AP Management 

Access Interface 

LAN Only:  Only allow access to the AP’s web management interface via a local 

Ethernet (LAN) connection.  In this configuration, the AP’s web management 

interface may not be accessed from over the air (i.e. from a device situated below the 

SM). 

LAN and WLAN:  Allow access to the AP’s web management interface via a local 

Ethernet (LAN) connection and from over the air (i.e. from a device situated below 

the SM). 

 Caution 

APs configured with AP Management Access Interface set to LAN and WLAN are 

susceptible to unauthorized access. 

SM Traffic Isolation 
Enabled: When SM Isolation feature is “enabled”, SM#1 will not be able to 
communicate with SM#2 (peer-to-peer traffic) when both the SM’s are associated 
with the same Access Point (AP). This feature essentially enables the AP to drop the 
packets to avoid peer-to-peer traffic scenario. 

Disabled: Default is set to “DISABLE” mode. When SM isolation is disabled, SM#1 

is able to communicate with SM#2, when both the SM’s are associated to the same 

Access Point (AP). 
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DHCP Option 82 Enabled: ePMP inserts “remote-id” (option ID 0×2) to be the SM’s MAC address 
and the “circuit-id” (ID 0×01) to be the AP’s MAC address. Those two fields are 
used to identify the remote device and connection from which the DHCP request 
was received.  
Disabled: When ‘Disabled’, ePMP does not insert the "remote-id" (option ID 0x2) 

and the "circuit-id" (ID 0x01). DHCP Option 82 is ‘Disabled’ by default.   

Virtual Local Area Network (VLAN) 

Management VLAN Enabled:  The AP management interface can be assigned to a Management VLAN 

to separate management traffic (remote module management via SNMP or HTTP) 

from user traffic (such as internet browsing, voice, or video. Once the management 

interface is enabled for a VLAN, an AP’s management interface can be accessed only 

by packets tagged with a VLAN ID matching the management VLAN ID.   

A VLAN configuration establishes a logical group within the network.  Each 

computer in the VLAN, regardless of initial or eventual physical location, has access 

to the same data based on the VLAN architecture.  For the network operator, this 

provides flexibility in network segmentation, simpler management and enhanced 

security. 

Disabled:  When disabled, all IP management traffic is allowed to the device. 

Management VLAN 

ID 

Configure this parameter to include the device’s management traffic on a separate 

VLAN network. For example, if MGMT VLAN ID is set to 2, GUI access will only 

be allowed from IP packets tagged with VLAN ID 2. 

Management VLAN 

Priority 

ePMP radios can prioritize VLAN traffic based on the eight priorities described in 

the IEEE 802.1p specification.  MGMT VLAN Priority represents the VLAN 

Priority or Class of Service (CoS).  Operators may use this prioritization field to give 

precedence to device management traffic. 

This parameter only takes effect if the MGMT VLAN parameter is enabled. 

Configure this parameter to set the value of the Priority code point field in the 

802.1q tag for traffic on the management VLAN originating from the SM. The 

default value is 0. 

Broadcast/Multicast Traffic Shaping 

Broadcast Packet Limit Enabled: This allows the user to set the Broadcast Packet Rate below. Configure 

this parameter to limit the amount of broadcast packets that will be allowed on the 

ingress of the radio’s Ethernet port. Set the packets per second value to limit the 

impact of events such as broadcast storms. 

Disabled: There is no limit on the amount of broadcast traffic that will be allowed 

into the ingress of the radio’s Ethernet port.  

Broadcast Packet Rate Set the packets per second value to limit the amount of broadcast traffic that will be 

allowed on the ingress on the radio’s Ethernet port. The packets per second limit 

can be set individually on each ePMP radio. The range is 100 to 16000 packets per 

second. The default is 200.  
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Convert Multicast to 

Unicast 

Enabled: This feature allows ePMP to support IGMP capable devices.  Once a 

multicast group is identified, the AP allows multicast traffic to be sent only to the 

SMs within the multicast group. The SMs support up to 5 unique multicast groups. 

In addition, when this option is enabled, the multicast traffic is sent to the SMs 

using the current Downlink MCS rate.  

Disabled: ePMP will still support IGMP capable devices but the multicast traffic 

will be sent using MCS 1 on the downlink to all SMs, regardless of the multicast 

group.  
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AP Security page 

The AP’s Security page is used to configure system security features including SM authentication and 

Layer2/Layer3 Firewall rules.  

 Caution 

If a device firewall rule is added with Action set to Deny and Interface set to LAN or WAN and no other 

rule attribute are configured, the device will drop all Ethernet or wireless traffic, respectively. Ensure that 

all firewall rules are specific to the type of traffic which must be denied, and that no rules exist in the 

devices with only Action set to Deny and Interface set to LAN or WAN. To regain access to the device, 

perform a factory default. 

Figure 26  AP Security page 
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Table 50  AP Security attributes 

Attribute Meaning 

Security Options 

Wireless Security Open:  All SMs requesting network entry are allowed registration. 

WPA2:  The WPA2 mechanism provides AES radio link encryption and SM 

network entry authentication. When enabled, the SM must register using the 

Authentication Pre-shared Key configured on the AP and SM. 

RADIUS: Enables the connection to a pre-configured RADIUS server.  

WPA2 

WPA2 Pre-shared Key Configure this key on the AP. Then configure each of the network SMs with this 

key to complete the authentication configuration. This key must be between 8 to 

128 symbols. 

RADIUS 

Servers For more Radio servers, click Add. Up to 3 Radius servers can be configured on the 

device with the following attributes: 

IP Address:  IP Address of the Radius server on the network.  

Port: The Radius server port. Default is 1812. 

Secret: Secret key that is used to communicate with the Radius server. 

Server Retries Number of times the radio will retry authentication with the configured Radius 

server before it fails authentication of the SM. 

Server Timeout Timeout between each retry with the configured Radius server before it fails 

authentication of the SM. 

Firewalls 

Layer 2 Firewall Enabled:  Modifications to the Layer 2 Firewall Table are allowed and rules are 

enforced. 

Disabled:  Modifications to the Layer 2 Firewall Table are not allowed and rules 

are not enforced. 

Firewall Rules When the SM is configured with SM Network Mode set to Bridge, the Layer 2 

firewall table may be used to configure rules matching layer 2 (MAC layer) traffic 

which result in forwarding or dropping the traffic over the radio link or Ethernet 

interface. 

Layer 3 Firewall Enabled:  Modifications to the Layer 3 Firewall Table are allowed and rules are 

enforced. 

Disabled:  Modifications to the Layer 3 Firewall Table are not allowed and rules 

are not enforced. 

Firewall Rules When the SM is configured with SM Network Mode set to NAT, the Layer 3 

firewall table may be used to configure rules matching layer 3 (IP layer) traffic 

which result in forwarding or dropping the traffic over the radio link or Ethernet 

interface. 
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AP MONITOR MENU 

Use the Monitor menu to access device and network statistics and status information. This section may be used to 

analyze and troubleshoot network performance and operation. 

The Monitor menu contains the following pages: 

 AP Performance page on page 112 

 AP System page on page 116 

 AP Wireless page on page 118 

 AP GPS page on page 120 

 AP Network page on page 122 

 AP System Log page on page 125 
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AP Performance page 

Use the Performance page to monitor system status and statistics to analyze and troubleshoot network 

performance and operation. 

Figure 27  AP Performance page 
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Table 51  AP Performance page attributes 

Attribute Meaning 

Time Since Last Reset  Time since the stats were last reset. 

Ethernet Statistics - Transmitted 

Total Traffic Total amount of traffic in Kbits transferred from the AP’s Ethernet interface. 

Total Packets Total number of packets transferred from the AP’s Ethernet interface. 

Packet Errors Total number of packets transmitted out of the AP’s Ethernet interface with errors 

due to collisions, CRC errors, or irregular packet size. 

Packet Drops Total number of packets dropped prior to sending out of the AP’s Ethernet interface 

due to Ethernet setup or filtering issues. 

Multicast/Broadcast 

Traffic 

Total amount of multicast and broadcast traffic in Kbits sent via the AP’s Ethernet 
interface. 

Broadcast Packets Total number of broadcast packets sent via the AP’s Ethernet interface. 

Multicast Packets Total number of multicast packets sent via the AP’s Ethernet interface. 

Ethernet Statistics - Received 

Total Traffic Total amount of traffic in Kbits received by the AP’s Ethernet interface. 

Total Packets Total number of packets received by the AP’s Ethernet interface. 

Packet Errors Total number of packets received by the AP’s Ethernet interface with errors due to 

collisions, CRC errors, or irregular packet size. 

Packet Drops Total number of packets dropped prior to sending out of the AP’s wireless interface 

due to Ethernet setup or filtering issues. 

Multicast/Broadcast 

Traffic 

Total amount of multicast and broadcast traffic in Kbits received by the AP’s 

Ethernet interface. 

Broadcast Packets Total number of broadcast packets received via the AP’s Ethernet interface. 

Multicast Packets Total number of multicast packets received via the AP’s Ethernet interface. 

Wireless Statistics – Downlink 

Total Traffic Total amount of traffic transmitted out of the AP’s wireless interface in Kbits. 

Total Packets Total number of packets transmitted out of the AP’s wireless interface. 

Error Drop Packets  Total number of packets dropped after transmitting out of the AP’s Wireless 

interface due to RF errors (No acknowledgement and other RF related packet 

error). 

Capacity Drop Packets  Total number of packets dropped after transmitting out of the AP’s Wireless 

interface due to capacity issues (data buffer/queue overflow or other performance or 

internal packet errors). 

Retransmission Packets Total number of packets re-transmitted after transmitting out of the AP’s Wireless 

interface due to the packets not being received by the SMs. 
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Attribute Meaning 

Multicast / Broadcast 

Traffic 

Total amount of multicast and broadcast traffic transmitted out of the AP’s wireless 

interface in Kbits. 

Broadcast Packets Total number of broadcast packets transmitted out of the AP’s wireless interface. 

Multicast Packets Total number of multicast packets transmitted out of the AP’s wireless interface. 

Wireless Statistics – Uplink 

Total Traffic Total amount of traffic received via the AP’s wireless interface in Kbits. 

Total Packets Total number of packets received via the AP’s wireless interface. 

Error Drop Packets Total number of packets dropped prior to sending out of the AP’s Ethernet interface 

due to RF errors (packet integrity error and other RF related packet error). 

Multicast / Broadcast 

Traffic 

Total amount of multicast and broadcast traffic received on the AP’s wireless 

interface in Kbits. 

Broadcast packets Total number of broadcast packets received on the AP’s wireless interface. 

Multicast Packets Total number of multicast packets received on the AP’s wireless interface. 

System Statistics  

Session Drops Total number of SM sessions dropped on the AP.  

Device Reboots Total number of reboots of the AP. 

Network Entry Attempts Total number of Network Entry Attempts by all the SMs on the AP. 

Successful Network 

Attempts 

Total number of successful network entry attempts. 

Network Entry 

Authentication Failures 

Total number of failed Network Entry Attempts by all the SMs on the AP. 

Radar (DFS) Detections Total number of DFS events that were detected by the AP. 

Subscriber Module Statistics 

MAC Address MAC Address of the SM connected to the AP. 

Total Uplink Total amount of traffic received via the AP’s wireless interface from this SM in 

Kbits. 

Total Uplink Packets Total number of packets received via the AP’s wireless interface from this SM. 

Uplink Packet Drops Total number of packets dropped prior to sending out of the AP’s Ethernet interface 

due to RF errors (packet integrity error and other RF related packet error) from 

this SM. 

Total Downlink Total amount of traffic transmitted out of the AP’s wireless interface in Kbits. 

Total Downlink Packets Total number of packets transmitted out of the AP’s wireless interface. 
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Attribute Meaning 

Downlink Packet Drops Total number of packets dropped after transmitting out of the AP’s Wireless 

interface due to RF errors (No acknowledgement and other RF related packet 

error). 

Downlink Capacity 

Packet Drops 

Total number of packets dropped after transmitting out of the AP’s Wireless 

interface due to capacity issues (data buffer/queue overflow or other performance or 

internal packet errors). 

Downlink Retransmitted 

Packets 

Total number of packets re-transmitted after transmitting out of the AP’s Wireless 

interface due to the packets not being received by the SM. 

Downlink Power The transmit power of the AP for the downlink packets to the SM.  

Downlink Packets per MCS  

MCS 0 through  

MCS 15 

Number of packets (and percentage of total packets) transmitted out of the AP’s 

wireless interface for every modulation mode used by the AP’s transmitter, based on 

radio conditions. 

Uplink Packets per MCS 

MCS 0 through 

MCS 15 

Number of packets (and percentage of total packets) received on the AP’s wireless 

interface for every modulation mode, based on radio conditions. 

Downlink Frame Time 

Total Frame Time Used Percentage of frame time used in the downlink. 

Uplink Frame Time 

Total Frame Time Used Percentage of frame time used in the uplink. 
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AP System page 

Use the System Status page to reference key system information. 

Figure 28  AP System Status page 

 

 

Table 52  AP System Status page attributes 

Attribute Meaning 

Hardware Version Board hardware version information. 

Firmware Version U-Boot version information. 

Software Version 

(Active Bank) 

The currently operating version of software on the ePMP device. 

Software Version 

(Inactive Bank) 

The backup software version on the ePMP device, used upon failure of the active 

bank. Two software upgrades in sequence will update both the Active Software 

Bank Version and the Inactive Software Bank Version. 

Date and Time Current date and time, subject to time zone offsets introduced by the configuration 

of the device Time Zone parameter. Until a valid NTP server is configured, this 

field will display the time configured from the factory. 

System Uptime The total system uptime since the last device reset. 

Wireless MAC 

Address 

The hardware address of the device wireless interface. 

Ethernet MAC 

Address 

The hardware address of the device LAN (Ethernet) interface. 
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Attribute Meaning 

DFS Status N/A:  DFS operation is not required for the region configured in parameter 

Country Code. 

Channel Availability Check:  Prior to transmitting, the device must check the 

configured Frequency Carrier for radar pulses for 60 seconds).  If no radar pulses 

are detected, the device transitions to state In-Service Monitoring. 

In-Service Monitoring: Radio is transmitting and receiving normally while 

monitoring for radar pulses which require a channel move. 

Radar Signal Detected: The receiver has detected a valid radar pulse and is 

carrying out detect-and-avoid mechanisms (moving to an alternate channel). 

In-Service Monitoring at Alternative Channel:  The radio has detected a radar 

pulse and has moved operation to a frequency configured in DFS Alternative 

Frequency Carrier 1 or DFS Alternative Frequency Carrier 2. 

System Not In Service due to DFS:  The radio has detected a radar pulse and has 

failed channel availability checks on all alternative frequencies.  The non-occupancy 

time for the radio frequencies in which radar was detected is 30 minutes. 

Sync Source Status Displays the current source (GPS, CMM or Internal) of sync timing for the AP.  
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AP Wireless page 

Use the Wireless Status page to reference key information about the radio’s wireless interface and connected SMs. 

Figure 29  AP Wireless Status page 

  

 

Table 53  AP Wireless Status page attributes 

Attribute Meaning 

Operating Frequency The current frequency at which the AP is operating. 

Operating Channel 

Bandwidth 

The current channel size at which the AP is transmitting and receiving. 

Transmitter Output 

Power 

The current power level at which the AP is transmitting. 

Registered Subscriber 

Modules 

The total number of SMs which are currently registered to the AP. 

Ethernet Interface Up: The Ethernet (LAN) interface is functioning properly. 

Down: The Ethernet (LAN) interface has encountered an error and is not servicing 

traffic. 

Wireless Interface Up: The radio (WAN) interface is functioning properly. 

Down: The radio (WAN) interface has encountered an error and is not servicing 

traffic. 

Current Country Code The current country code at which the AP is operating. 

Total Multicast groups Displays the current number of multicast groups that the AP has identified from 

IGMP devices connected to the registered SMs.  

Registered 

Subscriber Modules 

Use the Registered Subscriber Modules table to monitor registered SMs, their 

key RF status and statistics information.  

SM MAC Address The MAC address of the SM wireless interface. 
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Attribute Meaning 

SM IP Address The IP address of the SM wireless interface.  

SM Name Device Name of the SM 

Disconnect SM Clicking this button disconnects the SM from the AP 

Uplink RSSI Current receive signal strength of the SM at the AP, in the uplink 

Downlink RSSI 

(Estim.) 

Current estimated receive signal strength of the SM in the downlink 

Uplink SNR Current Signal-to-Noise of the SM in the uplink 

Downlink SNR Current Signal-to-Noise of the SM in the downlink 

Uplink MCS Current MCS at which the SM is operating on the uplink 

Downlink MCS Current MCS at which the SM is operating on the downlink 

MIR Profile Current MIR profile assigned to this SM 

Uplink Rate (kbps) Current uplink MIR assigned to this SM in kbps 

Downlink Rate (kbps) Current downlink MIR assigned to this SM in kbps 

Downlink Quality The downlink quality based on the current MCS and PER for this SM 

Downlink Capacity The downlink capacity based on the current DL MCS with respect to.the highest 

supported MCS (MCS15). Not available in ePTP Master mode.  

Session Time Time duration for which the SM has been registered and in session with the AP.  

  



CAMBIUM NETWORKS 

 

 120 

AP GPS page 

Use the GPS Status page to reference key information about the radio’s configured GPS coordinates. 

Figure 30  AP GPS Status page 
 

 

Table 54  AP GPS Status page attributes 

Attribute Meaning 

Internal GPS Latitude On a GPS Synchronized ePMP radio, the field is automatically populated with the 

Device Latitude information from the on-board GPS chip. 

Internal GPS 

Longitude 

On a GPS Synchronized ePMP radio, the field is automatically populated with the 

Device Longitude information from the on-board GPS chip. 

Internal GPS Height On a GPS Synchronized ePMP radio, the field is automatically populated with the 

Device height above sea level from the on-board GPS chip. 

GPS Time (Greenwich 

Mean Time) 

On a GPS Synchronized ePMP radio, the field is automatically populated with the 

time from the on-board GPS chip. 

GPS Firmware version On a GPS Synchronized ePMP radio, the field indicates the current firmware 

version of the on-board GPS chip. 
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Attribute Meaning 

Satellites Tracked  On a GPS Synchronized ePMP radio, the field indicates the number of satellites 

current tracked by the on-board GPS chip. 

Satellites Visible On a GPS Synchronized ePMP radio, the field indicates the number of satellites 

visible to the on-board GPS chip. 

Satellites The Satellites table provides information about each satellite that is visible or 

tracked along with the Satellite ID and Signal to Noise Ratio (SNR) of the satellite. 

ID Represents the Satellite ID.  

Signal-to-Noise Ratio This is an expression of the carrier signal quality with respect to signal noise. 

Status Status of each Satellite available.  
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AP Network page 

Use the AP Network Status page to reference key information about the device network status. 

Figure 31  AP Network Status page 

 

  

Table 55  AP Network Status page attributes 

Attribute Meaning 

Ethernet Status 

IP Assignment Static:  Device management IP addressing is configured manually in fields Device 

IP Address (LAN), IP Subnet Mask (LAN), Gateway IP Address (LAN) and 

DNS Server IP Address (LAN). 

DHCP:  Device management IP addressing (IP address, subnet mask, gateway, 

and DNS server) is assigned via a network DHCP server, and parameters 

Device IP Address (LAN), IP Subnet Mask (LAN), Gateway IP Address (LAN), 

and DNS Server IP Address (LAN) are unused. 
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Attribute Meaning 

Ethernet Interface Up: The device Ethernet interface is functioning and passing data. 

Down: The device Ethernet interface has encountered an error disallowing full 

operation. Reset the device to reinitiate the Ethernet interface. 

IP Address The current IP Address mode of the device (static or DHCP). 

Subnet Mask The currently configured device IP subnet mask. 

MTU Size The currently configured Maximum Transmission Unit for the AP’s Ethernet 

(LAN) interface. Larger MTU configurations can enable the network to operate 

with greater efficiency, but in the case of retransmissions due to packet errors, 

efficiency is reduced since large packets must be resent in the event of an error. 

Port Speed The current Ethernet port speed of the radio.  

Port Duplex Mode The current Ethernet port duplex mode of the radio. 

Wireless Status 

Wireless Interface Up: The device wireless interface is functioning and passing data 

Down: The device wireless interface has encountered an error disallowing full 

operation. Reset the device to reinitiate the wireless interface. 

IP address Currently unused. 

Subnet Mask Currently unused. 

Default Gateway IP address that is currently assigned. 

Network Status 

DNS Server IP Represents the IP address of the DNS Server.  

DHCP Option 82 
Enabled: ePMP inserts “remote-id” (option ID 0×2) to be SM’s MAC address and 
the “circuit-id” (ID 0×01) to be the AP’s MAC address. Those two fields are used to 
identify the remote device and connection where the DHCP request was received 
and DHCP server can assign IP address accordingly. 

Disabled: When ‘Disabled’, AP passes the bootP traffic unaffected. DHCP Option 

82 is ‘Disabled’ by default.   

Multicast Status 
 

Multicast Processing 
Displays the rate at which multicast traffic is sent on the downlink.  

Fixed MCS: Multicast traffic is sent to the SMs on the downlink at MCS 1.  

Converted to Unicast: Multicast traffic is converted to unicast and sent to the SMs 

at the current MCS capability on the downlink.   

ARP Table 

MAC Address MAC Address of the devices on the bridge. 

IP Address IP Address of the devices on the bridge. 

Interface Interface on which the AP identified the devices on. 

Bridge Table 
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Attribute Meaning 

MAC address The hardware address of the AP. 

Port The port to which the device is connected. 

Subscriber Module 

MAC 

MAC Address for one of the connected SMs. 

Aging Timer (secs) Time set for the MAC addresses in the Bridge table. 
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AP System Log page 

Use the AP System Log page to view the device system log and to download the log file to the accessing 

PC/device. 

Figure 32  AP System Log page 

  

Table 56  AP System Log attributes 

Attribute Meaning 

Syslog Display Enabled: The system log file is displayed on the management GUI. 

Disabled: The system log file is hidden on the management GUI. 

Download Use this button to download the full system log file to a connected PC or device. 
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AP TOOLS MENU 

The AP Tools menu provides several options for upgrading device software, configuration backup/restore, 

analyzing RF spectrum, testing device throughput, and running ping and traceroute tests. 

 AP Software Upgrade page on page 127 

 AP Backup/Restore page on page 129 

 AP eDetect page on page 132 

 AP Spectrum Analyzer page on page 135 

 AP Automatic Channel Selection page on page 138 

 AP eAlign page on page 140 

 AP Wireless Link Test page on page 142 

 AP Ping page on page 144 

 AP Traceroute page on page 145  
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AP Software Upgrade page 

Use the AP Software Upgrade page to update the device radio software to take advantage of new software features 

and improvements. 

 Caution 

Read the Release Notes associated with each software release.   

Figure 33  AP Software Upgrade page 

  
 

Table 57  AP Software Upgrade attributes 

Attribute Meaning 

Main Software 

Software Version  

(Active Bank)  

The current software running on the device. 

Software Version  

(Inactive Bank) 

When the Active Bank Software (current) is corrupt and cannot power up for 8 

consecutive reboots, the Inactive Software becomes the Active software and powers 

up the device. 

Firmware Version The current U-Boot version. 
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Attribute Meaning 

Upgrade Options URL: A webserver may be used to retrieve software upgrade packages 

(downloaded to the device via the webserver). For example, if a webserver is 

running at IP address 192.168.2.1 and the software upgrade packages are located 

in the home directory, an operator may select option From URL and configure the 

Software Upgrade Source field to 

http://192.168.2.1/<software_upgrade_package>. 

Local File: Click Browse to select the local file containing the software upgrade 

package. 

Select File Click Browse to select a local file (located on the device accessing the web 

management interface) for upgrading the device software. 

GPS Firmware 

Firmware Version The current firmware of the on-board GPS chip (AXN_1.51_2801). After upgrading, 

this version should show as AXN_1.51_2838. 

Upgrade Options URL: A webserver may be used to retrieve GPS firmware upgrade packages 

(downloaded to the device via the webserver). For example, if a webserver is running 

at IP address 192.168.2.1 and the firmware upgrade packages are located in the home 

directory, an operator may select option From URL and configure the GPS 

Firmware Upgrade Source field to 

http://192.168.2.1/<firmware_upgrade_package>. 

Local File: Click Browse to select the local file containing the GPS firmware upgrade 

package. 

 Note 

If the “GPS Firmware Version” under Monitor=>GPS Status shows “NOT 

AVAILABLE”, it means that the on-board GPS chip has locked up. A power cycle of 

the ePMP unit is required to restore the connectivity to the chip before performing 

the GPS firmware upgrade. 

Select File Click Browse to select a local file (located on the device accessing the web 

management interface) for upgrading the on-board GPS chip firmware. 

 Note 

Use the same package that is used to upgrade the device’s software. The new GPS 

firmware is part of the software upgrade packages. 
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To upgrade the device software from a local file (or network-accessible file), follow this: 

Procedure: 

1 Download the software upgrade packages from https://support.cambiumnetworks.com/files/epmp 

2 Clear the accessing browser cache 

3 On the device GUI, navigate to Tools => Software Upgrade. 

4 Select the Software Upgrade Source which represents the location of your software upgrade packages 

5 Based on the configuration of Software Upgrade Source, enter either the Software Upgrade Source  or 

click the Browse button and locate the software package 

6 Click Upgrade 

7 When the upgrade completes successfully, click the Reset icon 

To upgrade the GPS firmware from a local file (or network-accessible file), follow this: 

Procedure: 

1 Download the software upgrade packages from https://support.cambiumnetworks.com/files/epmp 

2 Clear the accessing browser cache 

3 On the device GUI, navigate to Tools => Software Upgrade 

4 Select the Upgrade Options under GPS Firmware which represents the location of your software 

upgrade packages 

5 Based on the configuration of GPS Firmware Source, enter either the Upgrade Source  or click the 

Browse button and locate the firmware package 

6 Click Upgrade 

7 When the upgrade completes successfully, click the Reset icon 
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AP Backup/Restore page 

Use the AP Backup/Restore page to perform the following functions: 

 Back up the configuration in either text (.json) format or binary (.bin) format.  

 Restore the configuration of using a configuration file that was previously backed up.  

 Reset the device to its factory default configuration. For more factory defaulting methods, see: 

o Using the device external reset button on page 227 

o Resetting the ePMP to factory defaults by power cycling on page 228 

Figure 34  AP Backup / Restore page 
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Table 58  AP Backup / Restore attributes 

Attribute Meaning 

Backup Configuration 

Configuration File 

Format 

Text (Editable): Choosing this option will download the configuration file in the 

json format and can be viewed and/or edited using a standard text editor.  

Binary (Secured): Choosing this option will download the configuration file in the 

.bin format and cannot be viewed and/or edited using an editor. Use this format 

for a secure backup.  

Restore Configuration 

Select File Click Browse to select a local file (located on the device accessing the web 

management interface) for restoring the device configuration. 

Factory Default Configuration 

Reset to Factory 

Defaults 

Use this button to reset the device to its factory default configuration. 

 Caution 

A reset to factory default configuration resets all device parameters. The AP will 

cease to transmit and any registered SMs will lose their session. 
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AP eDetect page 

The eDetect tool (not available in ePTP Master mode) is used to measure the 802.11 interference at the ePMP 

radio or system when run from the AP, on the current operating channel. When the tool is run, the ePMP device 

processes all frames received from devices not connected to the ePMP system and collects the interfering frame’s 

information such as MAC Address, RSSI, and MCS. Use the AP eDetect page to perform the following functions: 

 Collect information about interferers system wide on the AP and the SMs connected to it to display on the 

APs GUI.  

 Collect information about interferers locally at the AP only to display on the AP’s GUI.  

Figure 35  AP eDetect page  

 

 



CAMBIUM NETWORKS 

 

 133 

Table 59  AP eDetect attributes 

Attribute Meaning 

Detecting Device AP: Choosing this option will collect information about interferers local to the AP.  

AP/SMs: Choosing this option collect information about interferers system wide i.e. 

interferers local to the AP as well as interferers at the SMs connected to the AP.  

Detection Duration Configure the duration for which the AP (and SMs) scan for interferers. 

 Caution 

During the scanning period, the AP continues servicing the SMs under it, and there 

is no outage (unlike running a Spectrum Analyzer). There may be a negligible 

degradation in overall sector throughput.  

Start/Stop Use to start or stop the interference detection. 

Export to CSV Choose this option to export the detection results to .csv format. 

Status Current status of the Interference Detection tool. 

AP SSID The current configured name/SSID of the AP. 

Detection Results Use the Detection Results table to monitor interferers at the AP and at the 

registered SMs and their key RF parameters. 

Device Instant Health This is an indicator of the device’s health in terms of channel conditions in the 

presence of interferer(s).  

Green: Indicates that the channel is relatively clean and has good C/I levels 

(>25dB). The interference level is low.  

Yellow: Indicates that the channel has moderate or intermittent interference (C/I 

between 10dB and 25dB). 

Red: Indicates that the channel has high interference and poor C/I levels (<10dB). 

Device MAC The MAC address of the AP and/or SMs wireless interface. 

Device RSSI (dBm) The Received Signal Strength Indicator, which is a measurement of the power level 

being received by the device’s antenna. 

Device MCS Modulation and Coding Scheme – indicates the modulation mode used for the 

radio’s receiver side, based on radio conditions (MCS 1-7, 9-15). 

Interferers’ MAC The MAC address of the interferer’s wireless interface. 

Interferers’ RSSI 

(dBm) 

The Received Signal Strength Indicator, which is a measurement of the interferer’s 

power level being received by the device’s antenna. 

Interferers’ MCS Modulation and Coding Scheme – indicates the modulation mode used by the 

interferer, based on radio conditions (MCS 1-15). 

 Note 
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The system is operational when the eDetect tool is initiated. The detection is done during the transmission 

period within the TDD frame. And it is possible that the AP detects another AP on its back sector as an 

interferer when it is using the same frequency carrier in a GPS Synchronized system. Also, since the 

detection happens when the system is operational, there may be a negligible degradation in overall sector 

throughput when run from the AP.  
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AP Spectrum Analyzer page 

Use the AP Spectrum Analyzer page download the spectrum analyzer tool. 

To download the spectrum analyzer tool, the AP Device Mode must be set to Spectrum Analyzer. 

Java Runtime Environment is required to run the AP spectrum analyzer. 

 Caution 

Conducting spectrum analysis causes the AP to enter scan mode and the AP drops all RF connections.   

Vary the days and times when you analyze the spectrum in an area. The RF environment can change 

throughout the day or throughout the week. 

To conduct a spectrum analysis, follow this: 

Required Software: 

 Java Run-time Environment (JRE) 

Procedure: 

1 On the AP GUI, navigate to Configuration => Radio 

2 Change the Radio Mode to Spectrum Analyzer 

3 Click the Save button 

4 Click the Reset button 

5 Login to the AP GUI and navigate to Tools => Spectrum Analyzer. 

 

 

6 Click Download Spectrum Analyzer Tool 

7 Locate the folder to which the spectrum analyzer tool was saved and ‘Double-click’ on file csa.jnlp to 

launch the tool 

8 If a security warning window appears, check the box next to “I accept the risk and want to run this application” 
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9 In the security warning window, click Run 

The spectrum analyzer interface is displayed 

 

10 Click Range to configure the range of frequencies to scan. 

11 Click Start Scan to begin scanning 

 

 

 

Display of the 
average, peak, 
current, and 
minimum power 
levels for the 
configured range 

Statistical display 
of the number of 
times each 
frequency in the 
range was scanned 

Spectrogram 
display of the 
energy levels 
detected 
throughout the 
configured range, 
over time 
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Once the scanning completes, follow these steps to return the device to AP operation: 

Procedure: 

1 In the spectrum analyzer application, click Stop Scan 

2 Close the spectrum analyzer application by clicking File => Exit 

3 On the AP GUI, navigate to Configure => Radio 

4 Configure Device Mode to AP 

5 Click the Save button 

6 Click the Reset button 
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AP Automatic Channel Selection page 

Use the Automatic Channel Selection page to use the Automatic Channel Selection feature to allow the AP to 
choose the best channel possible under the current RF environment. This feature is not available when the AP is 
in ePTP Master mode.   
 

Figure 36 AP Automatic Channel Selection 
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Table 60 Automatic Channel Selection 

Attribute Meaning 

Automatic Channel 
Selection 

Enabled – This enables the Automatic Channel Selection (ACS) feature. ACS allows 

the radio to scan the entire band (governed by the Country setting) and chooses a 

channel with the lowest channel occupancy i.e. lowest interference level. To run the 

ACS feature (once enabled), the radio will have to be rebooted or manually triggered 

using Tools->Automatic Channel Selection. When ACS is running, the radio 

measures the occupancy level of the channel (measured in terms of an internal 

interference metric) and uses an algorithm to make a decision to choose the best 

channel within the band. The channel chosen is not based just on the occupancy level 

channel but also the occupancy level of adjacent channels.  

Disabled – ACS is disabled and the operator should configure a Frequency Carrier 

manually.  

 Note 

The channel bandwidth configured prior to enabling and running ACS will be used 

to automatically select a channel. For ex: If the operator manually configured a 

channel bandwidth of 20MHz, ACS will scan and choose a channel of 20MHz wide 

channel. To switch ACS to 40MHz or other channel bandwidth, the operator should 

disable ACS, manually configure 40MHz or desired channel bandwidth on the radio, 

then enable and run ACS.  

Scan Channel Bandwidth Configure the channel size for which the radio needs to scan the band. 

Minimum Dwell Time Configure the minimum time in milliseconds for which the radio needs to scan a 

channel to measure channel occupancy or interference levels. Default is 200 ms.  

Maximum Dwell Time Configure the maximum time in milliseconds for which the radio needs to scan a 

channel to measure channel occupancy or interference levels. Default is 300 ms. 

Results Click this button to download the most recent ACS results in .csv format.  
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AP eAlign page 

Use the eAlign page to aid with link alignment.  

 

 Note 

eAlign is available on the AP when the Access Point Mode is set to PTP only. A valid link to an SM is required 
to provide meaningful RSSI measurements. 

Figure 37 AP eAlign 

 

Table 61 eAlign 

Attribute Meaning 

Operating Frequency The current frequency at which the AP is operating. 

Registered SM MAC Address The MAC address of the SM that is registered to the AP. 

Current RSSI Current RSSI value measured on the uplink by the AP’s receiver. 

Peak RSSI Peak RSSI value measured by the AP’s receiver from the time the user 

navigated to the eAlign page.   

Reset Measurements Click this button to reset all current measurements.  
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 Caution 

ePMP supports Automatic Transmit Power Control (ATPC) where the SMs are instructed by the AP to 

adjust their Tx power in order for the SM’s signal (UL RSSI) to arrive at the AP at a predetermined RSSI 

level (configurable on the AP under Configuration->Radio->Power Control->Subscriber Module Target 

Receive Level). This feature is beneficial to keep the overall noise floor in the sector to an acceptable level 

and is critical for deploying a GPS Synchronized system. However, the feature negates the purpose of 

eAlign measurements on the AP since, during the alignment, the SM may constantly change its Tx power. 

It is recommended to turn off ATPC and set the SM’s Tx power to maximum allowable power during 

alignment.  

While aligning the link using eAlign, please follow these steps: 

Procedure: 

1 On the SM, set Configuration->Radio->Power Control->Tx Power Manual Limit to Max Tx Output 

Power 

2 Set Configuration->Radio->Power Control->Transmitter Output Power to 30 dBm (or maximum value 

allowed by regulations).  

3 Click the Save button 

4 Perform link alignment using eAlign 

5 Once alignment is complete, set Configuration->Radio->Power Control->Tx Power Manual Limit back to 

Auto 

6 Click the Save button 
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AP Wireless Link Test page 

Use the AP Wireless Link Test page to conduct a simple test of AP wireless throughput to any one of the 

connected SMs. This allows user to determine the throughput that can be expected on a particular link without 

having to use external tools.  

Figure 38  AP Wireless Link Test 

 

 

Table 62  AP Wireless Link Test attributes 

Attribute Meaning 

Test Setup 

Subscriber Module 

MAC Address 

Enter the MAC Address of one of the connected SMs or simply click the Select 

button of the SM desired in the “Registered Subscriber Modules” list. 

Packet Size Choose the Packet Size to use for the throughput test. 

Duration Choose the time duration in seconds to use for the throughput test. 

Downlink This field indicates the result of the throughput test on the downlink, in Mbps. 

Uplink This field indicates the result of the throughput test on the uplink, in Mbps. 

Aggregate This field indicates the result of the aggregate throughput on the link, in Mbps. 

Displayed only when Downlink/Uplink Ratio is set to 75/25, 50/50 or 30/70.  
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Registered Subscriber 

Modules 

Use the Connected SM List table to monitor registered SMs and their key RF status 

and statistics information. Click Select on the SM that is desired to be used in the 

throughput test. 
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AP Ping page 

Use the AP Ping page to conduct a simple test of AP IP connectivity to other devices which are reachable from the 

network. If no ping response is received or if “Destination Host Unreachable” is reported, the target may be down, 

there may be no route back to the AP, or there may be a failure in the network hardware (i.e. DNS server failure). 

Figure 39  AP Ping page 

 

Table 63  AP Ping attributes 

Attribute Meaning 

Ping 

IP Address Enter the IP address of the ping target. 

Number of packets (-c) Enter the total number of ping requests to send to the target. 

Buffer size (-s) Enter the number of data bytes to be sent. 

TTL (-t) Set the IP Time-To-Live (TTL) for multicast packets. This flag applies if the ping 

target is a multicast address. 

Ping results Results of the Ping test are displayed in the box.  
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AP Traceroute page 

Use the AP Traceroute page to display the route (path) and associated diagnostics for IP connectivity between the 

AP and the destination specified. 

Figure 40  AP Traceroute page 

 

Table 64  AP Traceroute attributes 

Attribute Meaning 

Traceroute 

IP Address Enter the IP address of the target of the traceroute diagnostic. 

Fragmentation (-F) ON: Allow source and target to fragment probe packets. 

OFF: Do not fragment probe packets (on source or target). 

Trace method (-l) ICMP ECHO: Use ICMP ECHO for traceroute probes. 

UDP: Use UDP for traceroute probes. 

Display TTL (-l) ON: Display TTL values for each hop on the route. 

OFF: Suppress display of TTL values for each hop on the route. 

Verbose (-v) ON: ICMP packets other than TIME_EXCEEDED and UNREACHABLE are 

displayed in the output. 

OFF:  Suppress display of extraneous ICMP messaging. 

Traceroute Results Traceroute test results are displayed in the box.  
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Using the SM menu options 

Use the menu navigation bar in the top and left panels to navigate to each web page. The functional area that may 

be accessed from each menu option is listed under Table 45. Some of the parameters are only displayed for specific 

system configurations. 

Table 65  Functional areas accessed from each menu option 

Menu option Menu Details 

Quick Start Configuring SM units using the Quick Start menu on page 84 

Configure SM Configuration menu on page 147 

    Radio SM Radio page on page 148 

    Quality of Service SM Quality of Service page on page 151 

    System SM System page on page 158 

    Network SM Network page on page 162 

    Security SM Security page on page 175 

Monitor SM Monitor menu on page 177 

    Performance SM Performance page on page 178 

    System Status SM System page on page 181 

    Wireless Status SM Wireless page on page 183 

    Network Status SM Network page on page 186 

    System Log SM System Log page on page 193 

Tools SM Tools menu on page 194 

    Software Upgrade SM Software Upgrade page on page 195 

    Backup / Restore SM Backup / Restore page on page 197 

    eDetect SM eDetect page on page 199 

    Spectrum Analyzer SM Spectrum Analyzer page on page 201 

    eAlign SM eAlign page on page 204 

    Wireless Link Test SM Wireless Link Test page on page 205 

    Ping SM Ping page on page 206 

    Traceroute SM Traceroute page on page 207 
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SM CONFIGURATION MENU 

Use the Configuration menu to access all applicable device configuration parameters. It contains the following 

pages: 

 SM Radio page on page 148 

 SM Quality of Service page on page 151 

 SM System page on page 158 

 SM Network page on page 162 

 SM Security page on page 175 
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SM Radio page 
Use the Radio page to configure the device radio interface parameters. 

 Caution 

Modifying radio parameters may result in a wireless outage. Plan configuration modifications accordingly. 

Figure 41  SM Radio page (TDD or ePTP Slave mode) 
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Table 66  SM Radio Configuration attributes (TDD mode or ePTP Slave mode) 

Attribute Meaning 

General 

Radio Mode This parameter controls the function of the device – All ePMP devices may be 

configured to operate as an Access Point (AP), Subscriber Module (SM) or as a 

Spectrum Analyzer. 

Subscriber Module 

Mode 

This parameter controls the wireless mode of operation of the SM.  

TDD: The SM is operating in the proprietary TDD mode and will only connect to 

another ePMP Access Point.  

Standard WiFi: The SM is operating in the Standard 802.11n WiFi mode and will 

be able to connect to any Access Point operating in standard 802.11n WiFi mode. 

ePTP Slave: The SM is operating as a Slave in point-to-point mode. The AP and 

the system do not support GPS Synchronization in this mode but are able to provide 

significantly lower latency than other modes. QoS (MIR and traffic priority) 

capability and Link Quality/Capacity indicators are not available in this mode.   

Country The SM automatically inherits the Country Code setting of the AP (except for US-

locked devices). 

Country settings affect the radios in the following ways: 

 Maximum transmit power limiting (based on radio transmitter power plus 

configured antenna gain) 

 DFS operation is enabled based on the configured country code, if applicable 

 Frequency selection is based on local regulatory limits 

Length Unit The unit of measurement used for reporting Distance from AP. 

Subscriber Module Configuration 

Uplink Max Rate Configure the maximum MCS (Modulation and Coding Scheme) that the SM should 

use in the uplink. For example: Setting this parameter to MCS12 will prevent the 

SM’s rate adapt algorithm from using MCS13 through MCS15. Not available when 

SM is in ePTP Slave or Standard WiFi mode.   

Preferred AP List 

Preferred APs The Preferred AP List is comprised of a list of up to 16 APs to which the SM 

sequentially attempts registration.  For each AP configured, if authentication is 

required, enter a Pre-shared Key associated with the configured AP SSID. 
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Attribute Meaning 

Subscriber Module Scanning 

Scan Channel 

Bandwidth Click the  button to unselect all channel bandwidths. The SM will not 

scan for any frequencies.   

Click the  button to select all channel bandwidths. The SM will scan all 

channel bandwidths, i.e 5 MHz, 10 MHz, 20 MHz and 40 MHz. 

Alternately choose individual channel bandwidth tabs and/or frequencies within 

each channel bandwidth tab for a customized scan list.  

Power Control 

Tx Power Manual 

Limit 

Auto: The Access Point can control, using ATPC (Automatic Transmit Power 

Control), the TX power of the SM up to the maximum capability of the SM’s 

transmitter (based on regulatory limits). 

Max Tx Output Power: The Access Point can control the TX power of the SM up 

to the value configured in the Transmitter Output Power field below.  

Transmitter Output 

Power 

When Max Tx Output Power is selected, the SM will not transmit higher than the 

configured value in the field. Determines the maximum output power of the 

transmitter. The actual output power may be lower due to Automatic Transmit 

Power Control (ATPC), where the AP instructs the SM to lower its power to meet 

the SM target Receive Level configured on the AP. 

Antenna Gain This value represents the amount of gain introduced by the unit’s internal antenna. 

This parameter is read-only for Integrated radios. 

Network Entry RSSI 

Threshold 

Set this parameter to the minimum Received Signal Strength Indicator (RSSI) at the 

SM required for the SM to attempt registration to an AP.  For example, if the AP 

RSSI Threshold is set to -80 dBm, and the SM is receiving the AP signal at -85 

dBm (RSSI = -85 dBm), the SM will not attempt to register to the AP. 

Network Entry SNR 

Threshold 

Set this parameter to the minimum Signal-to-Noise Ratio (SNR) at the SM required 

for the SM to attempt registration to an AP.  For example, if the AP SNR 

Threshold is set to 30 dB and the SM is calculating its DL SNR as 25 dB, the SM 

will not attempt to register to the AP. 
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Figure 42  SM Radio page (Standard WiFi mode) 
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Table 67  SM Radio Configuration attributes (Standard WiFi mode) 

Attribute Meaning 

General 

Radio Mode This parameter controls the function of the device – All ePMP devices may be 

configured to operate as an Access Point (AP), Subscriber Module (SM) or as a 

Spectrum Analyzer. 

Subscriber Module 

Mode 

This parameter controls the wireless mode of operation of the SM.  

TDD: The SM is operating in the proprietary TDD mode and will only connect to 

another ePMP Access Point.  

Standard WiFi: The SM is operating in the Standard 802.11n WiFi mode and will 

be able to connect to any Access Point operating in standard 802.11n WiFi mode. 

ePTP Slave: The SM is operating as a Slave in point-to-point mode. The AP and 

the system do not support GPS Synchronization in this mode but are able to provide 

significantly lower latency than other modes. QoS (MIR and traffic priority) 

capability and Link Quality/Capacity indicators are not available in this mode.    

Fallback Country The SM automatically inherits the Country Code setting of the AP (except for US-

locked devices). 

Fallback Country is used by the SM if the AP does not provide a Country Code to 

the SM during registration and affect the radios in the following ways: 

 Maximum transmit power limiting (based on radio transmitter power plus 

configured antenna gain) 

 DFS operation is enabled based on the configured country code, if applicable 

 Frequency selection is based on local regulatory limits 

Length Unit The unit of measurement used for configuring Distance to AP. 

Subscriber Module Configuration 

Distance to AP In Standard WiFi mode, this parameter represents cell coverage radius. SMs outside 

the configured radius will not achieve optimal throughput. It is recommended to 

configure Distance to AP to match the actual physical maximum range of the 

farthest subscriber. This must be configured to match the range of the farthest 

subscriber on all SMs under the AP regardless of their respective distance from the 

AP.  

Preferred AP List  

Preferred APs The Preferred AP List is comprised of a list of up to 16 APs to which the SM 

sequentially attempts registration.  For each AP configured, if authentication is 

required, enter a Pre-shared Key associated with the configured AP SSID. 



CAMBIUM NETWORKS 

 

 153 

Attribute Meaning 

Subscriber Module Scanning 

Scan Channel 

Bandwidth Click the  button to unselect all channel bandwidths. The SM will not 

scan for any frequencies.   

Click the  button to select all channel bandwidths. The SM will scan all 

channel bandwidths, i.e 5 MHz, 10 MHz, 20 MHz and 40 MHz. 

Alternately choose individual channel bandwidth tabs and/or frequencies within 

each channel bandwidth tab for a customized scan list.  

Power Control 

Tx Power Manual 

Limit 

Auto: The Access Point can control, using ATPC (Automatic Transmit Power 

Control), the TX power of the SM up to the maximum capability of the SM’s 

transmitter (based on regulatory limits). 

Max Tx Output Power: The Access Point can control the TX power of the SM up 

to the value configured in the Transmitter Output Power field below.  

Transmitter Output 

Power 

The SM will not transmit higher than the configured value in the field. Determines 

the maximum output power of the transmitter. The actual output power may be 

lower due to Automatic Transmit Power Control (ATPC), where the AP instructs 

the SM to lower its power to meet the SM target Receive Level configured on the 

AP. 

Antenna Gain This value represents the amount of gain introduced by the unit’s internal antenna. 

This parameter is read-only for Integrated radios. 
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SM Quality of Service page 

The ePMP platform supports three QoS priority levels (not available in ePTP Slave mode) using an air-fairness, 

priority-based starvation avoidance scheduling algorithm: 

ePMP Traffic Priority Label Priority Level  

VOIP Highest Priority (Served first)  

High Medium Priority (Served once 

highest priority traffic is sent) 

Low Lowest Priority (Serviced once 

Highest and Medium priority 

traffic is sent) 

 VoIP Priority (only utilized when VOIP Enable is set to Enabled) 

 High Priority 

 Low Priority 

By default, all traffic passed over the air interface is low priority. The SM’s Quality of Service page may be utilized 

to map traffic to certain priority levels using QoS classification rules. The rules included in the table are enforced 

starting with the first row of the table.  

 Caution 

Each additional traffic classification rule increases device CPU utilization. Careful network planning is required 

to efficiently use the device processor. 

The ePMP platform also supports radio data rate limiting (Maximum Information Rate, or MIR) based on the 

configuration of the MIR table. Operators may add up to 16 MIR profiles on the AP, each with unique limits for 

uplink and downlink data rates. The SM field MIR Profile Setting is used to configure the appropriate MIR 

profile for limiting the SM’s data rate. 

Priority 
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Figure 43  SM Quality of Service page 

  

 

Table 68  SM Quality of Service attributes 

Attribute Meaning 

Maximum Information Rate 

MIR Profiles Configure the desired MIR (Maximum Information Rate) profile for SM operation. 

This profile must be configured on the AP else the default profile (0) is used. 

Traffic Priority 

Traffic Priority Enabled:  The QoS Classification Rules table is editable and is utilized by the device 

to classify traffic. 

Disabled:  The QoS Classification Rules table is greyed-out and all traffic is sent at 

one priority level. 

VOIP Priority Enabled:  When enabled, two entries are automatically added to the first and second 

rows of the QoS Classification Rules table, one with Rule Type CoS (5) and one 

with Rule Type DSCP (46). The addition of these rules ensures that VoIP traffic 

passed over the radio downlink is given highest priority. The CoS and DSCP values 

may be modified to accommodate non-standard VoIP equipment. 

Broadcast Priority Low Priority: All Broadcast traffic sent over the uplink is prioritized as low priority 

and is delivered to the AP after scheduled high priority and VoIP traffic. 

High Priority:  All Broadcast traffic sent over the uplink is prioritized as high 

priority and is scheduled for delivery to the AP before low priority traffic but after 

VoIP traffic. 
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Attribute Meaning 

Multicast Priority Low Priority:  All Multicast traffic sent over the uplink is prioritized as low priority 
and is delivered to the AP after scheduled high priority and VoIP traffic. 

High Priority:  All Multicast traffic sent over the uplink is prioritized as high 
priority and is scheduled for delivery to the AP before low priority traffic but after 
VoIP traffic. 

Subscriber Module 

Priority 

Normal:  SM gives priority to the packets as defined in the rules which could be 
"Low", "High", or "VoIP". "Normal" priority will allow data to be added to the 
appropriate "High", "Low", and "VoIP" queues based on the QoS rules. This is the 
default setting. If no rule is defined for a packet, then the packet priority will be 
“Low”.  

High:  SM places all data other than VoIP in the "High" queue. It will be given 
higher priority than SMs configured with “Low” and “Normal” when there is 
contention for bandwidth under the AP. 

Low:  "Low" priority will place all data that is not VoIP in "Low" priority queue. It 
will be given lower priority than SMs configured with “High” when there is 
contention for bandwidth under the same AP.  

"VoIP" queue is the highest priority queue followed by "High" queue and then by 
"Low" queue. Higher priority queues have preference over lower priority queues, 
but will not starve them. 

QoS Classification 

Rules 

The QoS Classification Rules table contains all of the rules enforced by the device 

when passing traffic over the radio downlink. Traffic passed through the device is 

matched against each rule in the table; when a match is made the traffic is sent over 

the radio link using the priority defined in column Traffic Priority. 

Type DSCP:  Differentiated Services Code Point; traffic prioritization is based on the 6-bit 

Differentiated Services field in the IP header present in the Ethernet frame header in 

the packet entering the Ethernet port. 

CoS:  Class of Service; traffic prioritization is based on the 3-bit header present in 

the 802.1Q VLAN-tagged Ethernet frame header in the packet entering the SM’s 

Ethernet port. 

VLAN ID:  Traffic prioritization is based on the VLAN ID of the packet entering 

the SM’s Ethernet port. 

EtherType:  Traffic prioritization is based on 2 octet Ethertype field in the 

Ethernet frame entering the SM’s Ethernet port. The Ethertype is used to identify 

the protocol of the data in the payload of the Ethernet frame. 

IP:  Traffic prioritization is based on the source and/or destination IP addresses of 

the packet entering the SM’s Ethernet port. A sub.net mask may be included to 

define a range of IP addresses to match. 

MAC:  Traffic prioritization is based on the source and/or destination MAC 

addresses of the packet entering the SM’s Ethernet port. A mask may be included to 

define a range of MAC addresses to match. The mask is made up of a hex 

representation of a series of 1s to start the mask and 0s that end the mask. A 1 may 

not follow a 0. Thus, FF:FF:FF:FF:00:00 is allowed, but FF:00:FF:FF:FF:FF is not. 

The MAC address is combined with the mask to define the range of allowed MAC 

addresses. 
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Attribute Meaning 

Details The Rule Details column is used to further configure each classification rule 

specified in column Rule Type.  

Priority High:  Traffic entering the SM’s Ethernet port is prioritized as “high priority” for 

sending over the radio link (traffic will be sent after VOIP-classified traffic, but 

before Low-classified traffic). 

Low:  Traffic entering the SM’s Ethernet port is prioritized as “low priority” for 

sending over the radio link (traffic will be sent after VOIP-classified and High-

classified traffic is sent). 
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SM System page 

The SM’s System page is used to configure system parameters, services, time settings, SNMP and syslog.   

Figure 44  SM System page 
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Table 69  SM System attributes 

Attribute Meaning 

General 

Device Name The Device Name is used to identify the SM on the network, and may be retrieved 

by a NMS such as the Cambium Network Services Server (CNSS). 

Webpage Auto Update Configure the interval for which the device retrieves system statistics for display on 

the management interface. For example, if this setting is configured to 5 seconds, 

the statistics and status parameters displayed on the management interface will be 

refreshed every 5 seconds. 

Web Service 

Web Service HTTP:  Access to the device management GUI is conducted via HTTP. 

HTTPS:  Access to the device management GUI is conducted via HTTPS. 

HTTP Port If Web Service is set to HTTP, configure the port which the device uses to service 

incoming HTTP requests for management GUI access. 

HTTPS Port If Web Service is set to HTTPS, configure the port which the device uses to 

service incoming HTTPS requests for management GUI access. 

SSH Service 

SSH Service Disabled: If the SSH port to the device is ‘Disabled’, access to the device through 
SSH is not possible. 

Enabled: If the SSH port to the device is ‘Enabled’, Cambium engineers can access 

the device through SSH which enables them to login to the radio and troubleshoot. 

SSH port is ‘Enabled’ by default. 

Network Time Protocol (NTP) 

NTP Server IP 

Assignment 

Static:  The device retrieves NTP time data from the servers configured in fields 

Prefered NTP Server and Alternate NTP Server. 

DHCP:  The device retrieves NTP time data from the server IP issued via a 

network DHCP server. 

Preferred NTP Server Configure primary NTP server IP address from which the device retrieves time and 

date information. 

Alternate NTP Server Configure secondary or alternate NTP server IP address from which the device 

retrieves time and date information. 

Time Zone The Time Zone option may be used to offset the received NTP time to match the 

operator’s local time zone. 

Location Services 

Device Latitude Configure Latitude information for the device in decimal format. 

Device Longitude Configure Longitude information for the device in decimal format. 

Device Height Configure the Height above sea level for the device, in meters. 
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Attribute Meaning 

Internal GPS Height On a GPS Synchronized ePMP radio, the field is automatically populated with the 

Device height above sea level from the on-board GPS chip. 

User Account Management 

Administrator 

Username 

Read-only listing of available login levels. 

 ADMINISTRATOR, full read write permissions. 

 INSTALLER, permissions to read and write parameters applicable to unit 

installation and monitoring. 

 HOME USER, permissions only to access pertinent information for support 

purposes. 

 READONLY, permissions only to view the Monitor page. 

Administrator 

Password 

Configure a custom password configuration for each user to secure the device. The 

password character display may be toggled using the visibility icon   . 

Installer Account Disabled:  The disabled user is not granted access to the device management 

interface. The administrator user level cannot be disabled. 

Enabled:  The user is granted access to the device management interface. 

Installer Username Read-only listing of available login levels: 

 INSTALLER, permissions to read and write parameters applicable to unit 

installation and monitoring. 

 HOME USER, permissions only to access pertinent information for support 

purposes. 

 READONLY, permissions only to view the Monitor page. 

Installer Password Configure a custom password configuration for each user to secure the device. The 

password character display may be toggled using the visibility icon   . 

Home User Account Disabled:  The disabled user is not granted access to the device management 

interface. The administrator user level cannot be disabled. 

Enabled:  The user is granted access to the device management interface. 

Home User Username Read-only listing of available login levels: 

 HOME USER, permissions only to access pertinent information for support 

purposes. 

 READONLY, permissions only to view the Monitor page. 

Home User Password Configure a custom password configuration for each user to secure the device. The 

password character display may be toggled using the visibility icon   . 

Read-Only Account Disabled:  The disabled user is not granted access to the device management 

interface. The administrator user level cannot be disabled. 

Enabled:  The user is granted access to the device management interface. 
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Attribute Meaning 

Read-only Username READONLY, permissions only to view the Monitor page. 

Read-only Password Configure a custom password configuration for each user to secure the device. 

Simple Network Management Protocol (SNMP) 

Read-only Community 

String 

Specify a community string that allows a Network Management Station (NMS) such 

as the Cambium Networks Services Server (CNSS) to read SNMP information. No 

spaces are allowed in this string. This password will never authenticate an SNMP 

user or an NMS to read/write access. 

The SNMP Read-only Community String value is clear text and is readable by a 

packet monitor. 

Read-write Community 

String 

Specify a community string that allows a Network Management Station (NMS) to 

not only read SNMP information but also write SNMP values that are defined as 

writeable in the radio. No spaces are allowed in this string.  

Traps Disabled: With this setting, the radio does not send traps 

Enabled: Setting this enables the radio to send SNMP traps to the configured 

SNMP Trap Server. 

Trap Community 

String 

Specify a control string to match the Trap Community String on the SNMP Trap 

server. No spaces are allowed in this string. 

Trap Servers The SNMP Trap Servers table contains all of the SNMP Trap servers the radio can 

send SNMP traps. 

Configure the IP Address which the device uses to send SNMP traps. 

Server IP Specify up to four SNMP Trap Servers to which the device will send SNMP traps. 

Server Port Configure port which the device uses to send SNMP traps. 

System Name Specify a string to associate with the physical module. This parameter can be polled 

by the Cambium Networks Services Server (CNSS) or an NMS. Special characters 

are supported.  

System Description Specify a description string to associate with the physical module. This parameter 

can be polled by the Cambium Networks Services Server (CNSS) or an NMS. Special 

characters are supported. 

System Logging (Syslog) 

Server 1-4 IP Specify up to four syslog servers to which the device sends syslog messages. 

System Log Mask Configure the levels of syslog messages which the devices send to the servers 

configured in parameters Syslog Server IP 1-4 
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SM Network page 

The SM’s Network page is used to configure system networking parameters and VLAN parameters. Parameter 

availability is based on the configuration of the SM Network Mode parameter. 

Figure 45  SM Network page, NAT mode 
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Table 70  SM Network attributes, NAT mode 

Attribute Meaning 

General 

Network Mode NAT: The SM acts as a router and packets are forwarded or filtered based on 

their IP header (source or destination). 

Bridge: The SM acts as a switch and packets are forwarded or filtered based on 

their MAC destination address. 

Wireless IP Assignment Static:  Wireless IP addressing is configured manually in fields Wireless IP 

Address, Wireless IP Subnet Mask, Wireless Gateway IP Address, 

Preferred DNS IP Address and Alternate DNS IP Address. 

DHCP:  Device management IP addressing (IP address, subnet mask, gateway 

and DNS server) is assigned via a network DHCP server. 

Wireless IP Address Wireless Internet protocol (IP) address. This address is used by the family of 

Internet protocols to uniquely identify this unit on a network. 

Wireless Subnet Mask Defines the address range of the connected IP network. For example, if 

Wireless IP Address is configured to 192.168.2.1 and Wireless IP Subnet 

Mask is configured to 255.255.255.0, the device wireless interface will belong to 

subnet 192.168.2.X. 

Wireless Gateway Configure the IP address of a computer on the current network that acts as a 

gateway. A gateway acts as an entrance and exit to packets from and to other 

networks. 

Preferred DNS Server Configure The IP address of the preferred server used for DNS resolution. 

Alternate DNS Server Configure The IP address of the alternate server used for DNS resolution. 

Separate Wireless 

Management IP 

Disabled:  When disabled, the Wireless IP is the management interface for the 

SM. 

Enabled:  When enabled, the Separate Wireless Management IP Address is 

the management interface for the SM.  

Separate Wireless  

Management IP Address 

Mode 

Static:  Separate Wireless Management IP addressing is configured manually 

in fields Separate Wireless Management IP Address, Separate Wireless 

Management IP Mask and Separate Wireless Management Gateway. 

DHCP:  Device management IP addressing (IP address, subnet mask, gateway 

and DNS server) is assigned via a network DHCP server. 

Separate Wireless  

Management IP Address 

Configure the IP address that will be used to access the SM’s management 

interface when in NAT mode. The Wireless IP (public IP) will not allow 

management access.   

Separate Wireless  

Management IP Mask 

Defines the address range of the connected IP network. For example, if 

Wireless IP Address is configured to 192.168.2.1 and Wireless IP Subnet 

Mask is configured to 255.255.255.0, the device wireless interface will belong to 

subnet 192.168.2.X. 
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Separate Wireless  

Management Gateway 

Configure the IP address of a computer on the current network that acts as a 

gateway. A gateway acts as an entrance and exit to packets from and to other 

networks. 

Ethernet MTU Maximum Transmission Unit; the size in bytes of the largest data unit that the 

device is configured to process. Larger MTU configurations can enable the 

network to operate with greater efficiency, but in the case of retransmissions 

due to packet errors, efficiency is reduced since large packets must be resent in 

the event of an error. 

Ethernet Port 

Configuration 

Manual:  The LAN Ethernet port speed and duplex mode can be manually 

configured.  

Auto-negotiate:  The AP auto negotiates the LAN Ethernet port speed and 

duplex mode with the device connected to it.  

Port Speed With “Ethernet Port Configuration” set to Manual, the LAN Ethernet port 

speed can be forced to 1000 Mbps (only GPS Synchronized radio), 100 Mbps or 

10 Mbps. 

Port Duplex Mode With “Ethernet Port Configuration” set to Manual, the LAN Ethernet port 

duplex mode can be forced to Full or Half.  

Auxiliary Port Disabled:  When disabled, the LAN Auxiliary port on the SM is shut down. 

Enabled:  When enabled, LAN Auxiliary port on the SM is up and able to 

bridge traffic with the primary Ethernet port. Default value is Enabled. 

Auxiliary Port 

Configuration 

Manual:  The LAN Auxiliary port speed and duplex mode can be manually 

configured.  

Auto-negotiate:  The AP auto negotiates the LAN Auxiliary port speed and 

duplex mode with the device connected to it.  

Auxiliary Port Speed With “Auxiliary Port Configuration” set to Manual, the LAN Auxiliary port 

speed can be forced to 1000 Mbps (only GPS Synchronized radio), 100 Mbps or 

10 Mbps. 

Auxiliary Port Duplex 

Mode 

With “Auxiliary Port Configuration” set to Manual, the LAN Auxiliary port 

duplex mode can be forced to Full or Half.  

Auxiliary Port PoE Disabled:  When disabled, the LAN Auxiliary port on the SM will not provide 

proprietary PoE out. Default value is Disabled. 

Enabled:  When enabled, LAN Auxiliary port on the SM will provide 

proprietary PoE out to power external PoE devices such as another ePMP 

radio or a PoE camera.  

Spanning Tree Protocol Disabled:  When disabled, Spanning Tree Protocol (802.1d) functionality is 

disabled at the SM. 

Enabled:  When enabled, Spanning Tree Protocol (802.1d) functionality is 

enabled at the SM, allowing for the prevention of Ethernet bridge loops. 
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LAN Port Security Disabled:  When disabled, any number of devices (MAC Addresses) can 

connect via the SM’s Ethernet (LAN) port.  

Enabled:  When enabled, the number of devices (MAC Addresses) that can 

connect via the SM’s Ethernet (LAN) port can be restricted with the fields 

below. 

Number of Secure MAC 

Addresses 

Specify the maximum number of unique devices (MAC Addresses) that can 

connect via the SM’s Ethernet (LAN) port. Range is 1 – 254 devices.  

Security MAC Address 

Aging Time 

Specify the aging timer in seconds. The aging timer will determine the duration 

for which the SM will maintain the MAC Address in its bridge table. The timer 

is restarted any time traffic from a specific MAC address is received on the LAN 

port. Once the timer expires, the MAC Address is removed from the SM’s 

bridge table.  

DHCP Servers Below SM Disabled: This blocks DHCP servers connected to the SM’s LAN side from 

handing out IP addresses to DHCP clients above the SM (wireless side).  

Enabled:  This allows DHCP servers connected to the SM’s LAN side to assign 

IP addresses to DHCP clients above the SM (wireless side). This configuration 

is typical in PTP links. 

Ethernet Interface 

IP Address Internet protocol (IP) address. This address is used by the family of Internet 

protocols to uniquely identify this unit on a network. 

Subnet Mask Defines the address range of the connected IP network. For example, if Device 

IP Address (LAN) is configured to 192.168.2.1 and IP Subnet Mask (LAN) is 

configured to 255.255.255.0, the device will belong to subnet 192.168.2.X. 

Gateway Configure the IP address of a computer on the current network that acts as a 

gateway. A gateway acts as an entrance and exit to packets from and to other 

networks. 

DHCP Server Disabled: Use this setting when SM is in NAT mode, if there is an existing 

DHCP Server below the SM handing out IP Addresses or if all devices below 

the SM will be configured with static IP Addresses.  

Enabled:  Use this setting when SM is in NAT mode, to use the SM’s 

local/onboard DHCP server to hand out IP addresses to its clients.  

DHCP Start IP  Configure the first address which will be issued to a DHCP client. Upon 

additional DHCP requests, the DHCP Start IP is incremented until Local 

DHCP End IP is reached. 

DHCP End IP Configure the highest IP address in the DHCP pool that can be issued to a 

DHCP client. 

Preferred DHCP DNS 

Server 

Configure the primary DNS Server IP address which will be used to configure 

DHCP clients (if Local DHCP Server is set to Enabled). 

Alternate DHCP DNS 

Server 

Configure the secondary DNS Server IP address which will be used to configure 

DHCP clients (if Local DHCP Server is set to Enabled). 
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DHCP Lease Time Configure the time for which a DHCP IP address is leased. When the lease time 

expires, the DHCP client must renew IP addressing via DHCP request. 

DHCP Clients The DHCP Client List table identifies hardware situated below the SM which 

shall be issued DHCP IP addressing information. The SM acts as a DHCP 

server, responding to requests from hardware connected to the SM. 

MAC Configure the physical address of the device which will retrieve DHCP IP 

addressing information from the SM. 

IP Configure the IP address which will be assigned to the device. 

Name Configure a logical name for the device configured (i.e. VoIP Phone1, or 

Network Camera1). 

Port Forwarding 

Port Forwarding The SM port forwarding functionality may be used to configure the SM to 

route external network services to an internal IP address so that end devices 

(situated below the SM) are reachable from external networks. 

 Caution 

Opening ports for forwarding may introduce a network security risk. 

Ports The Port Forwarding Table is used to define which range of wireless ports are 

forwarded to which LAN (SM local network) IP addresses. 

Protocol UDP:  Packet forwarding decisions are based on UDP packets. 

TCP:  Packet forwarding decisions are based on TCP packets. 

Wireless Port Begin Configure the beginning of the range of wireless ports to match for forwarding 

to LAN IP. 

Wireless Port End Configure the end of the range of wireless ports to match for forwarding to 

LAN IP. 

Ethernet IP Configure the LAN IP of the device situated below the SM which receives the 

packets forwarded based on the Port Forwarding Table configuration. 

Point-to-Point Protocol over Ethernet (PPoE) 

PPPoE Point-to-Point Protocol over Ethernet: Used for Encapsulating PPP frames 

inside Ethernet frames. 

Service Name An optional entry to set a specific service name to connect to for the PPPoE 

session. If this is left blank the SM accepts the first service option that comes 

back from the Access Concentrator specified below, if any. This is limited to 32 

characters. 

Access Concentrator An optional entry to set a specific Access Concentrator to connect to for the 

PPPoE session. If this is blank, the SM accepts the first Access Concentrator 

which matches the service name (if specified). This is limited to 32 characters. 

http://en.wikipedia.org/wiki/Encapsulation_(networking)
http://en.wikipedia.org/wiki/Point-to-Point_Protocol
http://en.wikipedia.org/wiki/Ethernet
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Authentication ALL: This means that CHAP authentication will be attempted first, then PAP 

authentication. The same password is used for both types. 

CHAP: This means that CHAP authentication will be attempted. 

PAP: This means that PAP authentication will be attempted. 

Username This is the CHAP/PAP username that is used. This is limited to 32 characters. 

Password This is the CHAP/PAP password that is used. This is limited to 32 characters. 

MTU Size Maximum Transmission Unit; the size in bytes of the largest data unit that the 

device is configured to process inside the PPPoE tunnel. This field allows the 

operator to specify the largest MTU value to use in the PPPoE session, if 

PPPoE MSS Clamping is Enabled. The user will be able to enter an MTU 

value up to 1492. However, if the MTU determined in LCP negotiations is less 

than this user-specified value, the SM uses the smaller value as its MTU for the 

PPPoE link. 

Keep Alive Time Configure the Keep Alive Time to allow the radio to keep the PPPoE session up 

after establishment. As an example, if this field is set to 5, the PPPoE client will 

send a keep alive message to the PPPoE server every 5 seconds. If there is no 

acknowledgement, it sends the ‘Keep alive’ message to the server 4 more times 

(for a total or 5 times) before tearing down the PPPoE session. Setting this to 

12 will mean the keep alive message will be sent every 12 seconds and when 

there is no acknowledgement, the client will try for a total of 12 times every 12 

seconds before tearing down the PPPoE session. 

MSS Clamping Disabled: The SM PPPoE session allows any MTU size determined by other 

devices in the PPPoE session during the LCP negotiations.  

Enabled: The SM PPPoE session enforces a max MTU size determined by the 

PPPoE MTU Size setting for all devices in the PPPoE session during the LCP 

negotiations, unless one of the devices enforces a MTU setting that is smaller in 

value.   

De-Militarized Zone (DMZ) 

DMZ Disabled: Packets arriving on the Wireless Interface destined for the Ethernet 

side of the network are dropped if a session does not exist between the Source 

IP (Wireless) and Destination IP (Ethernet). By default NAT requires the 

sessions to be initiated from the Ethernet side before a packet is accepted from 

the Wireless to the Wired side." 

Enabled: Any packets with an unknown destination port (not associated to an 

existing session or not defined in the port forwarding rules) is automatically 

sent to the device configured with DMZ IP Address." 

IP Address Configure the IP address of an SM connected device which is allowed to provide 

network services to the wide-area network. 

Virtual Local Area Management (VLAN) 
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VLAN (Management + 

Data) 

Enabled:  A VLAN configuration establishes a logical group within the 

network. Each computer in the VLAN, regardless of initial or eventual physical 

location, has access to the same data based on the VLAN architecture.  For the 

network operator, this provides flexibility in network segmentation, simpler 

management and enhanced security.  When the SM is in NAT mode, the VLAN 

configuration is applicable to both management and user data. 

A VLAN configuration establishes a logical group within the network.  Each 

computer in the VLAN, regardless of initial or eventual physical location, has 

access to the same data based on the VLAN architecture.  For the network 

operator, this provides flexibility in network segmentation, simpler 

management and enhanced security. 

Disabled:  When disabled, all IP management and data traffic is allowed to the 

device. 

VLAN ID Configure this parameter to include the device’s management and user traffic on 

a separate VLAN network. 

VLAN Priority ePMP radios can prioritize VLAN traffic based on the eight priorities described 

in the IEEE 802.1p specification.  Data VLAN Priority represents the VLAN 

Priority or Class of Service (CoS). Operators may use this prioritization field to 

give precedence to device user and management data. 

This parameter only takes effect if the VLAN parameter is enabled. Configure 

this parameter to set the value of the Priority code point field in the 802.1q tag 

for traffic on the configured VLAN ID originating from the SM. The default 

value is 0. 

Separate Wireless 

Management VLAN  

Enabled:  A VLAN configuration establishes a logical group within the 

network. Each computer in the VLAN, regardless of initial or eventual physical 

location, has access to the same data based on the VLAN architecture.  For the 

network operator, this provides flexibility in network segmentation, simpler 

management and enhanced security.  When the SM is in NAT mode, the 

Separate Wireless Management VLAN configuration is applicable to 

management data. 

Disabled:  When disabled, the SM does not have a unique management VLAN.  

Separate Wireless 

Management VLAN ID 

Configure this parameter to include the device’s management traffic on a 

separate VLAN network. 

Separate Wireless 

Management VLAN 

Priority 

ePMP radios can prioritize VLAN traffic based on the eight priorities described 

in the IEEE 802.1p specification.  Data VLAN Priority represents the VLAN 

Priority or Class of Service (CoS). Operators may use this prioritization field to 

give precedence to device management data. 

This parameter only takes effect if the Separate Wireless Management VLAN 

parameter is enabled. Configure this parameter to set the value of the Priority 

code point field in the 802.1q tag for management traffic on the configured 

VLAN ID originating from the SM. The default value is 0. 
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Figure 46  SM Network page, Bridge mode 
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Table 71  SM Network attributes, Bridge mode 

Attribute Meaning 

General 

Network Mode NAT: The SM acts as a router and packets are forwarded or filtered based on their 

IP header (source or destination). 

Bridge: The SM acts as a switch and packets are forwarded or filtered based on 

their MAC destination address. 

IP Assignment Static:  Device management IP addressing is configured manually in fields IP 

Address, Subnet Mask, Gateway, Preferred DNS Server and Alternate 

DNS Server. 

DHCP:  Device management IP addressing (IP address, subnet mask, gateway, and 

DNS server) is assigned via a network DHCP server, and parameters IP Address, 

Subnet Mask, Gateway, Preferred DNS Server and Alternate DNS Server 

are unused. 

IP Address  Internet protocol (IP) address. This address is used by the family of Internet 

protocols to uniquely identify this unit on a network. 

 Note 

If Device IP address Mode is set to DHCP and the device is unable to retrieve IP 

address information via DHCP, the device management IP is set to fall back to IP 

192.168.0.1 (AP mode), 192.168.0.2 (SM mode), 192.168.0.3 (Spectrum Analyzer 

mode) or the previously-configured static Device IP Address.  Units may always be 

accessed via the Ethernet port with IP 169.254.1.1. 169.254.1.1 is a local IP and is 

independent of the NAT local subnet or the wireless IP. 

Subnet Mask  Defines the address range of the connected IP network. For example, if IP Address, 

Subnet Mask, Gateway, Preferred DNS Server and Alternate DNS Server 

are configured to 255.255.255.0, the device will belong to subnet 192.168.2.X. 

Gateway  Configure the IP address of a computer on the current network that acts as a 

gateway. A gateway acts as an entrance and exit to packets from and to other 

networks. 

Preferred DNS Server Configure the IP address of the preferred server used for DNS resolution. 

Alternate DNS Server Configure the IP address of the alternate server used for DNS resolution. 

Ethernet MTU Maximum Transmission Unit; the size in bytes of the largest data unit that the 

device is configured to process.  Larger MTU configurations can enable the network 

to operate with greater efficiency, but in the case of retransmissions due to packet 

errors, efficiency is reduced since large packets must be resent in the event of an 

error. 

Ethernet Port 

Configuration 

Manual:  The LAN Ethernet port speed and duplex mode can be manually 

configured.  

Auto-negotiate:  The AP auto negotiates the LAN Ethernet port speed and duplex 

mode with the device connected to it.  
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Port Speed With “Ethernet Port Configuration”, the LAN Ethernet port speed can be forced to 

1000 Mbps (only GPS Sync’d radio), 100 Mbps or 10 Mbps. 

Port Duplex Mode With “Ethernet Port Configuration”, the LAN Ethernet port duplex mode can be 

forced to Full or Half.  

Auxiliary Port Disabled:  When disabled, the LAN Auxiliary port on the SM is shut down. 

Enabled:  When enabled, LAN Auxiliary port on the SM is up and able to bridge 

traffic with the primary Ethernet port. Default value is Enabled. 

Auxiliary Port 

Configuration 

Manual:  The LAN Auxiliary port speed and duplex mode can be manually 

configured.  

Auto-negotiate:  The AP auto negotiates the LAN Auxiliary port speed and duplex 

mode with the device connected to it.  

Auxiliary Port Speed With “Auxiliary Port Configuration” set to Manual, the LAN Auxiliary port speed 

can be forced to 1000 Mbps (only GPS Synchronized radio), 100 Mbps or 10 Mbps. 

Auxiliary Port Duplex 

Mode 

With “Auxiliary Port Configuration” set to Manual, the LAN Auxiliary port duplex 

mode can be forced to Full or Half.  

Auxiliary Port PoE Disabled:  When disabled, the LAN Auxiliary port on the SM will not provide 

proprietary PoE out. Default value is Disabled. 

Enabled:  When enabled, LAN Auxiliary port on the SM will provide proprietary 

PoE out to power external PoE devices such as another ePMP radio or a PoE 

camera.  

Spanning Tree 

Protocol 

Disabled:  When disabled, Spanning Tree Protocol (802.1d) functionality is disabled 

at the SM. 

Enabled:  When enabled, Spanning Tree Protocol (802.1d) functionality is enabled 

at the SM, allowing for the prevention of Ethernet bridge loops. 

LAN Port Security Disabled:  When disabled, any number of devices (MAC Addresses) can connect via 

the SM’s Ethernet (LAN) port.  

Enabled:  When enabled, the number of devices (MAC Addresses) that can connect 

via the SM’s Ethernet (LAN) port can be restricted with the fields below. 

Number of Secure 

MAC Addresses 

Specify the maximum number of unique devices (MAC Addresses) that can connect 

via the SM’s Ethernet (LAN) port. Range is 1 – 254 devices.  

Security MAC 

Address Aging Time 

Specify the aging timer in seconds. The aging timer will determine the duration for 

which the SM will maintain the MAC Address in its bridge table. The timer is 

restarted any time traffic from a specific MAC address is received on the LAN port. 

Once the timer expires, the MAC Address is removed from the SM’s bridge table.  

DHCP Servers Below 

SM 

Disabled: This blocks DHCP servers connected to the SM’s LAN side from handing 

out IP addresses to DHCP clients above the SM (wireless side).  

Enabled:  This allows DHCP servers connected to the SM’s LAN side to assign IP 

addresses to DHCP clients above the SM (wireless side). This configuration is typical 

in PTP links. 

Virtual Local Area Network (VLAN) 
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Management VLAN Enabled:  The SM management interface can be assigned to a Management VLAN 

to separate management traffic (remote module management via SNMP or HTTP) 

from user traffic (such as internet browsing, voice, or video). Once the management 

interface is enabled for a VLAN, an SM’s management interface can be accessed only 

by packets tagged with a VLAN ID matching the management VLAN ID.   

A VLAN configuration establishes a logical group within the network.  For the 

network operator, this provides flexibility in network segmentation, simpler 

management and enhanced security. 

Disabled:  When disabled, all untagged IP management traffic is allowed to the 

device. 

Management VLAN 

ID 

Configure this parameter to include the device’s management traffic on a separate 

VLAN network. For example, if MGMT VLAN ID is set to 2, GUI access will only 

be allowed from frames tagged with VLAN ID 2. This parameter only takes effect if 

the MGMT VLAN parameter is enabled. 

Management VLAN 

Priority 

ePMP radios can prioritize VLAN traffic based on the eight priorities described in 

the IEEE 802.1p specification.  MGMT VLAN Priority represents the VLAN 

Priority or Class of Service (CoS).  Operators may use this prioritization field to give 

precedence to device management traffic. 

This parameter only takes effect if the MGMT VLAN parameter is enabled. 

Configure this parameter to set the value of the Priority code point field in the 

802.1q tag for traffic on the management VLAN originating from the SM. The 

default value is 0. 

Data VLAN Enabled:  A VLAN tag will be added to all untagged traffic entering the SM’s LAN 

port before sending it to the AP and remove tags in the opposite direction from 

traffic (tagged with Data VLAN ID) entering on the SM’s WAN port before sending 

to the SM’s LAN port.  

Disabled:  When disabled, no changes are made to untagged traffic passing through 

the SM.  

Data VLAN ID Configure this parameter to include this VLAN tag to all untagged traffic entering 

on the SM’s LAN port before sending it to the AP and remove tags in the opposite 

direction from traffic (tagged with Data VLAN ID) entering on the SM’s WAN port 

before sending to the SM’s LAN port. 

Data VLAN Priority ePMP radios can prioritize VLAN traffic based on the eight priorities described in 

the IEEE 802.1p specification. Data VLAN Priority represents the VLAN Priority 

or Class of Service (CoS). Operators may use this prioritization field to give 

precedence to device user data. 

This parameter only takes effect if the Data VLAN parameter is enabled. Configure 

this parameter to set the value of the Priority code point field in the 802.1q tag for 

traffic on the Data VLAN originating from the SM. The default value is 0. 
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Membership VLANs Configure the Membership VLAN Table to include the SM in one or more 

VLANs. When the SM receives a packet tagged from either the Ethernet (LAN) or 

Wirless (WAN) side with a VLAN ID which is contained in the Membership 

VLAN Table, the packet is forwarded and sent out the other interface. When the 

SM receives a packet tagged with a VLAN ID which is not present in the 

Membership VLAN Table, the frame is dropped (assuming there is at least one 

VLAN ID present in the Membership VLAN table or configured as a Data VLAN). 

VLAN ID Begin Configure the first VLAN ID for the VLAN range. 

VLAN ID End Configure the last VLAN ID for the VLAN range. 

VLAN Mapping Configure the VLAN Mapping Table to map the C-VLAN of traffic ingressing the 

Ethernet (LAN) port of the SM to a S-VLAN before being forwarded to the air 

interface on the UL. In the DL direction, the SM will automatically un-map the S-

VLAN to the C-VLAN before forwarding the tagged packets to the Ethernet (LAN) 

interface of the SM.  

C-VLAN Configure the C-VLAN ID of the tagged traffic for which the mapping needs to 

occur 

 Note 

The C-VLAN ID must be entered in the SM VLAN Membership VLAN 

table. 

S-VLAN Configure the S-VLAN ID to which the tagged traffic needs to be mapped to.  

 Note 

The S-VLAN ID must be entered in the SM VLAN Membership VLAN 

table.  

Broadcast/Multicast Traffic Shaping 

Broadcast Packet Limit Enabled: This allows the user to set the Broadcast Packet Rate below. Configure 

this parameter to limit the amount of broadcast packets that will be allowed on the 

ingress of the radio’s Ethernet port. Set the packets per second value to limit the 

impact of events such as broadcast storms. 

Disabled: There is no limit on the amount of broadcast traffic that will be allowed 

into the ingress of the radio’s Ethernet port.  

Broadcast Packet Rate Set the packets per second value to limit the amount of broadcast traffic that will be 

allowed on the ingress on the radio’s Ethernet port. The packets per second limit 

can be set individually on each ePMP radio. The range is 100 to 16000 packets per 

second. The default is 1000.  

Multicast Group Limit Configure the maximum number of simultaneous multicast groups that the SM will 

allow from devices below it. The default (and maximum) is 5. 
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Multicast VLAN Enabled:  A VLAN tag will be added to all untagged multicast traffic entering the 

SM’s LAN port before sending it to the AP and remove tags in the opposite 

direction from traffic (tagged with Multicast VLAN ID) entering on the SM’s WAN 

port before sending to the SM’s LAN port.  

Disabled:  When disabled, no changes are made to untagged multicast traffic 

passing through the SM. 

Multicast VLAN ID Configure this parameter to include this VLAN tag to all untagged multicast traffic 

entering on the SM’s LAN port before sending it to the AP and remove tags in the 

opposite direction from multicast traffic (tagged with Multicast VLAN ID) entering 

on the SM’s WAN port before sending to the SM’s LAN port. 

Multicast VLAN 

Priority 

ePMP radios can prioritize VLAN traffic based on the eight priorities described in 

the IEEE 802.1p specification. Multicast VLAN Priority represents the VLAN 

Priority or Class of Service (CoS). Operators may use this prioritization field to give 

precedence to device multicast data. 

This parameter only takes effect if the Multicast VLAN parameter is enabled. 

Configure this parameter to set the value of the Priority code point field in the 

802.1q tag for traffic on the Multicast VLAN originating from the SM. The default 

value is 0. 
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SM Security page 

The SM’s Security page is used to configure system security features including SM authentication and 

Layer2/Layer3 Firewall rules. 

  

 Caution 

If a device firewall rule is added with Action set to Deny and Interface set to LAN or WAN and no other rule 

attribute are configured, the device will drop all Ethernet or wireless traffic, respectively. Ensure that all firewall 

rules are specific to the type of traffic which must be denied, and that no rules exist in the devices with only 

Action set to Deny and Interface set to LAN or WAN. To regain access to the device, perform a factory 

default. 

 Figure 47  SM Security page 
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Table 72  SM Security attributes 

Attribute Meaning 

Security Options  

Wireless Security Select the type of authentication preferred, whether RADIUS, WPA2, Open or a 

combination of the three.  

WPA2 

WPA2 Pre-shared Key Configure this key on the AP and then configure each of the network SMs with this 

key to complete the authentication configuration. This key must be between 8 to 

128 symbols. 

RADIUS 

EAP-TTLS Username Configure the EAP-TTLS Username to match the credentials on the RADIUS 

server being used for the network.   

EAP-TTLS Password Configure the EAP-TTLS Password to match the credentials on the RADIUS 

server being used for the network.   

Authentication Identity 

String 

Configure this Identity string to match the credentials on the RADIUS server being 

used for the network. Default value for this parameter is “anonymous”. 

Authentication Identity 

Realm 

Configure this Identity string to match the credentials on the RADIUS server being 

used for the network. Default value for this parameter is “cambiumnetworks.com”. 

Default Root Certificate Default EAP-TTLS root certificate that must match the certificate on the RADIUS 

server. 

Default Canopy Root 

Certificate 

PMP 450 default EAP-TTLS root certificate to match the certificate on the 

RADIUS server used with current PMP 450 deployments.  

User Provisioned Root 

Certificate 1 

Import a user certificate if a certificate different from the default certificates is 

needed. 

User Provisioned Root 

Certificate 2 

Import a second user certificate if a certificate different from the default or 1st user 

provisioned certificate is needed. 

Firewalls 

Layer 2 Firewall Enabled:  Modifications to the Layer 2 Firewall Table are allowed and rules are 

enforced. 

Disabled:  Modifications to the Layer 2 Firewall Table are not allowed and rules 

are not enforced. 

Layer 3 Firewall Enabled:  Modifications to the Layer 3 Firewall Table are allowed and rules are 

enforced. 

Disabled:  Modifications to the Layer 3 Firewall Table are not allowed and rules 

are not enforced. 
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SM MONITOR MENU 

Use the Monitor menu to access device and network statistics and status information. This section may be used to 

analyze and troubleshoot network performance and operation. 

The Monitor menu contains the following pages: 

 SM Performance page on page 178 

 SM System page on page 181 

 SM Wireless page on page 183 

 SM Network page on page 186 

 SM System Log page on page 193 
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SM Performance page 

Use the Performance page to monitor system status and statistics to analyze and troubleshoot network 

performance and operation. 

Figure 48  SM Performance page 
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Table 73  SM Performance attributes 

Attribute Meaning 

Time Since Last Reset Time since the stats were last reset. 

Reset Stats Resets all statistics for both Ethernet and Wireless.  

Ethernet Statistics - Transmitted 

Total Traffic Total amount of traffic in Kbits transferred from the SM’s Ethernet interface. 

Total Packets Total number of packets transferred from the SM’s Ethernet interface. 

Packet Errors Total number of packets transmitted out of the SM’s Ethernet interface with errors 

due to collisions, CRC errors, or irregular packet size. 

Packet Drops Total number of packets dropped prior to sending out of the SM’s Ethernet 

interface due to Ethernet setup or filtering issues. 

Multicast / Broadcast 

Traffic 

Total amount of multicast and broadcast traffic in Kbits sent via the SM’s Ethernet 
interface. 

Broadcast Packets Total number of broadcast packets sent via the SM’s Ethernet interface. 

Multicast Packets 
Total number of multicast packets sent via the SM’s Ethernet interface. 

Ethernet Statistics - Received 

Total Traffic Total amount of traffic in Kbits received by the SM’s Ethernet interface. 

Total Packets Total number of packets received by the SM’s Ethernet interface. 

Packet Errors Total number of packets received by the SM’s Ethernet interface with errors due to 

collisions, CRC errors, or irregular packet size. 

Packet Drops Total number of packets dropped prior to sending out of the SM’s wireless interface 

due to Ethernet setup or filtering issues. 

Multicast / Broadcast 

Traffic 

Total amount of multicast and broadcast traffic in Kbits received by the SM’s 

Ethernet interface. 

Broadcast Packets Total number of broadcast packets received via the SM’s Ethernet interface. 

Multicast Packets Total number of multicast packets received via the SM’s Ethernet interface. 

Wireless Statistics - Downlink 

Total Traffic Total amount of traffic received via the SM’s wireless interface in Kbits. 

Total Packets Total number of packets received via the SM’s wireless interface. 

Error Drop Packets  Total number of packets dropped prior to sending out of the SM’s Ethernet 

interface due to RF errors (packet integrity error and other RF related packet 

error). 

Multicast / Broadcast 

Traffic 

Total amount of multicast and broadcast traffic transmitted out of the SM’s wireless 

interface in Kbits. 

Broadcast Packets Total number of broadcast packets transmitted out of the SM’s wireless interface. 
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Attribute Meaning 

Multicast Packets Total number of multicast packets transmitted out of the SM’s wireless interface. 

Wireless Statistics - Uplink 

Total Traffic Total amount of traffic transmitted out of the SM’s wireless interface in Kbits. 

Total Packets Total number of packets transmitted out of the SM’s wireless interface. 

Error Drop Packets Total number of packets dropped after transmitting out of the SM’s Wireless 

interface due to RF errors (No acknowledgement and other RF related packet 

error). 

Capacity Drop Packets  Total number of packets dropped after transmitting out of the SM’s Wireless 

interface due to capacity issues (data buffer/queue overflow or other performance or 

internal packet errors). 

Retransmission Packets Total number of packets re-transmitted after transmitting out of the SM’s Wireless 

interface due to the packets not being received by the AP. 

Multicast / Broadcast 

Traffic 

Total amount of multicast and broadcast traffic received on the SM’s wireless 

interface in Kbits. 

Broadcast Packets Total number of broadcast packets transmitted on the SM’s wireless interface. 

Multicast Packets Total number of multicast packets transmitted on the SM’s wireless interface. 

Link Quality (Uplink) The Uplink quality based on the current MCS and PER. 

Link Capacity (Uplink) The uplink capacity based on the current MCS with respect to the highest 
supported MCS (MCS15). 

Session Drops Total number of sessions dropped by the SM.  

Device Reboots Total number of reboots of the SM. 

Radar (DFS) Detections Total number of DFS events that were detected by the SM. 

Downlink Packets Per 

MCS 

Number of packets (and percentage of total packets) received on the SM’s wireless 

interface for every modulation mode, based on radio conditions. 

Uplink Packets Per MCS Number of packets (and percentage of total packets) transmitted out of the SM’s 

wireless interface for every modulation mode used by the SM’s transmitter, based 

on radio conditions. 
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SM System page 

Use the System page to reference key system information. 

Figure 49  SM System page 

 

Table 74  SM System page attributes 

Attribute Meaning 

Hardware Version Board hardware version information. 

Firmware Version U-Boot version information. 

Software Version Current operating version of software on the device. This listing is also present on 

the GUI footer bar (which contains a hyperlink to download new system software). 

Date and Time Current date and time, subject to time zone offsets introduced by the configuration 

of the device Time Zone parameter. This shows a factory-configured time until a 

valid NTP server is configured. 

System Uptime The total system uptime since the last device reset. 

Wireless MAC 

Address 

The hardware address of the device wireless interface. 

Ethernet MAC 

Address 

The hardware address of the device Ethernet interface. 
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Attribute Meaning 

DFS Status N/A:  DFS operation is not required for the region configured in parameter 

Country Code 

Channel Availability Check: Prior to transmitting, the device must check the 

configured Frequency Carrier for radar pulses for 60 seconds). If no radar pulses 

are detected, the device transitions to state In-Service Monitoring. 

In-Service Monitoring: Radio is transmitting and receiving normally while 

monitoring for radar pulses which require a channel move. 

Radar Signal Detected: The receiver has detected a valid radar pulse and is 

carrying out detect-and-avoid mechanisms (moving to an alternate channel). 

In-Service Monitoring at Alternative Channel: The radio has detected a radar 

pulse and has moved operation to a frequency configured in DFS Alternative 

Frequency Carrier 1 or DFS Alternative Frequency Carrier 2. 

System Not In Service due to DFS: The radio has detected a radar pulse and has 

failed channel availability checks on all alternative frequencies.  The non-occupancy 

time for the radio frequencies in which radar was detected is 30 minutes. 
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SM Wireless page 

Use the Wireless page to reference key information about the radio’s wireless interface. 

Figure 50  SM Wireless page 

 

Table 75  SM Wireless page attributes 

Attribute Meaning 

Registered AP SSID SSID of the AP to which the SM is registered. 

Registered AP MAC address Wireless MAC address of the AP to which the SM is registered. 

Distance from AP The distance from the AP, determined by radio signal propagation delay. 

Operating Frequency The current frequency at which the SM is transmitting and receiving. 

Operating Channel Bandwidth The current channel size at which the SM is transmitting and receiving. 

Downlink RSSI The Received Signal Strength Indicator, which is a measurement of the 

power level being received by the SM’s antenna. 

Downlink SNR The Signal to Noise Ratio, which is an expression of the carrier signal 

quality with respect to signal noise. 

Transmitter Output Power The current power level at which the SM is transmitting. 

Uplink MCS Modulation and Coding Scheme – indicates the modulation mode used 

for the radio uplink, based on radio conditions (MCS 1-7, 9-15). 
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Attribute Meaning 

Downlink MCS Modulation and Coding Scheme – indicates the modulation mode used 

for the radio downlink, based on radio conditions (MCS 1-7, 9-15). 

Power Control Mode from AP Open Loop: In this mode, the SM will not receive any power change 

information in the Group Poll Frame. SM calculates the UL transmit 

power based on path loss calculations only. 

Closed Loop: In closed loop UL power control, Subscriber Module will 

get the AP actual transmit power of beacon frame and SM Target 

Received Power Level in the beacon. Based on these two values, SM 

calculates the path loss. Based on path loss and TRL values it calculates 

it’s transmit power such that the signal from SM arrives at AP at the 

configured target level. Path loss calculation will be updated by SM 

every time there is a change in values of AP actual TX power or TRL in 

the Beacon. 

Ethernet Interface Up: The radio (LAN) interface is functioning properly. 

Down:  The radio (LAN) interface has encountered an error and is not 

servicing traffic. 

Wireless Interface Up: The radio (WAN) interface is functioning properly. 

Down: The radio (WAN) interface has encountered an error and is not 

servicing traffic. 

Current Country The current code the SM is operating under. 

Total IGMP groups currently 

subscribed 

Number of IGMP groups the SM has identified from IGMP capable 

devices connected to it.  

Time since last scan Amount of time elapsed since the last scan was completed by the SM for 

available APs.  

Connection Status The current registration status of the SM. 

Available APs The Available AP List may be referenced to view which APs are 

available for SM network entry, and also to view the status of the current 

AP to SM radio link. 

SSID The SSID of the visible AP. 

MAC The MAC address of the visible AP. 

Frequency Carrier The current operating frequency of the visible AP. 

Bandwidth The current operating channel bandwidth of the visible AP. 

SNR The current measured Signal-to-Noise Ratio of the SM to AP link. 

RSSI The current measured Received Signal Strength Indicator at the AP. 
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Attribute Meaning 

Meets Network Entry Criteria Yes: The scanned AP meets the Network Entry criteria defined by the 

internal Network Algorithm. 

No: The scanned AP does not meet the Network Entry criteria defined 

by the internal Network Algorithm. 

Network Entry State The indication of the result of the SM’s network entry attempt: 

Successful:  SM registration is successful 

Failed:  Out of Range:  The SM is out of the AP’s configured maximum 

range (Max Range parameter) 

Failed:  Capacity limit reached at AP:  The AP is no longer allowing 

SM network entry due to capacity reached 

Failed:  No Allocation on AP:  The SM to AP handshaking failed due to 

a misconfigured pre-shared key between the SM and AP 

Failed:  SW Version Incompatibility: The version of software resident 

on the AP is older than the software version on the SM 

Failed:  PTP Mode:  ACL Policy: The AP is configured with PTP 

Access set to MAC Limited and the SM’s MAC address is not 

configured in the AP’s PTP MAC Address field 

Failed: Other:  The AP does not have the required available memory to 

allow network entry 

Time since last NE attempt This timer indicates the last time that the SM attempted network entry 

to the AP. 

Wireless Security This field indicates the security state of the AP to SM link. 

Set as Preferred AP 
Click the  button to add the AP to the Preferred AP 

List under Configuration=>Radio.  
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SM Network page 

Use the SM Network page to reference key information about the device network status. 

Figure 51  SM Network page, Bridge Mode 

 

 

 

Table 76  SM Network page attributes, Bridge Mode 

Attribute Meaning 

Ethernet Status 
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Attribute Meaning 

IP Assignment Static:  Device management IP addressing is configured manually in fields IP 

Address, Subnet Mask, Gateway, Preferred DNS Server and Alternate DNS 

Server. 

DHCP:  Device management IP addressing (IP address, subnet mask, gateway, 

and DNS server) is assigned via a network DHCP server, and parameters IP 

Address, Subnet Mask, Gateway, Preferred DNS Server and Alternate DNS 

Server are unused. 

Ethernet Interface Up:  The device Ethernet interface is functioning and passing data 

Down:  The device Ethernet interface has encountered an error disallowing full 

operation. Reset the device to reinitiate the Ethernet interface. 

IP Address The current IP Address mode of the device (static or DHCP). 

Subnet Mask The currently configured device IP subnet mask. 

MTU Size The currently configured Maximum Transmission Unit for the AP’s Ethernet 

(LAN) interface. Larger MTU configurations can enable the network to operate 

with greater efficiency, but in the case of retransmissions due to packet errors, 

efficiency is reduced since large packets must be resent in the event of an error. 

Port Speed The current speed of the SMs LAN port. 

Port Duplex Mode The current duplex mode of the SMs LAN port. 

Wireless Status 

Wireless IP 

Assignment 

Static:  Device management IP addressing is configured manually in fields IP 

Address, Subnet Mask, Gateway, Preferred DNS Server and Alternate DNS 

Server. 

DHCP:  Device management IP addressing (IP address, subnet mask, gateway, 

and DNS server) is assigned via a network DHCP server, and parameters IP 

Address, Subnet Mask, Gateway, Preferred DNS Server and Alternate DNS 

Server are unused. 

Wireless Interface Up:  The device wireless interface is functioning and passing data 

Down:  The device wireless interface has encountered an error disallowing full 

operation. Reset the device to reinitiate the wireless interface. 

IP address The IP address for the wireless interface is displayed only when the SM is in NAT 

Mode. 

Subnet Mask The subnet for the wireless interface is displayed only when the SM is in NAT 

Mode. 

Network Status 
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Attribute Meaning 

Network Mode Bridge: The SM acts as a switch, and packets are forwarded or filtered based on 

their MAC destination address. 

NAT: The SM acts as a router, and packets are forwarded or filtered based on their 

IP header (source or destination) which can be grouped into subnets for finer 

granularity. 

Default Gateway IP address that is currently assigned. 

DNS Server IP Represents the IP address of the DNS Server. 

PPPoE Mode Disabled: If this is left blank the STA will accept the first service option that comes 

back from the Access Concentrator specified below, if any. PPPoE is ‘Disabled’ by 

default. 

Enabled: An optional entry is ‘Enabled’ to set a specific service name to connect to 

the PPPoE session. This is limited to 32 characters. 

DHCP Lease Time Current configured time for which a DHCP IP address is leased. When the lease 

time expires, the DHCP client must renew IP addressing via DHCP request. 

Multicast Status 

Multicast Group Limit The maximum number of simultaneous multicast groups that will be allowed 

through the SM.  

ARP Table 

MAC Address MAC Address of the devices on the bridge. 

IP Address IP Address of the devices on the bridge. 

Interface Interface on which the SM identified the devices on. 

Bridge Table 

MAC Address MAC Address of the SM connected to the AP. 

Port The port to which the device is connected.  

Aging Timer (secs) Time set for the MAC addresses in the Bridge table. 
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Figure 52  SM Network page, NAT Mode 

 

 

Table 77  SM Network page attributes, NAT mode 

Attribute Meaning 

Ethernet Status 
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Attribute Meaning 

Ethernet Interface Up:  The device Ethernet interface is functioning and passing data 

Down:  The device Ethernet interface has encountered an error disallowing full 

operation. Reset the device to reinitiate the Ethernet interface. 

IP Address The current IP Address mode of the device (static or DHCP). 

Subnet Mask The currently configured device IP subnet mask. 

MTU Size The currently configured Maximum Transmission Unit for the AP’s Ethernet 

(LAN) interface. Larger MTU configurations can enable the network to operate 

with greater efficiency, but in the case of retransmissions due to packet errors, 

efficiency is reduced since large packets must be resent in the event of an error. 

Port Speed The current speed of the SMs LAN port. 

Port Duplex Mode The current duplex mode of the SMs LAN port. 

Separate Wireless Management IP 

Separate Wireless 

Management IP 

Disabled: A separate wireless management interface is not available.  

Enabled: A Separate Wireless Management IP has been configured and a 

management interface is available.  

Separate Wireless 

Management IP 

Address Mode 

Static:  Device management IP addressing is configured manually in fields IP 

Address, Subnet Mask, Gateway, Preferred DNS Server and Alternate DNS 

Server. 

DHCP:  Device management IP addressing (IP address, subnet mask, gateway, 

and DNS server) is assigned via a network DHCP server, and parameters IP 

Address, Subnet Mask, Gateway, Preferred DNS Server and Alternate DNS 

Server are unused. 

Separate Wireless 

Management IP 

Address  

The IP address for the separate wireless management interface is displayed only 

when the SM is in NAT Mode and the Separate Wireless Management IP is 

enabled.  

Separate Wireless 

Management IP Mask 

The subnet for the separate wireless management interface is displayed only when 

the SM is in NAT Mode. 

Separate Wireless 

Default Gateway 

The default gateway for the separate wireless management interface is displayed 

only when the SM is in NAT Mode. 

Wireless Status 

Wireless IP 

Assignment 

Static:  Device management IP addressing is configured manually in fields IP 

Address, Subnet Mask, Gateway, Preferred DNS Server and Alternate DNS 

Server. 

DHCP:  Device management IP addressing (IP address, subnet mask, gateway, and 

DNS server) is assigned via a network DHCP server, and parameters IP Address, 

Subnet Mask, Gateway, Preferred DNS Server and Alternate DNS Server are 

unused. 
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Attribute Meaning 

Wireless Interface Up:  The device wireless interface is functioning and passing data 

Down:  The device wireless interface has encountered an error disallowing full 

operation. Reset the device to reinitiate the wireless interface. 

IP address The IP address for the wireless interface is displayed only when the SM is in NAT 

Mode. 

Subnet Mask The subnet for the wireless interface is displayed only when the SM is in NAT 

Mode. 

Network Status 

Network Mode Bridge: The SM acts as a switch, and packets are forwarded or filtered based on 

their MAC destination address. 

NAT: The SM acts as a router, and packets are forwarded or filtered based on their 

IP header (source or destination) which can be grouped into subnets for finer 

granularity. 

DNS Server IP Represents the IP address of the DNS Server. 

PPPoE Mode Disabled: If this is left blank the STA will accept the first service option that comes 

back from the Access Concentrator specified below, if any. PPPoE is ‘Disabled’ by 

default. 

Enabled: An optional entry is ‘Enabled’ to set a specific service name to connect to 

the PPPoE session. This is limited to 32 characters. 

DHCP Lease Time Current configured time for which a DHCP IP address is leased. When the lease 

time expires, the DHCP client must renew IP addressing via DHCP request. 

Multicast Status 

Multicast Group Limit The maximum number of simultaneous multicast groups that will be allowed 

through the SM.  

ARP Table 

MAC Address MAC Address of the devices in the SM’s routing table. 

IP Address IP Address of the devices in the SMs routing table. 

Interface Interface on which the SM identified the devices on. 

Local DHCP Server 

DHCP Server Status Indicates if the local DHCP server on the SM in NAT mode is Enabled/Disabled.  

DHCP Server IP Start 

Address 

The first IP address in the DHCP pool which will be issued to a DHCP client. Upon 

additional DHCP requests, the DHCP Start IP is incremented until Local DHCP 

End IP is reached. 

DHCP Server IP End 

Address 

The last/highest address IP address in the DHCP pool of addresses which is issued 

to a DHCP client. 
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Attribute Meaning 

DHCP Gateway IP 

Address 

The gateway of the local DHCP server 

DHCP DNS IP 

Address 

DNS Server IP address which will be used to configure DHCP clients (if Local 

DHCP Server is set to Enabled under Configuration=>Network). 

DHCP Static MAC to IP Configuration Table 

MAC Address MAC address of clients that were statically assigned an IP address in the DHCP 

Static MAC to IP Configuration Table under Configuration=>Network 

IP Address IP address of clients that were statically assigned an IP address in the DHCP Static 

MAC to IP Configuration Table under Configuration=>Network 

DHCP Assigned IP Address Table 

MAC Address MAC address of clients that were assigned a IP address through DHCP from the 

Local DHCP Server 

IP Address IP address of clients that were assigned a IP address through DHCP from the Local 

DHCP Server 

Device Name Device Name of clients that were assigned a IP address through DHCP from the 

Local DHCP Server 
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SM System Log page 

Use the SM System Log page to view the device system log and to download the log file to the accessing PC or 

device. 

Figure 53  SM System Log page 

 

Table 78  SM System Log attributes 

Attribute Meaning 

Syslog Display Enabled: The system log file is displayed on the management GUI. 

Disabled: The system log file is hidden on the management GUI. 

Syslog file Use this button to download the full system log file to a connected PC or device. 
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SM TOOLS MENU 

The SM Tools menu provides several options for upgrading device software, configuration backup/restore, 

analyzing RF spectrum, testing device throughput, running ping and traceroute tests. 

 SM Software Upgrade page on page 195 

 SM Backup / Restore page on page 197 

 SM eDetect page on page 199  

 SM Spectrum Analyzer page on page 201 

 SM eAlign page on page 204 

 SM Wireless Link Test page on page 205 

 SM Ping page on page 206 

 SM Traceroute page on page 207 
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SM Software Upgrade page 

Use the SM Software Upgrade page to update the device radio software to take advantage of new software 

features and improvements. 

 Caution 

Read the Release Notes associated with each software release.   

Figure 54  SM Software Upgrade page 

  

Table 79  SM Software Upgrade attributes 

Attribute Meaning 

Software Version The current operating software version. 

Firmware Version The current operating U-Boot version. 

Upgrade Options From URL:  A webserver may be used to retrieve software upgrade packages 

(downloaded to the device via the webserver).  For example, if a webserver is 

running at IP address 192.168.2.1 and the software upgrade packages are located in 

the home directory, an operator may select option From URL and configure the 

Software Upgrade Source Info field to 

http://192.168.2.1/<software_upgrade_package> 

From Local File: Click Browse to select the local file containing the software 

upgrade package 

Select File Click Browse to select a local file (located on the device accessing the web 

management interface) for upgrading the device software. 
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To upgrade the device software, follow this: 

Procedure: 

1 
Download the software upgrade packages from https://support.cambiumnetworks.com/files/epmp  

2 Clear the cache of the accessing browser 

3 On the device GUI, navigate to Tools => Software Upgrade 

4 Select the SW Upgrade Option which represents the location of your software upgrade packages 

5 Based on the configuration of SW Upgrade Option, enter either the Software Upgrade Source Info or 

click the Browse button and locate the software package 

6 Click Upgrade 

7 When the upgrade is completed successfully, click the Reset icon 
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SM Backup / Restore page 

Use the SM Backup / Restore page to perform the following functions: 

 Back up the configuration in either text (.json) format or binary (.bin) format.  

 Restore the configuration of using a configuration file that was previously backed up.  

 Reset the device to its factory default configuration. For more factory defaulting methods, see: 

o Using the device external reset button on page 227 

o Resetting the ePMP to factory defaults by power cycling on page 228 

Figure 55  SM Backup / Restore page 

  
  



CAMBIUM NETWORKS 

 

 198 

Table 80  SM Backup / Restore attributes 

Attribute Meaning 

Backup Configuration 

Configuration File 

Format 

Text (Editable): Choosing this option will download the configuration file in the 

.json format, and can be viewed and/or edited using a standard text editor.  

Binary (Secured): Choosing this option will download the configuration file in the 

.bin format, and cannot be viewed and/or edited using an editor. Use this format for 

a secure backup.  

Restore Configuration 

Select File Click Browse to select a local file (located on the device accessing the web 

management interface) for restoring the device configuration. 

Factory Default Configuration 

Reset to Factory 

Defaults 

Use this button to reset the device to its factory default configuration.  

 Caution 

A reset to factory default configuration resets all device parameters. With the SMs 

in default configuration it may not be able to register to an AP configured for your 

network. 
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SM eDetect page 

The eDetect tool (not available in ePTP Slave mode) is used to measure the 802.11 interference at the ePMP 

radio or system when run from the AP, on the current operating channel. When the tool is run, the ePMP device 

processes all frames received from devices not connected to the ePMP system and collects the interfering frame’s 

information such as MAC Address, RSSI, and MCS. Use the SM eDetect page to collect information about 

interferers locally at the SM to display on the SM’s GUI.  

Figure 56  SM eDetect page  
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Table 81  SM eDetect attributes 

Attribute Meaning 

eDetect 

Detection Duration Configure the duration for which the SM scans for interferers.  

 Caution 

During the scanning period, the SM must be connected to the AP and 

passing user traffic, and there cannot be any outage (unlike running a 

Spectrum Analyzer). There may be a negligible degradation in the SM’s 

throughput. 

Start/Stop Use to start or stop the interference detection. 

Export to CSV Choose this option to export the detection results to .csv format. 

Status Current status of the Interference Detection tool. 

Detection Results Use the Detection Results table to monitor interferers at the SM and their key RF 

parameters. 

Device Instant Health This is an indicator of the device’s health in terms of channel conditions in the 

presence of interferer(s). 

Green: Indicates that the channel is relatively clean and has good C/I levels 

(>25dB). The interference level is low.  

Yellow: Indicates that the channel has moderate or intermittent interference (C/I 

between 10dB and 25dB). 

Red: Indicates that the channel has high interference and poor C/I levels (<10dB). 

Device MAC The MAC address of the SM’s wireless interface. 

Device RSSI (dBm) The Received Signal Strength Indicator, which is a measurement of the power level 

being received by the device’s antenna. 

Device MCS Modulation and Coding Scheme – indicates the modulation mode used for a radio’s 

receiver side, based on radio conditions (MCS 1-7, 9-15). 

Interferers’ MAC The MAC address of the interferer’s wireless interface. 

Interferers’ RSSI 

(dBm) 

The Received Signal Strength Indicator, which is a measurement of the interferer’s 

power level being received by the device’s antenna. 

Interferers’ MCS Modulation and Coding Scheme – indicates the modulation mode used by the 

interferer, based on radio conditions (ex: MCS 1--15). 

 

 

 

 
  



CAMBIUM NETWORKS 

 

 201 

SM Spectrum Analyzer page 

Use the SM Spectrum Analyzer page to configure SM spectrum analyzer parameters and to download the 

spectrum analyzer tool. 

To download the spectrum analyzer tool, the AP Device Mode must be set to Spectrum Analyzer. 

Java Runtime Environment is required to run the AP spectrum analyzer.  

 Caution 

Conducting spectrum analysis causes the SM to enter scan mode and the SM drops all RF connections.   

Vary the days and times when you analyze the spectrum in an area. The RF environment can change 

throughout the day or throughout the week. 

To conduct a spectrum analysis, follow these steps: 

Required Software: 

 Java Run-time Environment (JRE) 

Procedure: 

1 On the SM GUI, navigate to Configure => System 

2 Configure Device mode to Spectrum Analyzer 

3 Click the Save button 

4 Click the Reset button 

5 Login to the SM and navigate to Tools => Spectrum Analyzer. Following screen is displayed: 

 

6 Click Download Spectrum Analyzer Tool 

7 Locate the folder to which the spectrum analyzer tool was saved, and double-click on file csa.jnlp to 

launch the tool 

8 If a security warning window is presented, tick the checkbox next to “I accept the risk and want to run this 

application” 



CAMBIUM NETWORKS 

 

 202 

9 In the security warning window, click Run 

The spectrum analyzer interface is displayed 

 

10 Click Range to configure the range of frequencies to scan. 



CAMBIUM NETWORKS 

 

 203 

11 Click Start Scan to begin scanning 

 

 

When scanning is complete, follow these steps to return the device to AP operation: 

Procedure: 

1 In the spectrum analyzer application, click Stop Scan 

2 Close the spectrum analyzer application by clicking File => Exit 

3 On the SM GUI, navigate to Configure => System 

4 Configure Device Mode to SM 

5 Click the Save button 

6 Click the Reset button 

 

 

  

Display of the 
average, peak, 
current, and 
minimum power 
levels for the 
configured range 

Statistical display 
of the number of 
times each 
frequency in the 
range was scanned 

Spectrogram 
display of the 
energy levels 
detected 
throughout the 
configured range, 
over time 
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SM eAlign page 
Use the eAlign page to aid with link alignment. A valid link to an AP is required for eAlign to provide meaningful 
measurements.  

Figure 57  SM eAlign page 
 

 

Table 82  SM eAlign attributes 

Attribute Meaning 

Operating Frequency The current frequency at which the SM is operating. 

Registered AP SSID The SSID of the AP to which the SM is registered.  

Current RSSI Current RSSI value measured on the uplink by the SM’s receiver. 

Peak RSSI Peak RSSI value measured by the SM’s receiver from the time the user 

navigated to the eAlign page.   

Reset Measurements Click this button to reset all current measurements.  
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SM Wireless Link Test page 

Use the SM Wireless Link Test page to conduct a simple test of SM wireless throughput to the AP to which it is 

registered. This allows you to determine the throughput that can be expected on a particular link without having 

to use external tools.  

Figure 58  SM Wireless Link Test page 
 

 

Table 83  SM Wireless Link Test attributes 

Attribute Meaning 

Test Setup 

AP MAC Address This is not an editable field. It is automatically populated with the wireless MAC 

address of the AP to which the SM is registered. 

Packet Size Choose the Packet Size to use for the throughput test. 

Duration Choose the time duration in seconds to use for the throughput test. 

Downlink This field indicates the result of the throughput test on the downlink, in Mbps. 

Uplink This field indicates the result of the throughput test on the uplink, in Mbps. 

Aggregate This field indicates the result of the aggregate throughput on the link, in Mbps. 

Displayed only when Downlink/Uplink Ratio is set to 75/25, 50/50 or 30/70.  
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SM Ping page 

Use the SM Ping page to conduct a simple test of SM IP connectivity to other devices which are reachable from 

the network. If no ping response is received or if “Destination Host Unreachable” is reported, the target may be 

down, there may be no route back to the SM, or there may be a failure in the network hardware (i.e. DNS server 

failure). 

Figure 59  SM Ping page 
 

 

Table 84  SM Ping attributes 

Attribute Meaning 

Ping 

IP Address Enter the IP address of the ping target. 

Number of packets (-c) Enter the total number of ping requests to send to the target. 

Buffer size (-s) Enter the number of data bytes to be sent. 

TTL (-t) Set the IP Time-To-Live (TTL) for multicast packets. This flag applies if the 

ping target is a multicast address. 

Ping Results Displays the ping test results.  
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SM Traceroute page 

Use the SM Traceroute page to display the route (path) and associated diagnostics for IP connectivity between 

the SM and the destination specified. 

Figure 60  SM Traceroute page 
 

 

Table 85  SM Traceroute attributes 

Attribute Meaning 

Traceroute 

IP Address Enter the IP address of the target of the traceroute diagnostic. 

Fragmentation (-F) ON: Allow source and target to fragment probe packets. 

OFF: Do not fragment probe packets (on source or target). 

Trace method (-l) ICMP ECHO: Use ICMP ECHO for traceroute probes. 

UDP: Use UDP for traceroute probes. 

Display TTL (-l) ON: Display TTL values for each hop on the route. 

OFF: Suppress display of TTL values for each hop on the route. 

Verbose (-v) ON: ICMP packets other than TIME_EXCEEDED and UNREACHABLE are 

displayed in the output. 

OFF:  Suppress display of extraneous ICMP messaging. 

Traceroute Results Displays the results of the traceroute diagnostics. 
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Radius Server 

INSTALLING FREE-RADIUS ON UBUNTU 12.04 LTS 

To install the Radius server on Ubuntu 12.04 LTS, follow these instructions: 

1. On the free-radius web page http://freeradius.org, download the latest package (currently 3.0.0), either 
from the main page or the download page.  

2. Extract the archive file by using the command line as shown below: 

 To extract a tar.bz2 file, use the command (note the j option) 

tar -jxvf freeradius-server-x.x.x.tar.bz2 

 To extract a tar.gz file, use the command (note the z option) 

tar -zxvf freeradius-server-x.x.x.tar.gz 

3. Once the files are extracted to a folder (cd freeradius-server-x.x.x), execute these commands:  

           sudo apt-get install libssl-dev  

     sudo apt-get install libtalloc-dev 

     ./configure 

     make 

     make install 

CONFIGURING FREE-RADIUS SERVER 

To configure Free-Radius server, follow these steps: 

 Note 

IP address or subnet of the client must be configured in the clients.conf file. 

Ex. – For the examples listed in the document, the subnet of the external machine is 172.22.121.0 or 

192.168.0.0. 
 

1. For testing from external machines, edit /usr/local/etc/raddb/clients.conf and add an entry. 

For example: 

                               client 172.22.121.0/24 { 
ipaddr = 172.22.121.0 

                            netmask = 24 

                            secret = cambium 

                            proto = * 

                            shortname = epmp1 

                     } 

   client 127.0.0.0/24 { 

     ipaddr = 172.22.121.0 

     netmask = 24 

     secret = cambium 

     proto = * 

     shortname = epmp1 

      } 

 

   client 192.168.0.0/16 { 

     ipaddr = 192.168.0.0 

     netmask = 16 

     secret = cambium 

     proto = * 

          } 

2. To add EAP-TTLS Username and EAP-TTLS Password, edit usr/local/etc/raddb/user. 

For example put this string at the end of file: 

http://freeradius.org/
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cambium-SubscriberModule Cleartext-Password := "cambium", 

where cambium-SubscriberModule - EAP-TTLS Username  and “cambium” - EAP-TTLS Password. 

3. To configure free-radius key and certificate, edit /usr/local/etc/raddb/mods-available/eap and add your 
certificates to folder /usr/local/etc/raddb/certs. 

Locate a string such as default_eap_type, private_key_file, certificate_file in 
eap file and change the value to: 

            default_eap_type = ttls 

   private_key_password = ***  - according to your certificate 

   private_key_file = ${certdir}/***.key 

   certificate_file = ${certdir}/***.crt 

Under the ttls section, change the following:  
copy_request_to_tunnel=yes  

use_tunnel_reply=yes  

  Note 

Once these steps are performed, free-radius in debug mode can be initiated: $ radiusd –X. 

 

  


